# Contents

Preface ................................................................. ix

Purpose of This Guide ........................................... ix
How to Obtain More Information ............................... xi
How to Obtain Support ............................................. xii
Safety Conventions Used in This Document .................... xiii
Symbols on the Instruments .................................... xiv
Safety Labels on Instruments .................................... xv
General Instrument Safety ...................................... xvi
Chemical Safety .................................................... xvii
Chemical Waste Safety ......................................... xix
Electrical Safety ................................................... xx
LED Safety ......................................................... xx
Biological Hazard Safety ...................................... xxi
Workstation Safety ............................................... xxi
Safety and Electromagnetic Compatibility (EMC) Standards .. xxii

Chapter 1  **Get Started.** ........................................ 1

About the StepOne™ and StepOnePlus™ Systems ........... 2
Before You Begin .................................................. 5
Select Protective Hardware and Software ...................... 7
Select an Installation Layout ..................................... 9
Plan the Installation ............................................... 11

Chapter 2  **Set Up the Instrument** ............................ 13

About the Installation ............................................. 14
Unpack the Instrument .......................................... 15
Check the Shipped Materials ................................... 17
Set Up the Instrument ........................................... 20
Complete the Installation ....................................... 23

Chapter 3  **Install the Colocated Layout** ....................... 25

About the Colocated Installation ............................... 26
Set Up the Computer ............................................. 28
Install the Computer ........................................... 29
<table>
<thead>
<tr>
<th>Chapter 4</th>
<th>Install the Standalone Layout</th>
<th>51</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>About the Standalone Installation</td>
<td>52</td>
</tr>
<tr>
<td></td>
<td>Set Up the Computer</td>
<td>54</td>
</tr>
<tr>
<td></td>
<td>Install the Computer</td>
<td>55</td>
</tr>
<tr>
<td></td>
<td>Install the StepOne™ Software</td>
<td>57</td>
</tr>
<tr>
<td></td>
<td>Check for StepOne™ Software Updates</td>
<td>61</td>
</tr>
<tr>
<td></td>
<td>Prepare the StepOne™ Software for Standalone Use</td>
<td>62</td>
</tr>
<tr>
<td></td>
<td>Perform the RNase P Experiment</td>
<td>64</td>
</tr>
<tr>
<td></td>
<td>Set Up the Experiment</td>
<td>66</td>
</tr>
<tr>
<td></td>
<td>Run the Experiment</td>
<td>67</td>
</tr>
<tr>
<td></td>
<td>Analyze the RNase P Experiment</td>
<td>69</td>
</tr>
<tr>
<td></td>
<td>Unload the Instrument</td>
<td>69</td>
</tr>
<tr>
<td></td>
<td>Transfer the Experiment</td>
<td>70</td>
</tr>
<tr>
<td></td>
<td>Analyze the Experiment</td>
<td>72</td>
</tr>
<tr>
<td></td>
<td>After the Installation</td>
<td>75</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Chapter 5</th>
<th>Connect the System to a Network</th>
<th>77</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Overview</td>
<td>78</td>
</tr>
<tr>
<td></td>
<td>Connect the Instrument to a Network</td>
<td>82</td>
</tr>
<tr>
<td></td>
<td>Set Up a Computer for Remote Monitoring</td>
<td>84</td>
</tr>
<tr>
<td></td>
<td>Monitor the Instrument</td>
<td>86</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Chapter 6</th>
<th>Maintain the System</th>
<th>91</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Regular Maintenance</td>
<td>92</td>
</tr>
<tr>
<td></td>
<td>Perform a Spatial Calibration</td>
<td>94</td>
</tr>
<tr>
<td></td>
<td>Perform a Background Calibration</td>
<td>98</td>
</tr>
<tr>
<td></td>
<td>Perform a Dye Calibration</td>
<td>104</td>
</tr>
<tr>
<td></td>
<td>Archive and Back Up Data</td>
<td>119</td>
</tr>
<tr>
<td></td>
<td>Infrequent Maintenance</td>
<td>120</td>
</tr>
<tr>
<td></td>
<td>Decontaminate the Sample Block(s)</td>
<td>121</td>
</tr>
<tr>
<td></td>
<td>Move the Instrument</td>
<td>124</td>
</tr>
</tbody>
</table>
Replace the External Fuses ......................................................... 126
Ship the Instrument for Service ........................................... 128
Update the StepOne™ Software or the Operating System .......... 130

Appendix A  How to Troubleshoot the Installation ................. 133
StepOne™ Software Problems .................................................. 134
Network Connection Problems ............................................. 135
Background Calibration Failure ............................................ 138
Dye Calibration Failure ......................................................... 140

Glossary ................................................................. 143

Index ................................................................. 159
## Purpose of This Guide

### About the System Documentation

The guides listed below are shipped with the Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems (StepOne™ and StepOnePlus™ systems).

<table>
<thead>
<tr>
<th>Guide</th>
<th>Purpose and Audience</th>
<th>PN</th>
</tr>
</thead>
</table>
| Applied Biosystems StepOne™/StepOnePlus™ Real-Time PCR System Getting Started Guide for Genotyping Experiments | Explains how to perform experiments on the StepOne™ and StepOnePlus™ systems. Each Getting Started Guide functions as both:  
• A tutorial, using example experiment data provided with the Applied Biosystems StepOne™ Real-Time PCR System Software (StepOne™ software).  
• A guide for your own experiments. Intended for laboratory staff and principal investigators who perform experiments using the StepOne™ or StepOnePlus™ system. | 4376786 |
| Applied Biosystems StepOne™/StepOnePlus™ Real-Time PCR System Installation, Networking, and Maintenance Guide | Explains how to install and maintain the StepOne™ and StepOnePlus™ systems. Intended for laboratory staff responsible for the installation and maintenance of the StepOne™ or StepOnePlus™ system. | 4376782 |
| Applied Biosystems StepOne™/StepOnePlus™ Real-Time PCR System Installation Quick Reference Card |  | 4376783 |
| Applied Biosystems StepOne™/StepOnePlus™ Real-Time PCR System Reagent Guide | Provides information about the reagents you can use on the StepOne™ and StepOnePlus™ systems, including:  
• An introduction to TaqMan® and SYBR® Green reagents  
• Descriptions and design guidelines for the following experiment types:  
  – Quantitation experiments  
  – Genotyping experiments  
  – Presence/absence experiments  
Intended for laboratory staff and principal investigators who perform experiments using the StepOne™ or StepOnePlus™ system. | 4379704 |
Preface
Purpose of This Guide

<table>
<thead>
<tr>
<th>Guide</th>
<th>Purpose and Audience</th>
<th>PN</th>
</tr>
</thead>
<tbody>
<tr>
<td>Applied Biosystems StepOne™/StepOnePlus™ Real-Time PCR System Site Preparation Guide</td>
<td>Explains how to prepare your site to receive and install the StepOne™ or StepOnePlus™ systems. Intended for personnel who schedule, manage, and perform the tasks required to prepare your site for installation of the StepOne™ or StepOnePlus™ system.</td>
<td>4376768</td>
</tr>
<tr>
<td>Applied Biosystems StepOne™ Real-Time PCR System Software Help</td>
<td>Explains how to use the StepOne™ software to: • Set up, run, and analyze experiments using the StepOne™ and StepOnePlus™ systems. • Monitor networked StepOne™ and StepOnePlus™ instruments. • Calibrate StepOne™ and StepOnePlus™ instruments. • Verify the performance of StepOne™ and StepOnePlus™ instruments with an RNase P run. Intended for: • Laboratory staff and principal investigators who perform experiments using the StepOne™ or StepOnePlus™ system. • Laboratory staff responsible for the installation and maintenance of the StepOne™ or StepOnePlus™ system.</td>
<td>NA</td>
</tr>
</tbody>
</table>

Text Conventions

This guide uses the following conventions:
- **Bold** text indicates user action. For example:
  - Type `0`, then press **Enter** for each of the remaining fields.
- **Italic** text indicates new or important words and is also used for emphasis. For example:
  - Before analyzing, **always** prepare fresh matrix.
- A right arrow symbol (▶) separates successive commands you select from a drop-down or shortcut menu. For example:
  - Select **File ▶ Open**.

User Attention Words

Two user attention words appear in Applied Biosystems user documentation. Each word implies a particular level of observation or action as described below:

**Note:** – Provides information that may be of interest or help but is not critical to the use of the product.

**IMPORTANT!** – Provides information that is necessary for proper instrument operation, accurate chemistry kit use, or safe use of a chemical.

Examples of the user attention words appear below:

**Note:** The Calibrate function is also available in the Control Console.

**IMPORTANT!** To verify your client connection, you need a valid user ID.
Safety Alert Words  Safety alert words also appear in user documentation. For more information, see “Safety Alert Words” on page xiii.

How to Obtain More Information

<table>
<thead>
<tr>
<th>Related Documentation</th>
<th>Document</th>
<th>PN</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Applied Biosystems StepOne™/StepOnePlus™ Real-Time PCR System Installation Performance Verification Protocol</td>
<td>4376791</td>
</tr>
<tr>
<td></td>
<td>Applied Biosystems StepOne™/StepOnePlus™ Real-Time PCR System Installation Qualification-Operation Qualification Protocol</td>
<td>4376790</td>
</tr>
<tr>
<td></td>
<td>Applied Biosystems StepOne™/StepOnePlus™ Real-Time PCR System Planned Maintenance Protocol</td>
<td>4376788</td>
</tr>
</tbody>
</table>

Note: For more documentation, see “How to Obtain Support” on page xii.

Obtaining Information from the Software Help

The StepOne™ Software Help describes how to use each feature of the user interface. Access the Help from within the StepOne™ software by doing one of the following:

- Press F1.
- Click 📚 in the toolbar.
- Select Help ➔ StepOne Help.

To find topics of interest in the Help:

- Review the table of contents.
- Search for a specific topic.
- Search an alphabetized index.
How to Obtain Support

For the latest services and support information for all locations, go to www.lifetechnologies.com, then click the link for Support.

At the Support page, you can:

- Search through frequently asked questions (FAQs)
- Submit a question directly to Technical Support
- Order Applied Biosystems user documents, SDSs, certificates of analysis, and other related documents
- Download PDF documents
- Obtain information about customer training
- Download software updates and patches

In addition, the Support page provides access to worldwide telephone and fax numbers to contact Applied Biosystems Technical Support and Sales facilities.

Applied Biosystems Customer Care Center

Contact the Applied Biosystems Customer Care Center when directed by this guide, or to schedule maintenance for your instrument (such as, annual planned maintenance or temperature verification/calibration). To contact the Applied Biosystems Customer Care Center call 1-800-762-4001, Option 1 (U.S.A. only). For all other countries, please contact your local Applied Biosystems service representative.
Safety Conventions Used in This Document

Safety Alert Words

Four safety alert words appear in Applied Biosystems user documentation at points in the document where you need to be aware of relevant hazards. Each alert word—IMPORTANT, CAUTION, WARNING, DANGER—implies a particular level of observation or action, as defined below.

Definitions

IMPORTANT! – Indicates information that is necessary for proper instrument operation, accurate chemistry kit use, or safe use of a chemical.

⚠️ CAUTION – Indicates a potentially hazardous situation that, if not avoided, may result in minor or moderate injury. It may also be used to alert against unsafe practices.

⚠️ WARNING – Indicates a potentially hazardous situation that, if not avoided, could result in death or serious injury.

⚠️ DANGER – Indicates an imminently hazardous situation that, if not avoided, will result in death or serious injury. This signal word is limited to the most extreme situations.

Except for IMPORTANTs, each safety alert word in an Applied Biosystems document appears with an open triangle figure that contains a hazard symbol. These hazard symbols are identical to the hazard symbols that are affixed to Applied Biosystems instruments (see “Safety Symbols” on page xiv).

Examples

IMPORTANT! You must create a separate spreadsheet for each 96-well plate.

⚠️ CAUTION CHEMICAL HAZARD. TaqMan Universal PCR Master Mix may cause eye and skin irritation. Exposure may cause discomfort if swallowed or inhaled. Read the SDS, and follow the handling instructions. Wear appropriate protective eyewear, clothing, and gloves.

⚠️ WARNING PHYSICAL INJURY HAZARD. During instrument operation, the heated cover and sample block can reach temperatures in excess of 100°C.

⚠️ DANGER ELECTRICAL HAZARD. Grounding circuit continuity is vital for the safe operation. Never operate the system with the grounding conductor disconnected.
## Symbols on the Instruments

### Electrical Symbols

The following electrical symbols may be displayed on Applied Biosystems instruments.

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="symbol" alt="On" /></td>
<td>Indicates the <strong>On</strong> position of the main power switch.</td>
</tr>
<tr>
<td><img src="symbol" alt="Off" /></td>
<td>Indicates the <strong>Off</strong> position of the main power switch.</td>
</tr>
<tr>
<td><img src="symbol" alt="Standby" /></td>
<td>Indicates a standby switch by which the instrument is switched on to the <strong>Standby</strong> condition. Hazardous voltage may be present if this switch is on standby.</td>
</tr>
<tr>
<td><img src="symbol" alt="On/Off" /></td>
<td>Indicates the <strong>On/Off</strong> position of a push-push main power switch.</td>
</tr>
<tr>
<td><img src="symbol" alt="Signal Ground" /></td>
<td>Indicates a terminal that may be connected to the signal ground reference of another instrument. This is not a protected ground terminal.</td>
</tr>
<tr>
<td><img src="symbol" alt="Power Ground" /></td>
<td>Indicates a protective grounding terminal that must be connected to earth ground before any other electrical connections are made to the instrument.</td>
</tr>
<tr>
<td><img src="symbol" alt="Alternating Current" /></td>
<td>Indicates a terminal that can receive or supply alternating current or voltage.</td>
</tr>
<tr>
<td><img src="symbol" alt="Direct Current" /></td>
<td>Indicates a terminal that can receive or supply alternating or direct current or voltage.</td>
</tr>
</tbody>
</table>

### Safety Symbols

The following safety symbols may be displayed on Applied Biosystems instruments. Each symbol may appear by itself or with text that explains the relevant hazard (see “Safety Labels on Instruments” on page xv). These safety symbols may also appear next to DANGERS, WARNINGS, and CAUTIONS that occur in this and other documents.

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="symbol" alt="Caution" /></td>
<td>Indicates that you should consult the manual for further information and to proceed with appropriate caution.</td>
</tr>
<tr>
<td><img src="symbol" alt="DANGER" /></td>
<td>Indicates the presence of moving parts and to proceed with appropriate caution.</td>
</tr>
<tr>
<td><img src="symbol" alt="WARNING" /></td>
<td>Indicates the presence of an electrical shock hazard and to proceed with appropriate caution.</td>
</tr>
<tr>
<td><img src="symbol" alt="CAUTION" /></td>
<td>Indicates the presence of a laser inside the instrument and to proceed with appropriate caution.</td>
</tr>
</tbody>
</table>

### Environmental Symbols

The following symbol applies to all Applied Biosystems electrical and electronic products placed on the European market after August 13, 2005.

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="symbol" alt="WEEE" /></td>
<td>Do not dispose of this product as unsorted municipal waste. Follow local municipal waste ordinances for proper disposal provisions to reduce the environmental impact of waste electrical and electronic equipment (WEEE). <strong>European Union customers:</strong> Call your local Applied Biosystems Customer Service office for equipment pick-up and recycling. See <a href="http://www.lifetechnologies.com">www.lifetechnologies.com</a> for a list of customer service offices in the European Union.</td>
</tr>
</tbody>
</table>
Safety Labels on Instruments

The following CAUTION, WARNING, and DANGER statements may be displayed on Applied Biosystems instruments in combination with the safety symbols described in the preceding section.

<table>
<thead>
<tr>
<th>English</th>
<th>Francais</th>
</tr>
</thead>
<tbody>
<tr>
<td>CAUTION Hazardous chemicals. Read the Safety Data Sheets (SDSs) before handling.</td>
<td>ATTENTION Produits chimiques dangereux. Lire les fiches techniques de sûreté de matériels avant la manipulation des produits.</td>
</tr>
<tr>
<td>CAUTION Hazardous waste. Refer to SDS(s) and local regulations for handling and disposal.</td>
<td>ATTENTION Déchets dangereux. Lire les fiches techniques de sûreté de matériels et la régulation locale associées à la manipulation et l’élimination des déchets.</td>
</tr>
<tr>
<td>CAUTION Hot surface.</td>
<td>ATTENTION Surface brûlante.</td>
</tr>
<tr>
<td>DANGER High voltage.</td>
<td>DANGER Haute tension.</td>
</tr>
<tr>
<td>WARNING To reduce the chance of electrical shock, do not remove covers that require tool access. No user-serviceable parts are inside. Refer servicing to Applied Biosystems qualified service personnel.</td>
<td>AVERTISSEMENT Pour éviter les risques d’électrocution, ne pas retirer les capots dont l’ouverture nécessite l’utilisation d’outils. L’instrument ne contient aucune pièce réparable par l’utilisateur. Toute intervention doit être effectuée par le personnel de service qualifié de Applied Biosystems.</td>
</tr>
<tr>
<td>CAUTION Moving parts.</td>
<td>ATTENTION Parties mobiles.</td>
</tr>
<tr>
<td>DANGER Class 3B (III) visible and/or invisible LED radiation present when open and interlocks defeated. Avoid exposure to beam.</td>
<td>DANGER Rayonnement visible ou invisible d’un faisceau LED de Classe 3B, (III) en cas d’ouverture et de neutralisation des dispositifs de sécurité. Evitez toute exposition au faisceau.</td>
</tr>
</tbody>
</table>

Locations of Warnings

The system contains a warning at the location shown below:
General Instrument Safety

**WARNING** PHYSICAL INJURY HAZARD. Using the instrument in a manner not specified by Applied Biosystems may result in personal injury or damage to the instrument.

**CAUTION** PHYSICAL INJURY HAZARD. The instrument is to be moved and positioned only by the personnel or vendor specified in the applicable site preparation guide. If you decide to lift or move the instrument after it has been installed, do not attempt to lift or move the instrument without the assistance of others, the use of appropriate moving equipment, and proper lifting techniques. Improper lifting can cause painful and permanent back injury. Depending on the weight, moving or lifting an instrument may require two or more persons.

**WARNING** Do not attempt to lift or move the computer or the monitor without the assistance of others. Depending on the weight of the computer and/or the monitor, moving them may require two or more people.

Things to consider before lifting the computer and/or the monitor:

- Make sure that you have a secure, comfortable grip on the computer or the monitor when lifting.
- Make sure that the path from where the object is to where it is being moved is clear of obstructions.
- Do not lift an object and twist your torso at the same time.
- Keep your spine in a good neutral position while lifting with your legs.
- Participants should coordinate lift and move intentions with each other before lifting and carrying.
- Instead of lifting the object from the packing box, carefully tilt the box on its side and hold it stationary while someone slides the contents out of the box.

Ensure that anyone who operates the instrument has:

- Received instructions in both general safety practices for laboratories and specific safety practices for the instrument.
- Read and understood all applicable Safety Data Sheets (SDSs). See “About SDSs” on page xvii.

**CAUTION** Before using a cleaning or decontamination method other than those recommended by the manufacturer, verify with the manufacturer that the proposed method will not damage the equipment.
Chemical Safety

Chemical Hazard Warning

⚠️ WARNING CHEMICAL HAZARD. Before handling any chemicals, refer to the Safety Data Sheet (SDS) provided by the manufacturer, and observe all relevant precautions.

⚠️ WARNING CHEMICAL STORAGE HAZARD. Never collect or store waste in a glass container because of the risk of breaking or shattering. Reagent and waste bottles can crack and leak. Each waste bottle should be secured in a low-density polyethylene safety container with the cover fastened and the handles locked in the upright position. Wear appropriate eyewear, clothing, and gloves when handling reagent and waste bottles.

Chemical Safety Guidelines

To minimize the hazards of chemicals:

- Read and understand the Safety Data Sheets (SDSs) provided by the chemical manufacturer before you store, handle, or work with any chemicals or hazardous materials. (See “About SDSs” on page xvii.)
- Minimize contact with chemicals. Wear appropriate personal protective equipment when handling chemicals (for example, safety glasses, gloves, or protective clothing). For additional safety guidelines, consult the SDS.
- Minimize the inhalation of chemicals. Do not leave chemical containers open. Use only with adequate ventilation (for example, fume hood). For additional safety guidelines, consult the SDS.
- Check regularly for chemical leaks or spills. If a leak or spill occurs, follow the manufacturer’s cleanup procedures as recommended in the SDS.
- Comply with all local, state/provincial, or national laws and regulations related to chemical storage, handling, and disposal.

About SDSs

Chemical manufacturers supply current Safety Data Sheets (SDSs) with shipments of hazardous chemicals to new customers. They also provide SDSs with the first shipment of a hazardous chemical to a customer after an SDS has been updated. SDSs provide the safety information you need to store, handle, transport, and dispose of the chemicals safely.

Each time you receive a new SDS packaged with a hazardous chemical, be sure to replace the appropriate SDS in your files.
Obtaining SDSs

The SDS for any chemical supplied by Applied Biosystems is available to you free 24 hours a day. To obtain SDSs:

1. Go to www.lifetechnologies.com/support

2. Click the MSDS, COA & other Support Documents link.

3. In the Redefine your search field:
   a. Type the chemical name, part number, or other information that you expect to appear in the SDS of interest.
   b. Select Material Safety Data Sheets in the drop-down list.
   c. Click Search.

4. To view, download, or print the document of interest:
   a. Click the link below MSDS Files.
   b. Click the link for the language of choice.
      The SDS opens in the web browser. You can print or save the SDS.

Note: For the SDSs of chemicals not distributed by Applied Biosystems, contact the chemical manufacturer.
Chemical Waste Safety

HAZARDOUS WASTE. Refer to Safety Data Sheets and local regulations for handling and disposal.

CHEMICAL WASTE HAZARD. Wastes produced by Applied Biosystems instruments are potentially hazardous and can cause injury, illness, or death.

CHEMICAL STORAGE HAZARD. Never collect or store waste in a glass container because of the risk of breaking or shattering. Reagent and waste bottles can crack and leak. Each waste bottle should be secured in a low-density polyethylene safety container with the cover fastened and the handles locked in the upright position. Wear appropriate eyewear, clothing, and gloves when handling reagent and waste bottles.

Chemical Waste Safety Guidelines

To minimize the hazards of chemical waste:

- Read and understand the Safety Data Sheets (SDSs) provided by the manufacturers of the chemicals in the waste container before you store, handle, or dispose of chemical waste.
- Provide primary and secondary waste containers. (A primary waste container holds the immediate waste. A secondary container contains spills or leaks from the primary container. Both containers must be compatible with the waste material and meet federal, state, and local requirements for container storage.)
- Minimize contact with chemicals. Wear appropriate personal protective equipment when handling chemicals (for example, safety glasses, gloves, or protective clothing). For additional safety guidelines, consult the SDS.
- Minimize the inhalation of chemicals. Do not leave chemical containers open. Use only with adequate ventilation (for example, fume hood). For additional safety guidelines, consult the SDS.
- Handle chemical wastes in a fume hood.
- After emptying a waste container, seal it with the cap provided.
- Dispose of the contents of the waste tray and waste bottle in accordance with good laboratory practices and local, state/provincial, or national environmental and health regulations.

Waste Disposal

If potentially hazardous waste is generated when you operate the instrument, you must:

- Characterize (by analysis if necessary) the waste generated by the particular applications, reagents, and substrates used in your laboratory.
- Ensure the health and safety of all personnel in your laboratory.
- Ensure that the instrument waste is stored, transferred, transported, and disposed of according to all local, state/provincial, and/or national regulations.

IMPORTANT! Radioactive or biohazardous materials may require special handling, and disposal limitations may apply.
**Electrical Safety**

**Fuses**

- **DANGER** ELECTRICAL SHOCK HAZARD. Severe electrical shock can result from operating the system without its instrument panels in place. Do not remove instrument panels. High-voltage contacts are exposed when instrument panels are removed from the instrument.

- **WARNING** FIRE HAZARD. Improper fuses or high-voltage supply can damage the instrument wiring system and cause a fire. Before turning on the instrument, verify that the fuses are properly installed and that the instrument voltage matches the power supply in your laboratory.

- **WARNING** FIRE HAZARD. For continued protection against the risk of fire, replace fuses only with fuses of the type and rating specified for the instrument.

**Power**

- **DANGER** ELECTRICAL HAZARD. Grounding circuit continuity is vital for the safe operation of equipment. Never operate equipment with the grounding conductor disconnected.

- **DANGER** ELECTRICAL HAZARD. Use properly configured and approved line cords for the voltage supply in your facility.

- **DANGER** ELECTRICAL HAZARD. Plug the system into a properly grounded receptacle with adequate current capacity.

**Overvoltage Rating**

The StepOne™ and StepOnePlus™ systems have an installation (overvoltage) category of II, and are classified as portable equipment.

**LED Safety**

To ensure safe LED operation:

- The system must be maintained by an Applied Biosystems Technical Representative.
- All instrument panels must be in place on the instrument while the instrument is operating. When all panels are installed, there is no detectable radiation present. If any panel is removed when the LED is operating (during service with safety interlocks disabled), you may be exposed to LED emissions in excess of the Class 3B rating.
- Do not remove safety labels or disable safety interlocks.
Biological Hazard Safety

General Biohazard

WARNING BIOHAZARD. Biological samples such as tissues, body fluids, infectious agents, and blood of humans and other animals have the potential to transmit infectious diseases. Follow all applicable local, state/provincial, and/or national regulations. Wear appropriate protective equipment, which includes but is not limited to: protective eyewear, face shield, clothing/lab coat, and gloves. All work should be conducted in properly equipped facilities using the appropriate safety equipment (for example, physical containment devices). Individuals should be trained according to applicable regulatory and company/institution requirements before working with potentially infectious materials. Read and follow the applicable guidelines and/or regulatory requirements in the following:

- U.S. Department of Health and Human Services guidelines published in Biosafety in Microbiological and Biomedical Laboratories (stock no. 017-040-00547-4; bmbld.od.nih.gov)
- Your company’s/institution’s Biosafety Program protocols for working with/handling potentially infectious materials.

Additional information about biohazard guidelines is available at:

www.cdc.gov

Workstation Safety

Correct ergonomic configuration of your workstation can reduce or prevent effects such as fatigue, pain, and strain. Minimize or eliminate these effects by configuring your workstation to promote neutral or relaxed working positions.

CAUTION MUSCULOSKELETAL AND REPETITIVE MOTION HAZARD.
These hazards are caused by potential risk factors that include but are not limited to repetitive motion, awkward posture, forceful exertion, holding static unhealthy positions, contact pressure, and other workstation environmental factors.

To minimize musculoskeletal and repetitive motion risks:

- Use equipment that comfortably supports you in neutral working positions and allows adequate accessibility to the keyboard, monitor, and mouse.
- Position the keyboard, mouse, and monitor to promote relaxed body and head postures.
Safety and Electromagnetic Compatibility (EMC) Standards

U.S. and Canadian Safety Standards

The system has been tested to and complies with standard:


UL 61010A-2-010/CAN/CSA 1010.2.010, “Particular Requirements for Laboratory Equipment for the Heating of Materials.”

Canadian EMC Standard

The instrument has been tested to and complies with ICES-001, Issue 3: “Industrial, Scientific, and Medical Radio Frequency Generators.”

European Safety and EMC Standards

Safety

This instrument meets European requirements for safety (Low Voltage Directive 2006/95/EC). This instrument has been tested to and complies with standards EN 61010-1:2001, “Safety Requirements for Electrical Equipment for Measurement, Control and Laboratory Use, Part 1: General Requirements.”

EN 61010-2-010, “Particular Requirements for Laboratory Equipment for the Heating of Materials.”

EN 61010-2-081, “Particular Requirements for Automatic and Semi-Automatic Laboratory Equipment for Analysis and Other Purposes.”

EMC

This instrument meets European requirements for emission and immunity (EMC Directive 2004/108/EC). This instrument has been tested to and complies with standard EN 61326 (Group 1, Class B), “Electrical Equipment for Measurement, Control and Laboratory Use – EMC Requirements.”

Australian EMC Standards

This instrument has been tested to and complies with standard AS/NZS 2064, “Limits and Methods Measurement of Electromagnetic Disturbance Characteristics of Industrial, Scientific, and Medical (ISM) Radio-frequency Equipment.”
This chapter covers:

- About the StepOne™ and StepOnePlus™ Systems ........................................... 2
- Before You Begin .................................................................................................. 5
- Select Protective Hardware and Software ......................................................... 7
- Select an Installation Layout ............................................................................... 9
- Plan the Installation ............................................................................................ 11

Note: For more information about any of the topics discussed in this guide, access the Help from within the Applied Biosystems StepOne™ Real-Time PCR System Software by pressing F1, or clicking 📚 in the toolbar, or selecting Help › StepOne Software Help.
About the StepOne™ and StepOnePlus™ Systems

There are two models available for this Real-Time PCR System:

<table>
<thead>
<tr>
<th>System</th>
<th>Features</th>
</tr>
</thead>
<tbody>
<tr>
<td>Applied Biosystems StepOne™ Real-Time PCR System (StepOne™ system)</td>
<td>• 48-well platform</td>
</tr>
<tr>
<td></td>
<td>• Three-color system</td>
</tr>
<tr>
<td>Applied Biosystems StepOnePlus™ Real-Time PCR System (StepOnePlus™ system)</td>
<td>• 96-well platform</td>
</tr>
<tr>
<td></td>
<td>• Four-color system</td>
</tr>
<tr>
<td></td>
<td>• VeriFlex™ sample blocks</td>
</tr>
</tbody>
</table>

The Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems use fluorescent-based polymerase chain reaction (PCR) reagents to provide:

- Quantitative detection of target nucleic acid sequences (targets) using real-time analysis.
- Qualitative detection of targets using post-PCR (endpoint) analysis.
- Qualitative analysis of the PCR product (achieved by melt curve analysis that occurs post-PCR).

About Data Collection

The StepOne™ and StepOnePlus™ systems collect raw fluorescence data at different points during a PCR, depending on the type of run that the instruments perform:

<table>
<thead>
<tr>
<th>Run Type</th>
<th>Data Collection Point</th>
</tr>
</thead>
<tbody>
<tr>
<td>Real-time runs</td>
<td>- Standard curve</td>
</tr>
<tr>
<td></td>
<td>- Relative standard curve</td>
</tr>
<tr>
<td></td>
<td>- Comparative CT (ΔΔCT)</td>
</tr>
<tr>
<td></td>
<td>The instrument collects data following each extension step of the PCR.</td>
</tr>
<tr>
<td>Post-PCR (endpoint) runs</td>
<td>- Genotyping</td>
</tr>
<tr>
<td></td>
<td>- Presence/absence</td>
</tr>
<tr>
<td></td>
<td>The instrument collects data:</td>
</tr>
<tr>
<td></td>
<td>- Before the PCR (For presence/absence experiments, data collection before the PCR is optional, but recommended.)</td>
</tr>
<tr>
<td></td>
<td>- (Optional) During the PCR. The instrument can collect data during the run (real-time); collecting data during the run can be helpful for troubleshooting.</td>
</tr>
<tr>
<td></td>
<td>- After the PCR</td>
</tr>
</tbody>
</table>

Regardless of the run type, a data collection point or read on the StepOne™ or StepOnePlus™ instrument consists of three phases:

1. **Excitation** – The instrument illuminates all wells of the reaction plate within the instrument, exciting the fluorophores in each reaction.

2. **Emission** – The instrument optics collect the residual fluorescence emitted from the wells of the reaction plate. The resulting image collected by the device consists only of light that corresponds to the range of emission wavelengths.

3. **Collection** – The instrument assembles a digital representation of the residual fluorescence collected over a fixed time interval. The StepOne™ software stores the raw fluorescent image for analysis.

After a run, the StepOne™ software uses calibration data (spatial, dye, and background) to determine the location and intensity of the fluorescent signals in each read, the dye associated with each fluorescent signal, and the significance of the signal.
Filters and Supported Dyes

StepOnePlus™ System Filters and Dyes

The StepOnePlus™ instrument features a four-color filter set that supports the following Applied Biosystems dyes: FAM™ dye, JOE™ dye, NED® dye, ROX™ dye, TAMRA® dye, VIC® dye, and SYBR® Green dye. The following figure shows the emission spectrum for each dye, and the filter at which each dye is read.

<table>
<thead>
<tr>
<th>Filters</th>
<th>Wavelength (nm)</th>
<th>Emission Spectra</th>
<th>Dyes</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>~520 nm</td>
<td></td>
<td>FAM</td>
</tr>
<tr>
<td>2</td>
<td>~550 nm</td>
<td></td>
<td>JOE</td>
</tr>
<tr>
<td>3</td>
<td>~580 nm</td>
<td></td>
<td>NED</td>
</tr>
<tr>
<td>4</td>
<td>~610 nm</td>
<td></td>
<td>ROX</td>
</tr>
</tbody>
</table>

StepOne™ System Filters and Dyes

The StepOne™ instrument features a three-color filter set that supports the following Applied Biosystems dyes: FAM™ dye, JOE™ dye, ROX™ dye, VIC® dye, and SYBR® Green dye. The following figure shows the emission spectrum for each dye, and the filter at which each dye is read.

<table>
<thead>
<tr>
<th>Filters</th>
<th>Wavelength (nm)</th>
<th>Emission Spectra</th>
<th>Dyes</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>~520 nm</td>
<td></td>
<td>FAM</td>
</tr>
<tr>
<td>2</td>
<td>~550 nm</td>
<td></td>
<td>JOE</td>
</tr>
<tr>
<td>3</td>
<td>~610 nm</td>
<td></td>
<td>ROX</td>
</tr>
</tbody>
</table>

About the VeriFlex™ Technology

The StepOnePlus instrument contains six independently thermally regulated VeriFlex™ blocks to help you optimize your thermal cycling conditions. You can set a different temperature for one or more of the VeriFlex blocks, creating up to six different zones for samples, or you can set the same temperature for each of the VeriFlex blocks.
Before You Begin

Before you install the Applied Biosystems StepOne™/StepOnePlus™ Real-Time PCR System, familiarize yourself with this guide, read the supporting site preparation documentation, and obtain the materials required for the installation.

Review This Guide

You can use this guide to:

- Install the system.
  
  Chapters 2 through 5 of this guide contain all the information necessary for you to perform a complete installation of the system. You can install the system within 4 hours; however, the installation may require more time if you plan to connect the system to a network.

- Maintain the system.
  
  Chapter 6 contains all the information necessary to perform routine maintenance of the system.

  Go to Chapter 6 to learn how to:
  
  – Archive and back up data
  – Calibrate the instrument
  – Decontaminate the instrument
  – Move the instrument
  – Replace the instrument fuses
  – Ship the instrument for service

Prepare for the Installation

- Read the Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems Site Preparation Guide and complete the preinstallation checklist contained in the guide.

- Obtain the materials for installation (see “Obtain the Required Materials” on page 6).

- Read “Select Protective Hardware and Software” on page 7 and obtain any protective hardware and software that you want to install to the system.

IMPORTANT! You can use this guide to reinstall the StepOne™ or StepOnePlus™ system after transportation, but you must have the necessary installation reagents. See “Check the Shipped Materials” on page 17 for a list of materials that are required for the installation and to order more materials from Applied Biosystems as needed.
**Obtain the Required Materials**

- Tools and equipment
  - Centrifuge with a reaction plate adapter of the appropriate size
  - Powder-free gloves
  - Safety glasses
  - Scissors or box cutters
  - Screwdriver, flathead
- Computer (see below)
- (Optional) Protective hardware and software to install to the instrument and the computer (see “Select Protective Hardware and Software” on page 7).

**Minimum Computer Requirements**

If you did not order a computer with your system, supply one that meets the following requirements:

<table>
<thead>
<tr>
<th>Component</th>
<th>For operating the StepOne or StepOnePlus instrument</th>
<th>For analyzing experiments in comparative C_T studies</th>
</tr>
</thead>
<tbody>
<tr>
<td>Computer</td>
<td>• Intel processor, 1.0 GHz</td>
<td>• Intel Core Duo T5500E processor, 1.66 GHz</td>
</tr>
<tr>
<td></td>
<td>• 512 MB of RAM</td>
<td>• 1 GB of RAM#</td>
</tr>
<tr>
<td></td>
<td>• One 60-GB hard drive</td>
<td>• One 60-GB hard drive</td>
</tr>
<tr>
<td></td>
<td>• 20/48X IDE CD-ROM</td>
<td>• 20/48X IDE CD-ROM</td>
</tr>
<tr>
<td></td>
<td>• Ethernet network interface adapter (10BASE-T)§</td>
<td>• Ethernet network interface adapter (10BASE-T)§</td>
</tr>
<tr>
<td></td>
<td>• UL-listed</td>
<td>• UL-listed</td>
</tr>
<tr>
<td></td>
<td>• CE-marked</td>
<td>• CE-marked</td>
</tr>
<tr>
<td></td>
<td>• FCC-labeled</td>
<td>• FCC-labeled</td>
</tr>
<tr>
<td>Monitor</td>
<td>• 1280 × 1024 pixel resolution for full-screen display</td>
<td>• 1280 × 1024 pixel resolution for full-screen display</td>
</tr>
<tr>
<td></td>
<td>• 32-bit color</td>
<td>• 32-bit color</td>
</tr>
<tr>
<td></td>
<td>• UL-listed</td>
<td>• UL-listed</td>
</tr>
<tr>
<td>Operating System‡‡</td>
<td>Microsoft Windows® XP Professional Operating System, Service Pack 2 or later</td>
<td>Microsoft Windows® XP Professional Operating System, Service Pack 2 or later</td>
</tr>
</tbody>
</table>

‡ A computer that meets the minimum requirement provides optimal software performance and is supported by Applied Biosystems.

§ Necessary only if you plan to connect the computer to the instrument or to a local area network.

# The number of reaction plates (experiments) that can be analyzed in a comparative C_T study depends on the processor speed and the amount of RAM.

‡‡Applied Biosystems supports the Windows® Vista Business Operating System, Service Pack 1, for performing data analysis (that is, analyzing your experiments with the computer). Applied Biosystems does not support the Vista operating system for instrument control purposes.
Select Protective Hardware and Software

Before installing the system, obtain any of the following optional hardware and/or software.

**Electrical Protective Devices**

Applied Biosystems recommends several protective devices to prevent loss of data and to protect the system from damage resulting from electrical hazards.

**Power Line Regulator**

Applied Biosystems recommends the use of a 1.5-kVA power line regulator in areas where the supplied power fluctuates in excess of ±10% of the normal voltage. Power fluctuations can adversely affect the function of the system.

*Note:* A power line regulator monitors the input current and adjusts the power supplied to the instrument or computer. It does not protect against a power surge or failure.

**Uninterruptible Power Supply (UPS)**

Applied Biosystems recommends the use of a 1.5-kVA uninterruptible power supply (UPS), especially in areas prone to power failure. Power failures and other events that abruptly terminate the function of the system can corrupt data and possibly damage the system.

*IMPORTANT!* UPSs have finite battery lives and they provide power for a limited time. They are meant to delay the effects of a power outage, not to serve as replacement power sources. In the event of a power loss, power off the system unless you expect to regain power within the battery life of the UPS.

**Surge Protector**

Applied Biosystems recommends the use of a 10-kVA surge protector (line conditioner) in areas with frequent electrical storms or near devices that are electrically noisy, such as refrigerators, air conditioners, or centrifuges. Short-duration, high-voltage power fluctuations can abruptly terminate the function of, and thereby damage the components of, the computer and the system.

*Note:* A dedicated line and ground between the instrument/computer and the building’s main electrical service can also prevent problems caused by power fluctuations.

**Data Backup/Storage Devices**

Applied Biosystems recommends the use of one or more backup storage devices to prevent potential loss of data caused by unforeseen failures of the instrument or the computer. If your system includes a computer, then the CD/DVD drive of the computer can serve as the backup storage device for your system. By saving your experiment files (EDSs) to one or more writable CD or DVDs on a weekly basis, you can back up the data generated by your system. Before installing the system, decide on a method for backing up your data (“Archive and Back Up Data” on page 119).
Third-Party Software

Applied Biosystems recommends the use of several types of commercial software to ensure optimal performance of the system and software, including:

- File compression software for archiving data generated by the system
- System optimization software for defragmenting the computer hard drive(s)
- Antivirus and firewall software for protecting the system if you plan to connect it to a network

Before you install third-party software to the computer running the StepOne™ software, confirm that the software will not:

- Restrict Ethernet communication
- Interfere with StepOne™ software operation (see below)

To confirm that third-party software does not interfere with the StepOne™ software:

1. Install the software to the computer that contains the StepOne™ software.
2. Perform several test experiments using “dummy” plates (plates that do not contain reagents).

Note: The goal of the test experiments is to run plates under conditions that match normal instrument operation. Therefore, the characteristics of the test experiments (plate layout and run method) must closely resemble your actual experiments.

3. Confirm that the system performs each test experiment without producing errors.

If the system performs the tests successfully, perform experiments normally. If the system encounters errors during the test runs, the software may not be compatible with the StepOne™ software.
Select an Installation Layout

Before you install your StepOne™ or StepOnePlus™ system, select the installation layout that best suits your laboratory environment. The layout that you select affects the flow of the installation, so note your choice for later reference. The StepOne™ and StepOnePlus™ instruments can be installed in the two layouts described below (standalone or colocated).

Colocated Layout

In the colocated layout, the instrument is directly connected to the computer by the yellow StepOne system cable. In this configuration, you can set up, run, and analyze experiments from the colocated computer. The following figure shows an instrument in a colocated layout.

Note: You can control a colocated instrument from the instrument touchscreen, but only when the StepOne™ software is not performing a run.

Note: Experiment data can be transferred between the standalone instrument and computer over an Ethernet network ( answering keys) connection. See “Networked Colocated and Standalone Layouts” on page 10 for more information.

The following steps summarize the experiment workflow when using a colocated system:

1. Create the experiment on the colocated computer using the StepOne™ software.

2. Start the run from the colocated computer.
   During the run, use the colocated computer to:
   • Monitor the status of a run in progress.
   • View temperature and amplification data as they are collected.

3. Analyze the experiment on the colocated computer using the StepOne™ software.
Standalone Layout

In the standalone layout, the instrument is not connected to the computer. Instead, a USB drive is used to transfer data between the instrument and the computer. In this configuration, you set up and analyze experiments from the computer but run them from the instrument touchscreen. The following figure shows an instrument in a standalone layout.

![Standalone Layout Diagram]

**Note:** Experiment data can be transferred between the standalone instrument and computer over an Ethernet network connection. See “Networked Colocated and Standalone Layouts” below for more information.

The workflow for the standalone layout is more complicated than for the colocated layout because the system components do not share a direct connection. The following steps summarize the experiment workflow for a standalone system:

1. Create the experiment on the standalone computer using the StepOne™ software.
2. Transfer the experiment to the standalone instrument on a USB drive.
3. Start the experiment from the instrument touchscreen.
   During the run, monitor the run from the instrument touchscreen.
4. Transfer the experiment to the standalone computer on a USB drive.
5. Analyze the experiment on the standalone computer using the StepOne™ software.

Networked Colocated and Standalone Layouts

You can expand the functionality of a colocated or standalone instrument by connecting it to an Ethernet network. When an instrument is part of a network, other computers on the network that are running the StepOne™ software can:

- Monitor the status of the instrument
- Send and download experiments to and from the instrument

**IMPORTANT!** Computers on the network cannot control the instrument, only monitor it.

**Note:** Chapter 5, “Connect the System to a Network,” on page 77 contains a detailed explanation of how to install the instrument to a network.
Plan the Installation

You can install the system within a 4-hour period. The installation does not require your constant attention; however, plan to spend most of your time working with the system.

Recommended Workflow

Unpack and Set Up the instrument (Chapter 2)

Colocated Installation (Chapter 3)

Install the Computer

Connect the system

Perform the RNase P Experiment

(Optional) Install the system to a Network (Chapter 5)

Note: Consult your IT department to network a colocated computer. To enable the full functionality of the StepOne™ software, the colocated computer requires a network connection.
Set Up the Instrument

This chapter covers:

- About the Installation ................................................................. 14
- Unpack the Instrument .............................................................. 15
- Check the Shipped Materials ....................................................... 17
- Set Up the Instrument ............................................................... 20
- Complete the Installation ........................................................... 23

Note: For more information about any of the topics discussed in this guide, access the Help from within the Applied Biosystems StepOne™ Real-Time PCR System Software by pressing F1, or clicking 🕵️ in the toolbar, or selecting Help > StepOne Software Help.
About the Installation

This chapter explains how to install the Applied Biosystems StepOne™/StepOnePlus™ Real-Time PCR Instrument for both colocated and standalone layouts.

Installation Workflow

Unpack and Set Up the Instrument
1. Unpack and place the instrument.
2. Check the shipped materials.
3. Set up the instrument.
   a. Prepare the instrument.
   b. Set the instrument settings.

Chapter 1, Get Started

Chapter 3, Install the Colocated Layout

Chapter 4, Install the Standalone Layout

Notes
Unpack the Instrument

Prepare the installation site and unpack the instrument.

**Before Unpacking**

- Review and complete the preinstallation checklists in the *Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems Site Preparation Guide*. The guide is shipped to you before the instrument arrives, and it contains important environmental and electrical requirements for the system.
- Prepare the installation site as described in the *Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems Site Preparation Guide*.

**Confirm the Site Requirements**

**IMPORTANT!** Avoid placing the system on surfaces that are subject to constant or intermittent vibration. Tabletop centrifuges, vortex mixers, and other laboratory equipment can vibrate the instrument during a run and produce data collection errors.

Confirm that the installation site meets the physical and environmental requirements for the instrument listed in the table below. Refer to the *Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems Site Preparation Guide* for a complete summary.

<table>
<thead>
<tr>
<th>Requirement</th>
<th>Instrument</th>
<th>Additional</th>
<th>Total</th>
</tr>
</thead>
<tbody>
<tr>
<td>Length (drawer closed)</td>
<td>48.5 cm (19.1 in)</td>
<td>• Front‡ – 18.8 cm (7.4 in)</td>
<td>82.5 cm (32.5 in)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Rear§ – 15.2 cm (6.0 in)</td>
<td></td>
</tr>
<tr>
<td>Width</td>
<td>24.6 cm (9.7 in)</td>
<td>15.2 cm (6.0 in)#</td>
<td>39.8 cm (15.7 in)</td>
</tr>
<tr>
<td>Height</td>
<td>51.8 cm (20.4 in)</td>
<td>30.5 cm (12.0 in)</td>
<td>81.7 cm (32.4 in)</td>
</tr>
<tr>
<td>Weight</td>
<td>• StepOne™ Instrument – 23.59 ± 0.45 kg (52 ± 1 lbs)‡‡</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• StepOnePlus™ Instrument – 24.04 ± 0.45 kg (53 ± 1 lbs)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Temperature</td>
<td>15 to 30°C (59 to 86°F) / Maximum change &lt; 15°C every 24 hrs</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Humidity</td>
<td>15 to 80% relative humidity, noncondensing</td>
<td>100 to 240 VAC (50 to 60 Hz)</td>
<td></td>
</tr>
<tr>
<td>Power</td>
<td>100 to 240 VAC (50 to 60 Hz)</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

‡ Clearance required to provide adequate space for the instrument drawer to open.
§ Clearance required to ensure adequate airflow and cooling.
# Clearance at the left and right sides to ensure adequate airflow and cooling.
‡‡ Or at least 38.32 kg (84.5 lbs) if you plan to place a computer with the instrument. Actual weights depend on the computer model you use.

1 square. = (10 cm)² (3.94 in)²
Chapter 2 Set Up the Instrument

Unpack the Instrument

Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems
Installation, Networking, and Maintenance Guide

1. Cut the tape securing the top flaps of the crate and open them.
2. Remove the system packing kit from the instrument and set it aside.
3. Remove the packing material from the crate.
4. Remove the protective cover from the instrument.
5. Position yourselves on either side of the instrument and grasp it firmly at the corners.
6. Lift and move the instrument to the installation location.

Guidelines for lifting and moving the instrument:
- Keep your spine in a neutral position.
- Bend at the knees and lift with your legs.
- Do not lift an object and twist your torso at the same time.
- Coordinate your intentions with your assistant before lifting and carrying.

Do not carry the instrument by the instrument drawer. Carrying the instrument by the drawer can damage the instrument optics.
Check the Shipped Materials

After unpacking the instrument, confirm that you have received all of the components shipped with the Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems.

### Instrument and Computer

<table>
<thead>
<tr>
<th>Component</th>
</tr>
</thead>
<tbody>
<tr>
<td>StepOne™ and StepOnePlus™ instrument</td>
</tr>
<tr>
<td>(Optional) Dell® computer:</td>
</tr>
<tr>
<td>- Dell® tower computer with a Dell® flat screen monitor, or</td>
</tr>
<tr>
<td>- Dell® laptop computer with a PCMCIA Network Card</td>
</tr>
<tr>
<td>IMPORTANT! If you did not order a computer from Applied Biosystems, provide one that meets the requirements listed in “Minimum Computer Requirements” on page 6.</td>
</tr>
</tbody>
</table>

### Packing Kit

#### StepOnePlus™ System Packing Kit

<table>
<thead>
<tr>
<th>Component</th>
<th>PN</th>
</tr>
</thead>
<tbody>
<tr>
<td>Business card holder</td>
<td>4333831</td>
</tr>
<tr>
<td>Cable, Ethernet (blue)</td>
<td>4376698</td>
</tr>
<tr>
<td>Cable, StepOne™ system (yellow)</td>
<td>4376700</td>
</tr>
<tr>
<td>Cables, universal voltage kit†</td>
<td>4377117</td>
</tr>
<tr>
<td>MicroAmp® 96-Well Support Base</td>
<td>4379590</td>
</tr>
<tr>
<td>MicroAmp® 96-Well Tray for VeriFlex Blocks</td>
<td>4379983</td>
</tr>
<tr>
<td>MicroAmp® Adhesive Film Applicator</td>
<td>4333183</td>
</tr>
<tr>
<td>MicroAmp® Cap Installing Tool (Handle)</td>
<td>4330015</td>
</tr>
<tr>
<td>MicroAmp® Fast 8-Tube Strip (0.1 mL)</td>
<td>4358293</td>
</tr>
<tr>
<td>MicroAmp® Fast Optical 96-Well Reaction Plate with Barcode (0.1-mL)</td>
<td>4346906</td>
</tr>
<tr>
<td>MicroAmp® Fast Reaction Tube with Cap (0.1-mL)</td>
<td>4358297</td>
</tr>
<tr>
<td>MicroAmp® Optical 8-Cap Strip</td>
<td>4323032</td>
</tr>
<tr>
<td>MicroAmp® Optical Adhesive Film</td>
<td>4360954</td>
</tr>
<tr>
<td>StepOnePlus™ System USB Drive</td>
<td>4333831</td>
</tr>
<tr>
<td>Warranty card, release notes</td>
<td>—</td>
</tr>
</tbody>
</table>

† Contains Australian, British, European, North American, and Japanese power cords.
Chapter 2 Set Up the Instrument
Check the Shipped Materials

StepOne™ System Packing Kit

<table>
<thead>
<tr>
<th>Component</th>
<th>PN</th>
</tr>
</thead>
<tbody>
<tr>
<td>Business card holder</td>
<td>4333831</td>
</tr>
<tr>
<td>Cable, Ethernet (blue)</td>
<td>4376698</td>
</tr>
<tr>
<td>Cable, StepOne™ system (yellow)</td>
<td>4376700</td>
</tr>
<tr>
<td>Cables, universal voltage kit‡</td>
<td>4377117</td>
</tr>
<tr>
<td>MicroAmp® Fast Reaction Tube with Cap (0.1-mL)</td>
<td>4358297</td>
</tr>
<tr>
<td>MicroAmp® 48-Well Base Adapter</td>
<td>4375284</td>
</tr>
<tr>
<td>MicroAmp® 48-Well Optical Adhesive Film</td>
<td>4375928</td>
</tr>
<tr>
<td>MicroAmp® 96-Well Support Base</td>
<td>4379590</td>
</tr>
<tr>
<td>MicroAmp® Fast 48-Well Tray</td>
<td>4375282</td>
</tr>
<tr>
<td>MicroAmp® Fast 8-Tube Strip (0.1-mL)</td>
<td>4358293</td>
</tr>
<tr>
<td>MicroAmp® Fast Optical 48-Well Reaction Plate</td>
<td>4375816</td>
</tr>
<tr>
<td>MicroAmp® Optical 8-Cap Strip</td>
<td>4323032</td>
</tr>
<tr>
<td>StepOne™ System USB Drive</td>
<td>4333831</td>
</tr>
<tr>
<td>Warranty card, release notes</td>
<td>—</td>
</tr>
</tbody>
</table>

‡ Contains Australian, British, European, North American, and Japanese power cords.

Chemistry Installation Kit

StepOnePlus™ System Chemistry Installation Kit

<table>
<thead>
<tr>
<th>Component</th>
<th>PN</th>
</tr>
</thead>
<tbody>
<tr>
<td>TaqMan® RNase P Fast 96-Well Instrument Verification Plate</td>
<td>4351979</td>
</tr>
</tbody>
</table>

StepOne™ System Chemistry Installation Kit

<table>
<thead>
<tr>
<th>Component</th>
<th>PN</th>
</tr>
</thead>
<tbody>
<tr>
<td>TaqMan® RNase P Fast 48-Well Instrument Verification Plate</td>
<td>4371439</td>
</tr>
</tbody>
</table>
### Software and Documentation Kit

<table>
<thead>
<tr>
<th>Component</th>
<th>PN</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>✓</strong> Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems Site Preparation Guide</td>
<td>4376768</td>
</tr>
<tr>
<td>Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems Quick Reference Card</td>
<td>4376783</td>
</tr>
<tr>
<td>Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems Installation, Networking, and Maintenance Guide (this document)</td>
<td>4376782</td>
</tr>
<tr>
<td>Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems Getting Started Guide for Presence/Absence Experiments</td>
<td>4376787</td>
</tr>
<tr>
<td>Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems Getting Started Guide for Relative Standard Curve and Comparative C&lt;sub&gt;T&lt;/sub&gt; Experiments</td>
<td>4376785</td>
</tr>
<tr>
<td>Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems Reagent Guide</td>
<td>4379740</td>
</tr>
<tr>
<td>Applied Biosystems StepOne™ Real-Time PCR System Software</td>
<td>4379099</td>
</tr>
<tr>
<td>Primer Express® Software v3.0</td>
<td>4363991</td>
</tr>
<tr>
<td>Miscellaneous items (mouse pad, registration card, and others)</td>
<td>—</td>
</tr>
</tbody>
</table>

### Notes

---

Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems Installation, Networking, and Maintenance Guide
Set Up the Instrument

After confirming that you have received all system components, perform an initial system test of the instrument, then define the instrument settings.

Prepare the Instrument

1. Connect the power cord to the system.

2. (Optional) Install electrical protective devices to the power cord.
   Applied Biosystems recommends that you install at least one of the electrical protective devices (power line regulator, uninterruptible power supply, and/or surge protector) to prevent loss of data and to protect the instrument from damage resulting from electrical hazards.
   
   Note: For more information on selecting electrical protective devices for the instrument, see “Select Protective Hardware and Software” on page 7.

3. Connect the power cord to the power receptacle.

4. Power on the instrument, then wait for it to perform a diagnostic of the system components.
   When you power on the instrument for the first time, it may require more than 5 min to boot. Proceed with the installation when the touchscreen displays the Main Menu, indicating that the instrument has completed the boot.
   
   Note: If you are updating the instrument firmware, the instrument may pause for up to 20 min before completing the boot.

If the instrument displays an error, power off the instrument, wait 30 sec, then power on the instrument. If the instrument displays the error again, contact Applied Biosystems as explained in “How to Obtain Support” on page xii.
5. Remove the packing material from the sample block(s):
   a. Open the instrument drawer.
   b. Remove the packing material from the sample block(s).
   c. Close the instrument drawer.

When removing the packing material from the sample block(s), you must power on the instrument to lower the instrument drawer. The drawer is in the “raised” position during transportation and it will not open until the instrument is powered on.

Define the Settings
1. Set the instrument name:
   a. In the Main Menu, touch **Settings Menu**, then touch **Admin Menu**, then touch **Set Instrument Name**.
   b. Touch the **Instrument Name** field, enter a name for the instrument, then touch **Done**.

   The instrument name identifies your computer on the network. If you want to connect the instrument to a network, the name must be unique.

   **Note:** The instrument does not restrict the length or content of the instrument name. However, if you plan to connect the instrument to a network, limit the instrument name to fifteen characters and do not include spaces or special characters (such as ; : " < > * + = \ | ? , ).

   c. Touch **Done** to save the settings, then touch **OK** when prompted.
2. Define the date and time settings:
   a. In the Admin Menu, touch Set Date & Time.
   b. Touch the Date field, then enter the current date (in year/month/day format), then touch Done.
   c. Touch the Time field, then enter the time in hour:minute format, then touch Done.
   d. Touch AM/PM to display the correct time period.
   e. Touch Done to save the settings, then touch OK when prompted.

3. Touch , then touch Yes in the Confirmation Screen to enter standby mode.
Complete the Installation

After setting up the instrument, install the remaining system components according to the layout you selected (standalone or colocated), then perform the RNase P verification experiment.

Perform the Appropriate Installation

As explained in “Select an Installation Layout” on page 9, the system supports two basic installation layouts: colocated and standalone. Perform the installation according to the layout you selected.

<table>
<thead>
<tr>
<th>If you want to install the…</th>
<th>Go to…</th>
</tr>
</thead>
<tbody>
<tr>
<td>instrument and the computer to the same location, connected by the yellow StepOne system cable.</td>
<td>Chapter 3, “Install the Colocated Layout,” on page 25.</td>
</tr>
</tbody>
</table>

| instrument and the computer to different locations. | Chapter 4, “Install the Standalone Layout,” on page 51. |

**IMPORTANT!** Do not install the instrument to an Ethernet network until you complete the installation by performing an RNase P experiment that passes. See Chapter 5, “Connect the System to a Network,” on page 77 to connect the instrument to a network after the installation.
Install the Colocated Layout

This chapter covers:

- About the Colocated Installation ....................................................... 26
- Set Up the Computer ................................................................. 28
  - Install the Computer ................................................................. 29
  - Install the StepOne™ Software ...................................................... 32
- Check for StepOne™ Software Updates ........................................... 36
- Connect the System Components ...................................................... 37
- Perform the RNase P Experiment ..................................................... 41
  - Set Up the Experiment ............................................................... 43
  - Run the Experiment ................................................................. 44
  - Analyze the Experiment ............................................................. 46
- After the Installation ................................................................. 50

Note: For more information about any of the topics discussed in this guide, access the Help from within the Applied Biosystems StepOne™ Real-Time PCR System Software by pressing F1, or clicking in the toolbar, or selecting Help ▶ StepOne Software Help.
About the Colocated Installation

This chapter explains how to install the Applied Biosystems StepOne™ or StepOnePlus™ Real-Time PCR System for colocated operation.

When to Perform a Colocated Installation

In this layout, the yellow StepOne system cable connects the instrument to the colocated computer. Install the system in the colocated layout when both the computer and the instrument will be placed together in the same location. See “Colocated Layout” on page 9 for a complete description of the layout.

Note: If you do not want to connect the computer to the instrument, perform the standalone installation as described in Chapter 4, “Install the Standalone Layout.”
Chapter 3, Install the Colocated Layout
About the Colocated Installation

Chapter 2, Set Up the Instrument

Set Up the Computer
1. Install the computer.
2. Install the StepOne™ software.
IMPORTANT! Perform step 2 only if you did not order a computer from Applied Biosystems.

Check for Software Updates

Connect the System
1. Connect the instrument to the computer.
2. Confirm the connection.

Perform the RNase P Experiment
1. Set up the experiment.
2. Run the experiment.
3. Analyze the experiment.

Chapter 5, Connect the System to a Network

Notes
Set Up the Computer

After you install the StepOne™ or StepOnePlus™ instrument, set up the colocated computer.

IMPORTANT! If you ordered a computer from Applied Biosystems, you need only to unpack the computer as explained on page 29. Computers shipped by Applied Biosystems are ready for use with the instrument and already contain the StepOne™ software.

Materials Required

- CD, Applied Biosystems StepOne™ Real-Time PCR System Software
- Computer

IMPORTANT! If you did not order a computer from Applied Biosystems, provide a computer that satisfies the requirements listed on “Minimum Computer Requirements” on page 6.

- Screwdrivers, flathead and Phillips
- StepOne system cable, yellow (from the system packing kit)
- (Optional) Protective hardware to install to the computer

Applied Biosystems recommends that you install one or more of the following electrical devices to the computer to prevent loss of data and to protect the computer from damage resulting from electrical hazards:

- Power line regulator
- Uninterruptible power supply (UPS)
- Surge protector
- Backup storage device

For more information, see “Select Protective Hardware and Software” on page 7.
Install the Computer

After obtaining the required materials, install the computer.

Confirm the Site Requirements

Confirm that the installation site meets the physical and environmental requirements for the computer. See the documentation for your computer for the site requirements.

**CAUTION** PHYSICAL INJURY HAZARD. Improper lifting can cause painful and sometimes permanent back injury. Use proper lifting techniques when lifting or moving the computer. We recommend safety training for proper lifting techniques. Do not attempt to lift or move the computer or the monitor without the assistance of others. Depending on the weight of the computer and the monitor, this may require two or more people.

1. If you have not done so already, unpack the monitor, computer, keyboard, and mouse, and assemble the computer components as described in the computer installation guide.

Guidelines for lifting and moving the computer:

- Make sure that you have a secure grip on the computer when lifting.
- Make sure that the pathway from the beginning of the lift to the final location is clear of obstructions.
- Do not lift an object and twist your torso at the same time.
- Keep your spine in a neutral position while lifting with your legs.
- Coordinate lift and movement with all participants before lifting and carrying the computer.
- Instead of lifting the computer/monitor from the packing box, tilt the box on its side, then slide the contents out of the box.

2. Make the following connections:

<table>
<thead>
<tr>
<th>Connect</th>
<th>Do Not Connect</th>
<th>Power</th>
<th>Mouse</th>
<th>Keyboard</th>
<th>Monitor</th>
<th>Ethernet</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>![Power Icon]</td>
<td>![Mouse Icon]</td>
<td>![Keyboard Icon]</td>
<td>![Monitor Icon]</td>
<td>![Ethernet Icon]</td>
</tr>
</tbody>
</table>
3. If you ordered a laptop computer from Applied Biosystems, install the PCMCIA Network Card as described in the documentation accompanying the card. After installing the PCMCIA Network Card, wait several minutes to allow the computer to enable the device. The computer may require time to register the network card with the operating system before it is available for use.

**Note:** If you are installing your system in a colocated setup, do not connect the StepOne system cable to the Ethernet port of the PCMCIA card. If you have already installed the instrument connection through the card, unplug and connect the StepOne system cable to the appropriate port.

4. If you ordered a tower computer from Applied Biosystems, set the voltage appropriately for your region as described in the computer installation guide.

5. Get the yellow StepOne system cable from the system packing kit (see “Check the Shipped Materials” on page 17), then connect the:
   - Yellow Ethernet port ( ) of the instrument, to the
   - Ethernet port ( ) of the computer

**IMPORTANT!** Do not connect the StepOne system cable to the blue LAN Port ( ); this port is reserved for a network connection.

6. (Optional) Install electrical protective devices to the computer.

**Note:** For more information, see “Select Protective Hardware and Software” on page 7.
Power On the Computer

1. Power on the computer and monitor.

2. Log onto the operating system:
   - If you are using a computer that you provided, log on to the operating system as a member of the Administrators user group.
   - If you are using a computer from Applied Biosystems, enter **Administrator** in the User field, then click **Login**. Leave the Password field blank.

   **IMPORTANT!** If you are installing a computer that you provided, you must log onto the Windows® operating system using a user account that belongs to the Administrators user group.

3. In the Getting Started with Windows® XP window, deselect **Show this screen at startup**, then click **Exit**.

4. Determine the next step:
   - If you are installing a computer that you provided, go to “Install the StepOne™ Software” on page 32.
   - If you are installing a computer from Applied Biosystems, go to “Check for StepOne™ Software Updates” on page 36.
Install the StepOne™ Software

After setting up the computer, define the display properties, computer name, and the date and time settings, then install the StepOne™ software.

**IMPORTANT!** If you ordered a computer from Applied Biosystems, skip “Install the StepOne™ Software” and go to “Check for StepOne™ Software Updates” on page 36. Computers that are supplied by Applied Biosystems already contain the StepOne™ software, and are ready for use with the instrument.

---

**Prepare the Operating System**

1. Change the screen saver and power options settings:
   a. Right-click the desktop, then select **Properties**.
   b. In the Display Properties dialog box, select the **Screen Saver** tab.
   c. In the Screen saver group box, select *(None)* in the dropdown menu.
   d. Click **Power**.
   e. In the Power Options Properties dialog box, select **HomeOffice Desk** from the Power schemes dropdown list.
   f. Set the Plugged in power scheme settings:
      * Monitor – Select **After 20 mins** from the Plugged in dropdown menu.
      * Hard Disks – Select **Never** from the Plugged in dropdown menu.
      * System standby – Select **Never** from the Plugged in dropdown menu.
   g. Click **OK** to save the settings.
2. Change the screen resolution:
   a. In the Display Properties dialog box, select the Settings tab.
   b. In the Screen Area group box, use the slider to select **1280 by 1024 pixels**.
   c. In the Colors group box, select **Highest (32 bit)** in the dropdown menu.
   d. Click OK twice, then click Yes to accept the new resolution.

3. Define the date and time settings:
   a. Right-click the time readout in the toolbar, then select **Adjust Date/Time**.
   b. In the Date & Time tab, define the date and time settings.
   c. Select the **Time Zone** tab.
   d. Select a time zone from the dropdown menu, then select **Automatically adjust clock for daylight saving changes** if necessary.
   e. Click OK.

**Note:** Computers on a network synchronize their date/time settings with the server.
4. Change the computer name:
   a. In the desktop, right-click My Computer, then select Properties.
   b. In the System Properties dialog box, select the Computer Name tab.
   c. Click Change.
   d. In the Computer Name field, enter the computer name.

   ![CAUTION]
   A shared name could lead to network conflicts if you install both devices to an Ethernet network.

   e. If necessary, define the Domain or Workgroup settings if you are going to connect the computer to a network.
   f. Click OK twice.
   g. In the Network Identification dialog box, click OK.

   Note: The computer name identifies the computer on the network and must be different than that of the instrument. After you install the system, you can change the computer name without disrupting the function of the StepOne™ software.

5. In the Systems Settings Change dialog box, click Yes to restart the computer.
6. Log onto the operating system as a member of the Administrators user group.
Install the Software

**IMPORTANT!** You must be logged into the Windows® operating system as an administrator to install the StepOne™ software.

**Note:** If you encounter errors during the installation of the StepOne™ software, reinstall the software as described in “Uninstall the StepOne™ Software” on page 134.

1. Insert the Applied Biosystems StepOne™ Real-Time PCR System Software CD into the CD drive of the computer and wait for the installer to start.
   If the installer does not start automatically, double-click (My Computer), navigate to the CD drive, then double-click Setup.exe.
2. In the Welcome page of the InstallShield Wizard, click Next.
3. In the License Agreement page, click Yes to accept the agreement.
4. In the Choose Destination Location page, click Next to accept the default location.
   **Note:** Applied Biosystems recommends installing the StepOne™ software to the D drive; however, you can install the software to another location.
5. In the Default Instrument Type page, select the type of instrument that you are installing (StepOnePlus™ Instrument or StepOne™ Instrument), then click Next.
6. In the Start Copying Files page, confirm that the installation location displayed in the Current Settings field is correct, then click Next to begin installing the StepOne™ software.
7. When the StepOne™ software completes the installation, click Finish.
Check for StepOne™ Software Updates

Updates and/or patches may be available for the StepOne software. Applied Biosystems recommends that you check for software updates before you proceed with the installation.

**Note:** To periodically check for software updates after the StepOne or StepOnePlus system is installed (as part of routine maintenance), see “Update the StepOne™ Software or the Operating System” on page 130.

To check for software updates:

1. Go to: [http://www.lifetechologies.com/support](http://www.lifetechologies.com/support) and click the Instrument Software, Patches & Updates link.

2. In the Instrument Software, Patches & Updates page, click the link for the appropriate software.

3. Under Software Download, view the available downloads.

4. If there are updates and/or patches for StepOne software v2.1 or later, select the appropriate option, then follow the prompts to begin the download.

   You may be asked for your instrument serial number. The serial number is on the back panel of your instrument, or can be obtained from the instrument touchscreen.
Connect the System Components

After preparing the computer, connect the instrument to the computer, then confirm that the StepOne™ software can access the instrument by retrieving the maintenance data.

Establish the Connection

1. If necessary, power on the instrument.

2. Power on the computer and monitor.

3. Log in as Administrator, or as a member of the Administrators user group.

   **IMPORTANT!** If you install the system using a computer that you provide, you must log onto the Windows® operating system using a user account that belongs to the Administrators user group.

4. In the desktop, double-click (StepOne software) or select Start ➤ All Programs ➤ Applied Biosystems ➤ StepOne Software ➤ <software name>

   where <software name> is the current version of the StepOne software.

   While the StepOne™ software loads:
   - The software establishes communication with the instrument.
   - The Windows XP operating system automatically detects the connection and displays a Local Area Connection alert in the taskbar.

   **Note:** You can disable the network connection messages displayed when the StepOne™ software and instrument communicate. See “(Optional) Disable the Local Area Connection Messages” on page 39 for more information.
5. In the Login dialog box, create a user name:
   a. In the User Name field, enter a user name.

   **Note:** You cannot use the following characters in the User Name field: space, forward slash (/), backslash (\), greater than sign (>), less than sign (<), asterisk (*), question mark (?), quotation mark ("), vertical line (|), colon (:), or semicolon (;).

   b. Click **OK**.

   Applied Biosystems recommends that you log in with a user name. If you log in with a user name, you can set preferences in the software. The next time you log in to the software with the same user name, the software uses the preferences you set as the defaults.

   **IMPORTANT!** If you log in to the software as a Guest, you cannot set preferences.

6. If you are prompted to update the instrument firmware, click **Upgrade Firmware Now**.

7. When the StepOne™ software prompts you to perform the RNase P experiment, click **Open Instrument Maintenance Manager**.

Wait while the StepOne™ software downloads the maintenance data from the instrument. If successful, the StepOne™ software automatically opens the RNase P Run wizard in the Instrument Maintenance Manager.

If the StepOne™ software displays the “Instrument Connection Failed” message:

   a. Confirm that the computer and instrument are connected by the yellow StepOne system cable as explained in **step 5 on page 30**.

   b. Power off the instrument, then after 30 sec power on the instrument.
c. When the instrument displays the main screen, click **Retry**.

If the problem persists, contact Applied Biosystems as explained in “How to Obtain Support” on page xii.

During normal operation, the Windows® operating system displays Local Area Connection messages when the StepOne™ software and instrument communicate. You can disable these messages by changing the network connection settings for the Ethernet network interface adapter as explained below.

### (Optional) Disable the Local Area Connection Messages

To disable the network connection alerts for the instrument connection:

1. In the desktop, select **Start** ➤ **Control Panel**, then double-click **Network Connections**.
2. Right-click **Local Area Connection**, then select **Properties**.
3. Deselect **Show icon in notification area when connected**.
4. Deselect **Notify me when this connection has limited or no connectivity**.
5. Click **OK**.

---

**Alert displayed when instrument communication...**

<table>
<thead>
<tr>
<th>Begins</th>
<th>Ends</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Local Area Connection is now connected" /></td>
<td><img src="image" alt="Local Area Connection" /></td>
</tr>
<tr>
<td>Speed: 10.0 Mbps</td>
<td>Speed: 0.0 Mbps</td>
</tr>
<tr>
<td>2:59 PM</td>
<td>2:59 PM</td>
</tr>
</tbody>
</table>
6. Close the Network Connections window.
Perform the RNase P Experiment

After you establish system communication, confirm the function of the system by running a TaqMan® RNase P Fast Instrument Verification Plate.

Materials Required
- TaqMan® RNase P Fast Instrument Verification Plate
- Powder-free gloves
- Safety glasses
- Centrifuge with reaction plate adapter

When to Perform the RNase P Experiment
Applied Biosystems recommends performing an RNase P experiment:
- After installing the system.
- After moving the instrument to another location.
- As needed to confirm the function of the instrument, depending on your laboratory and regulatory requirements.

Purpose of the Experiment
The TaqMan® RNase P Fast Instrument Verification Plate experiment verifies the performance of the instrument. The RNase P plate is preloaded with the reagents necessary for the detection and quantitation of genomic copies of the human RNase P gene (a single-copy gene encoding the RNase moiety of the RNase P enzyme).

Each well contains:
- 1X TaqMan® Fast Universal PCR Master Mix, No AmpErase® UNG
- RNase P primers
- FAM™ dye-labeled probe
- Known concentration of human genomic DNA template

The figure below illustrates the arrangement of the standard and unknown populations on the RNase P plate. The RNase P plate contains five replicate groups of standards (1250, 2500, 5000, 10,000, and 20,000 copies), two unknown populations (5000 and 10,000 copies), and negative control wells (NC).
After the run, the StepOne™ software:

1. Generates a standard curve from the averaged threshold cycle (C_t) values of the replicate groups of standards.

2. Calculates the concentration of the two unknown populations using the standard curve.

3. Calculates the following to assess the instrument performance:

\[
\left(\frac{(\text{CopyUnk}_2 - 3\sigma_{\text{CopyUnk}_2})}{(\text{CopyUnk}_1 + 3\sigma_{\text{CopyUnk}_1})}\right) > 0
\]

where:

- \(\text{CopyUnk}_1\) = Average copy number of unknown #1 (5,000-copy population)
- \(\sigma_{\text{CopyUnk}_1}\) = Standard deviation of unknown #1 (5,000-copy population)
- \(\text{CopyUnk}_2\) = Average copy number of unknown #2 (10,000-copy population)
- \(\sigma_{\text{CopyUnk}_2}\) = Standard deviation of unknown #2 (10,000-copy population)

**Installation Specification**

The instrument passes the installation specification if the inequality holds and the instrument successfully distinguishes between 5,000 and 10,000 copies with greater than 99.7% confidence.

To meet the installation specification, you can omit a limited number of outlier wells from the 5,000- and 10,000-copy unknown populations. The number of wells that you can remove depends on the instrument that you are installing.

<table>
<thead>
<tr>
<th>Instrument</th>
<th>Maximum number of outlier wells that can be removed from each...</th>
<th>Total</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Unknown Population</td>
<td>Standard (STD)</td>
</tr>
<tr>
<td>StepOnePlus™ System</td>
<td>6</td>
<td>0</td>
</tr>
<tr>
<td>StepOne™ System</td>
<td>2</td>
<td>0</td>
</tr>
</tbody>
</table>
Set Up the Experiment

Prepare the TaqMan® RNase P Fast Instrument Verification Plate for the run.

**IMPORTANT!** Do not use an RNase P plate for another Applied Biosystems instrument to verify the performance of the StepOne™ system. RNase P plates for other instruments contain the TAMRA™ dye, which is not supported by the StepOne™ system.

**IMPORTANT!** Wear powder-free gloves when you handle the RNase P plate.

1. Get the TaqMan® RNase P Fast Instrument Verification Plate from the freezer, then allow the reaction plate to warm to room temperature (for approximately 5 min).

2. Remove the RNase P plate from its packaging.

3. Vortex the reaction plate for 5 sec.

4. Centrifuge the reaction plate for 2 min at less than 1500 rpm.

**IMPORTANT!** The reaction plate must be well mixed and centrifuged.

5. Confirm that the liquid is at the bottom of each well of the reaction plate. If not, centrifuge the reaction plate again at a greater rpm and for a longer time.

**IMPORTANT!** Do not allow the bottom of the RNase P plate to become dirty. Fluids and other contaminants that adhere to the bottom of the reaction plate can contaminate the sample block(s) and cause an abnormally high background signal.

<table>
<thead>
<tr>
<th>Correct</th>
<th>Incorrect</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Correct Liquid" /></td>
<td><img src="image" alt="Incorrect Liquid" /></td>
</tr>
</tbody>
</table>

- Liquid is at the bottom of the well.
- Not centrifuged with enough force, or
- Not centrifuged for enough time

**Notes**
Run the Experiment

After preparing the TaqMan® RNase P Fast Instrument Verification Plate, load the plate into the instrument and start the run.

**CAUTION** PHYSICAL INJURY HAZARD. During instrument operation, the temperature of the sample block(s) can exceed 100°C. If the instrument has been used recently, keep your hands away until the sample block(s) reach room temperature.

**IMPORTANT!** Wear powder-free gloves when you handle the RNase P plate.

1. Open the instrument drawer.

2. Place the RNase P plate in the sample block(s) so that the A1 position is at the back-left corner of the sample block(s).

3. Close the instrument drawer carefully.

Notes
**Start the Run**

1. If the StepOne™ software automatically opened the RNase P Run dialog box, go to step 2. Otherwise, display the wizard as follows:
   a. Select **Instrument ➤ Instrument Maintenance Manager**.
   b. In the Instrument Maintenance Manager, select **RNase P** in the navigation column.
   c. Click **Start RNase P Run**.

2. In the Setup screen of the RNase P Run wizard, select **The RNase P plate is loaded into the instrument**.

3. Click **Next**.

4. In the Run screen of the RNase P Run wizard, click **Start Run** ➤ .

**Note:** Before starting the run, the instrument may take up to 15 min to heat the heated cover to the correct temperature.
Analyze the Experiment

Review the data to confirm the results of the experiment.

**Note:** After the StepOne™ software completes the RNase P run, it automatically analyzes the run and displays the results in the Analysis screen.

1. In the Analysis screen of the RNase P Run wizard, confirm the status of the run:
   - **Passed** – The instrument passed the RNase P run. Go to step 5 on page 48.
   - **Failed** – The instrument failed the RNase P run. Go to step 2 to screen the experiment for outliers.

   If the run fails, the automated analysis may have included outliers that caused the initial analysis to fail. Experimental error may cause some wells to be amplified insufficiently or not at all. These wells typically produce Ct values that differ significantly from the average for the associated replicate wells. If included in the calculations, these outlying data (outliers) can result in erroneous measurements.

2. In the Amplification Plot, select **Ct vs. Well** from the Plot Type dropdown menu.

3. Confirm the uniformity of each replicate population on the reaction plate (controls, standards, and unknowns) by comparing the groupings of Ct values:
   - In the plate layout, select the wells containing the 10,000-copy unknown population:
     - **StepOne™ System** – Wells from columns 1, 2, 6, 7, and 8 in rows D, E, and F
     - **StepOnePlus™ System** – Wells rows F, G, and H
   - **Note:** The numbers on the X-axis of the plot correspond to the wells of the reaction plate. Beginning with well A1, the wells are numbered from left-to-right, and top-to-bottom.
c. If an outlier is present in the population, select the corresponding well in the plate layout, then click **Omit** to remove the well from the analysis.

<table>
<thead>
<tr>
<th>Instrument</th>
<th>Maximum number of outlier wells that can be removed from each...</th>
<th>Total</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Unknown Population</td>
<td>Standard (STD)</td>
</tr>
<tr>
<td>StepOnePlus™ System</td>
<td>6</td>
<td>0</td>
</tr>
<tr>
<td>StepOne™ System</td>
<td>2</td>
<td>0</td>
</tr>
</tbody>
</table>

**IMPORTANT!** If too many outliers are present, order another RNase P plate and repeat the experiment.

d. Repeat steps 3a through 3c for each replicate population (unknowns, standards, and negative controls) on the reaction plate.

4. Click **Reanalyze** to analyze the run without the outliers.

If the status of the RNase P Run is “Failed” after performing steps 2 through 4, repeat the RNase P experiment using a different RNase P plate. If the problem persists, contact Applied Biosystems as explained in “How to Obtain Support” on page xii.
5. Review the standard curve:
   a. Select the Standard Curve tab.
   b. Click the upper-right corner of the Plate Layout to select all wells.
   c. Confirm that the R2 value is greater than or equal to 0.990.

   If the R2 value is less than 0.990, repeat the RNase P experiment using a different RNase P plate. If the problem persists, contact Applied Biosystems as explained in “How to Obtain Support” on page xii.

6. Click Finish, click Yes when prompted to save the experiment.
Unpack the instrument

**CAUTION** PHYSICAL INJURY HAZARD. During instrument operation, the temperature of the sample block(s) can exceed 100°C. If the instrument has been used recently, keep your hands away until the sample block(s) reach room temperature.

**IMPORTANT!** Wear powder-free gloves when you handle the RNase P plate.

1. Open the instrument drawer.
2. Remove the RNase P plate from the sample block(s).
3. Close the instrument drawer carefully.
4. Dispose of the RNase P plate.

**IMPORTANT!** Do not power off the instrument following a run. The instrument automatically enters a hibernation mode when not in use. Power off the instrument only when it will not be used for an extended period.
After the Installation

After verifying the performance of the system by completing the RNase P experiment, you can install additional software to the computer and/or connect the instrument to a network.

Install Additional Software

Applied Biosystems recommends installing the following types of software to improve the function and security of the system computer:

- Antivirus software
- Archival or file compression software
- Security software (firewall and encryption utilities)
- Performance optimizing software

Note: For more information, see “Select Protective Hardware and Software” on page 7.

To confirm that third-party software does not interfere with the StepOne™ software:

1. Install the software to the computer that contains the StepOne™ software.
2. Perform several test experiments using “dummy” plates (plates that do not contain reagents).

Note: The goal of the test experiments is to run plates under conditions that match normal instrument operation. Therefore, the characteristics of the test experiments (plate layout and run method) must closely resemble your actual experiments.

3. Confirm that the system performs each test experiment without producing errors.
   If the system performs the tests successfully, perform experiments normally. If the system encounters errors during the test runs, the software may not be compatible with the StepOne™ software.

Network the System

You can expand the functionality of the colocated instrument by connecting it to an Ethernet network. When the colocated instrument is part of a network, computers on the network that are running the StepOne™ software can:

- Monitor the status of a run in progress
- Send and download experiments to and from the instrument

IMPORTANT! Computers linked to a colocated instrument over a network cannot control the instrument.

To connect the instrument to a network, go to Chapter 5, “Connect the System to a Network,” on page 77.
This chapter covers:

- About the Standalone Installation .................................................. 52
- Set Up the Computer ................................................................. 54
  - Install the Computer ................................................................. 55
  - Install the StepOne™ Software .................................................... 57
- Check for StepOne™ Software Updates ........................................... 61
- Prepare the StepOne™ Software for Standalone Use ......................... 62
- Perform the RNase P Experiment .................................................... 64
  - Set Up the Experiment ............................................................. 66
  - Run the Experiment ................................................................. 67
- Analyze the RNase P Experiment ..................................................... 69
  - Unload the Instrument .............................................................. 69
  - Transfer the Experiment ......................................................... 70
  - Analyze the Experiment ........................................................... 72
- After the Installation ................................................................. 75

**Note:** For more information about any of the topics discussed in this guide, access the Help from within the Applied Biosystems StepOne™ Real-Time PCR System Software by pressing F1, or clicking HELP in the toolbar, or selecting Help ➤ StepOne Software Help.
About the Standalone Installation

This chapter explains how to install the system for standalone operation.

When to Perform a Standalone Installation

In this layout, the instrument is *not* connected to the computer running the StepOne™ software. Instead, a USB drive (†) is used to transfer data between the system components. Install the system in the standalone layout when the computer and the instrument must be placed in separate locations. See “Standalone Layout” on page 10 for complete descriptions of the layouts.

*Note:* If you want to connect the computer to the instrument, perform the colocated installation as described in Chapter 3, “Install the Colocated Layout.”
Chapter 4 Install the Standalone Layout

Chapter 2, Set Up the Instrument

Set Up the Computer
1. Install the computer.
2. Install the StepOne™ software.

Note: Perform step 2 only if you did not order a computer from Applied Biosystems.

Check for Software Updates

Prepare the Software for Standalone Use

Perform the RNase P Experiment
1. Set up the experiment.
2. Run the experiment.

Analyze the RNase P Experiment
1. Transfer the experiment data.
2. Analyze the experiment.

Chapter 5, Connect the System to a Network
Set Up the Computer

After you install the StepOne™ or StepOnePlus™ instrument, set up the standalone computer.

**IMPORTANT!** If you ordered a computer from Applied Biosystems, you need only to unpack the computer as explained on page 55. Computers shipped by Applied Biosystems are ready for use with the instrument and already contain the StepOne™ software.

**Materials Required**
- Computer

**IMPORTANT!** If you did not order a computer from Applied Biosystems, provide a computer that satisfies the requirements listed in “Minimum Computer Requirements” on page 6.

- Screwdrivers, flathead and Phillips
- (Optional) Protective hardware to install to the computer

Applied Biosystems recommends that you install one or more of the following electrical devices to the computer to prevent loss of data and to protect the computer from damage resulting from electrical hazards:
- Power line regulator
- Uninterruptible power supply (UPS)
- Surge protector
- Backup storage device

For more information, see “Select Protective Hardware and Software” on page 7.
Install the Computer

After obtaining the required materials, install the computer.

Confirm the Site Requirements

Confirm that the installation site meets the physical and environmental requirements for the computer. See the documentation for your computer for the site requirements.

**CAUTION** PHYSICAL INJURY HAZARD. Improper lifting can cause painful and sometimes permanent back injury. Use proper lifting technique when lifting or moving the computer. We recommend safety training for proper lifting techniques. Do not attempt to lift or move the computer or the monitor without the assistance of others. Depending on the weight of the computer, this may require two or more people.

1. If you have not done so already, unpack the monitor, computer, keyboard, and mouse, and assemble the computer components as described in the computer installation guide.

Guidelines for lifting and moving the computer:

- Make sure that you have a secure grip on the computer when lifting.
- Make sure that the pathway from the beginning of the lift to the final location is clear of obstructions.
- Do not lift an object and twist your torso at the same time.
- Keep your spine in a neutral position while lifting with your legs.
- Coordinate lift and movement with all participants before lifting and carrying the computer.
- Instead of lifting the computer/monitor from the packing box, tilt the box on its side, then slide the contents out of the box.

2. Make the following connections:

<table>
<thead>
<tr>
<th>Connect</th>
<th>Do Not Connect</th>
</tr>
</thead>
<tbody>
<tr>
<td>Power</td>
<td>Ethernet</td>
</tr>
<tr>
<td>Mouse</td>
<td></td>
</tr>
<tr>
<td>Keyboard</td>
<td></td>
</tr>
<tr>
<td>Monitor</td>
<td></td>
</tr>
</tbody>
</table>

3. If you ordered a laptop computer from Applied Biosystems, install the PCMCIA Network Card as described in the documentation accompanying the card.

After installing the PCMCIA Network Card, wait several minutes to allow the computer to enable the device. The computer may require time to initialize the drivers and register the network card with the operating system before it is available for use.
4. If you ordered a tower computer from Applied Biosystems, set the voltage appropriately for your region as described in the computer installation guide.

5. (Optional) Install electrical protective devices to the computer.

   **Note:** For more information, see “Select Protective Hardware and Software” on page 7.

### Power On the Computer

1. Power on the computer and monitor.

2. Log onto the operating system:
   - If you are using a computer that you provided, log on to the operating system as a member of the Administrators user group.
   - If you are using a computer from Applied Biosystems, enter *Administrator* in the User field, then click Login. Leave the Password field blank.

   **IMPORTANT!** If you are installing a computer that you provided, log onto the Windows® operating system using a user account that belongs to the Administrators user group.

3. In the Getting Started with Windows® XP window, deselect *Show this screen at startup*, then click Exit.

4. Determine the next step:
   - If you are installing a computer that you provided, go to “Install the StepOne™ Software” on page 57.
   - If you are installing a computer from Applied Biosystems, go to “Check for StepOne™ Software Updates” on page 61.
Chapter 4 Install the Standalone Layout
Set Up the Computer

Install the StepOne™ Software

After setting up the computer, define the display properties, computer name, and the date and time settings, then install the StepOne™ software.

**IMPORTANT!** If you ordered a computer from Applied Biosystems, skip “Install the StepOne™ Software” and go to “Check for StepOne™ Software Updates” on page 61. Computers that are supplied by Applied Biosystems already contain the StepOne™ software, and are ready for use with the instrument.

1. **Prepare the Operating System**

   a. Right-click the desktop, then select **Properties**.
   
   b. In the Display Properties dialog box, select the **Screen Saver** tab.
   
   c. In the Screen saver group box, select **(None)** in the dropdown menu.
   
   d. Click **Power**.
   
   e. In the Power Options Properties dialog box, select **Home\Office Desk** from the Power schemes dropdown list.
   
   f. Define the Plugged in power scheme settings:
      - Monitor – Select **After 20 mins** from the Plugged in dropdown menu.
      - Hard Disks – Select **Never** from the Plugged in dropdown menu.
      - System standby – Select **Never** from the Plugged in dropdown menu.
   
   g. Click **OK** to save the settings.
2. Change the screen resolution:
   a. In the Display Properties dialog box, select the **Settings** tab.
   b. In the Screen Area group box, use the slider to select **1280 by 1024 pixels**.
   c. In the Colors group box, select **Highest (32 bit)** in the dropdown menu.
   d. Click **OK** twice, then click **Yes** to accept the new resolution.

3. Define the date and time settings:
   a. Right-click the time readout in the toolbar, then select **Adjust Date/Time**.
   b. In the Date & Time tab, define the date and time settings.
   c. Select the **Time Zone** tab.
   d. Select a time zone from the dropdown menu, then select **Automatically adjust clock for daylight saving changes** if necessary.
   e. Click **OK**.

**Note:** Computers on a network synchronize their date/time settings with the server.
4. Change the computer name:
   a. In the desktop, right-click **My Computer**, then select **Properties**.
   b. In the System Properties dialog box, select the **Computer Name** tab.
   c. Click **Change**.
   d. In the Computer Name field, enter the computer name.

   **CAUTION**
   Do not give the computer the same name as the instrument. A shared name could lead to network conflicts if you install both devices to an Ethernet network.

   e. If necessary, define the Domain or Workgroup settings if you are going to connect the computer to a network.
   f. Click **OK** twice.
   g. In the Network Identification dialog box, click **OK**.

   **Note:** The computer name identifies the computer on the network and must be different than that of the instrument. After you install the system, you can change the computer name without disrupting the function of the StepOne™ software.

5. In the Systems Settings Change dialog box, click **Yes** to restart the computer.

6. Log onto the operating system as a member of the Administrators user group.
Chapter 4  Install the Standalone Layout
Set Up the Computer

Install the Software

IMPORTANT! You must be logged into the Windows® operating system as an administrator to install the StepOne™ software.

Note: If you encounter errors during the installation of the StepOne™ software, uninstall the software as explained in “Uninstall the StepOne™ Software” on page 134.

1. Insert the Applied Biosystems StepOne™ Real-Time PCR System Software CD into the CD drive of the computer and wait for the installer to start.
   If the installer does not automatically start, double-click (My Computer), navigate to the CD drive, then double-click Setup.exe.

2. In the Welcome page of the InstallShield Wizard, click Next.

3. In the License Agreement page, click Yes to accept the agreement.

4. In the Choose Destination Location page, click Next to accept the default location.
   Note: Applied Biosystems recommends installing the StepOne™ software to the D drive; however, you can install the software to another location.

5. In the Default Instrument Type page, select the type of instrument that you are installing (StepOnePlus™ Instrument or StepOne™ Instrument), then click Next.

6. In the Start Copying Files page, confirm that the installation location displayed in the Current Settings field is correct, then click Next to begin installing the StepOne™ software.

7. When the StepOne™ software completes the installation, click Finish.
Check for StepOne™ Software Updates

Updates and/or patches may be available for the StepOne software. Applied Biosystems recommends that you check for software updates before you proceed with the installation.

**Note:** To periodically check for software updates after the StepOne or StepOnePlus system is installed (as part of routine maintenance), see “Update the StepOne™ Software or the Operating System” on page 130.

To check for software updates:

1. Go to: [http://www.lifetechnologies.com/support](http://www.lifetechnologies.com/support) and click the **Instrument Software, Patches & Updates** link.

2. In the Instrument Software, Patches & Updates page, click the link for the appropriate software.

3. Under Software Download, view the available downloads.

4. If there are updates and/or patches for StepOne software v2.1 or later, select the appropriate option, then follow the prompts to begin the download.

   You may be asked for your instrument serial number. The serial number is on the back panel of your instrument, or can be obtained from the instrument touchscreen.
Prepare the StepOne™ Software for Standalone Use

After installing the StepOne™ software, set the software preferences so that the software does not attempt to connect to the instrument at startup or confirm the status of the RNase P experiment.

1. In the desktop, double-click (StepOne software) or select Start → All Programs → Applied Biosystems → StepOne Software → <software name>
   where <software name> is the current version of the StepOne software.

2. In the Login dialog box, create a user name.
   a. In the User Name field, enter a user name.

   Note: You cannot use the following characters in the User Name field: space, forward slash (/), backslash (\), greater than sign (>), less than sign (<), asterisk (*), question mark (?), quotation mark ("), vertical line (|), colon (:), or semicolon (;).

   b. Click OK.

   Applied Biosystems recommends that you log in with a user name. If you log in with a user name, you can set preferences in the software. The next time you log in to the software with the same user name, the software uses the preferences you set as the defaults.

   IMPORTANT! If you log in to the software as a Guest, you cannot set preferences. You will not be able to perform the steps in “Set the Preferences” on page 63.
Chapter 4 Install the Standalone Layout
Prepare the StepOne™ Software for Standalone Use

3. When the Instrument Connection Failed dialog box appears, click Continue without connection.

Set the Preferences

1. In the Main Screen, select Tools ➤ Preferences.

2. In the Preferences dialog box, select the Startup tab.

3. Deselect Connect to default instrument.

4. Click OK.
Perform the RNase P Experiment

After you install the instrument, confirm the function of the system by running a TaqMan® RNase P Fast Instrument Verification Plate.

Materials Required
- TaqMan® RNase P Fast Instrument Verification Plate
- Powder-free gloves
- Safety glasses
- Centrifuge with plate adapter

When to Perform the RNase P Experiment
Applied Biosystems recommends performing an RNase P experiment:
- After installing the system.
- After moving the instrument to another location.
- As needed to confirm the function of the instrument, depending on your laboratory and regulatory requirements.

Purpose of the Experiment
The TaqMan® RNase P Fast Instrument Verification Plate experiment verifies the performance of the instrument. The RNase P plate is preloaded with the reagents necessary for the detection and quantitation of genomic copies of the human RNase P gene (a single-copy gene encoding the RNase moiety of the RNase P enzyme).

Each well contains:
- 1X TaqMan® Fast Universal PCR Master Mix, No AmpErase® UNG
- RNase P primers
- FAM™ dye-labeled probe
- Known concentration of human genomic DNA template

The figure below illustrates the arrangement of the standard and unknown populations on the RNase P plate. The RNase P plate contains five replicate groups of standards (1250, 2500, 5000, 10,000, and 20,000 copies), two unknown populations (5000 and 10,000 copies), and negative control wells.

![TaqMan® 48-well RNase P Plate for the StepOne™ System](image1)

![TaqMan® 96-well RNase P Plate for the StepOnePlus™ System](image2)
After the run, the StepOne™ software:

1. Generates a standard curve from the averaged threshold cycle ($C_T$) values of the replicate groups of standards.

2. Calculates the concentration of the two unknown populations using the standard curve.

3. Calculates the following to assess the instrument performance:

$$[(\text{CopyUnk}_1) - 3(\sigma_{\text{CopyUnk}_1})] > [(\text{CopyUnk}_2) + 3(\sigma_{\text{CopyUnk}_2})]$$

where:

- $\text{CopyUnk}_1 =$ Average copy number of unknown #1 (5,000-copy population)
- $\sigma_{\text{CopyUnk}_1} =$ Standard deviation of unknown #1 (5,000-copy population)
- $\text{CopyUnk}_2 =$ Average copy number of unknown #2 (10,000-copy population)
- $\sigma_{\text{CopyUnk}_2} =$ Standard deviation of unknown #2 (10,000-copy population)

**Installation Specification**

The instrument passes the RNase P experiment if the inequality holds and the instrument successfully distinguishes between 5,000 and 10,000 copies with greater than 99.7% confidence.

To meet the installation specification, you can omit a limited number of outlier wells from the 5,000- and 10,000-copy unknown populations. The number of wells that you can remove depends on the instrument that you are installing.

<table>
<thead>
<tr>
<th>Instrument</th>
<th>Maximum number of outlier wells that can be removed from each...</th>
<th>Total</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Unknown Population</td>
<td>Standard</td>
</tr>
<tr>
<td>StepOnePlus™ System</td>
<td>6</td>
<td>0</td>
</tr>
<tr>
<td>StepOne™ System</td>
<td>2</td>
<td>0</td>
</tr>
</tbody>
</table>
Set Up the Experiment

Prepare the TaqMan® RNase P Fast Instrument Verification Plate for the run.

**IMPORTANT!** Do not use an RNase P plate for another Applied Biosystems instrument to verify the performance of the StepOne™ system. RNase P plates for other instruments contain the TAMRA™ dye, which is not supported by the StepOne™ system.

**IMPORTANT!** Wear powder-free gloves when you handle the RNase P plate.

1. Get the TaqMan® RNase P Fast Instrument Verification Plate from the freezer, then allow the reaction plate to warm to room temperature (for approximately 5 min).

2. Remove the RNase P plate from its packaging.

3. Vortex the RNase P plate for 5 sec.

4. Centrifuge the RNase P plate for 2 min at less than 1500 rpm.

**IMPORTANT!** The RNase P plate must be well mixed and centrifuged.

5. Confirm that the liquid is at the bottom of each well of the RNase P plate. If not, centrifuge the plate again at a greater rpm and for a longer time.

**IMPORTANT!** Do not allow the bottom of the RNase P plate to become dirty. Fluids and other contaminants that adhere to the bottom of the RNase P plate can contaminate the sample block(s) and cause an abnormally high background signal.

<table>
<thead>
<tr>
<th>Correct</th>
<th>Incorrect</th>
</tr>
</thead>
<tbody>
<tr>
<td>Liquid is at the bottom of the well.</td>
<td>- Not centrifuged with enough force, or - Not centrifuged for enough time</td>
</tr>
</tbody>
</table>
Run the Experiment

After preparing the TaqMan® RNase P Fast Instrument Verification Plate, load the plate into the instrument and start the run.

⚠️ CAUTION PHYSICAL INJURY HAZARD. During instrument operation, the temperature of the sample block(s) can exceed 100°C. If the instrument has been used recently, keep your hands away until the sample block(s) reaches room temperature.

IMPORTANT! Wear powder-free gloves when you handle the RNase P plate.

1. Open the instrument drawer.

2. Place the RNase P plate in the sample block(s) so that the A1 position is at the back-left corner of the sample block(s).

3. Close the instrument drawer carefully.

Notes
Start the Run

1. Touch the instrument touchscreen to awaken it, then touch 🔄.

2. In the Main Menu, touch **Tools Menu**, then touch **RNase P Wizard**.

3. In the Welcome screen, touch **Continue**, then touch → four times to bypass the instructions screens.

4. In the Start Run screen, touch **Start** to begin the run.

**Note:** Before starting the run, the instrument may take up to 15 min to heat the heated cover to the correct temperature.
Chapter 4
Install the Standalone Layout
Analyze the RNase P Experiment

Analyze the RNase P Experiment

After setting up the computer and the instrument completes the run, analyze the RNase P experiment.

Materials Required

- Powder-free gloves
- Safety glasses
- USB Drive (from the system packing kit)

Unload the Instrument

Unload the RNase P plate from the instrument.

**CAUTION PHYSICAL INJURY HAZARD.** During instrument operation, the temperature of the sample block(s) can exceed 100°C. If the instrument has been used recently, keep your hands away until the sample block(s) reaches room temperature.

**IMPORTANT!** Wear powder-free gloves when you handle the RNase P plate.

1. Open the instrument drawer.
2. Remove the RNase P plate from the sample block(s).
3. Close the instrument drawer carefully.
4. Dispose of the RNase P plate.

**IMPORTANT!** Do not power off the instrument following a run. The instrument automatically enters a hibernation mode when not in use. Power off the instrument only when it will not be used for an extended period.

---

Notes

Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems
Installation, Networking, and Maintenance Guide
Transfer the Experiment

After unloading the instrument, transfer the experiment data to the computer for analysis.

Transfer the Data to the USB Drive

1. Connect a USB drive to the USB port.

2. In the RNase P Wizard, touch \( \rightarrow \).

   If the instrument cannot find the USB drive, touch \( \text{OK} \), wait for 30 sec, then touch \( \text{Collect Results} \) again.

3. When prompted that the data has been transferred successfully, touch \( \text{OK} \), then touch \( \rightarrow \).

4. Remove the USB drive from the instrument.

Notes______________________________________________________________
Transfer the Data to the Computer

1. Connect the USB drive to one of the USB ports on the computer.
2. In the StepOne™ software, select Instrument > Instrument Maintenance Manager.
3. In the Instrument Maintenance Manager, click RNase P.
4. Select the RNase P Run:
   a. In the RNase P Run screen, click Browse.
   b. In the Open dialog box, navigate to the USB drive.
   c. In the file name field, select the experiment.
   d. Click Open.

The StepOne™ software automatically analyzes the run and displays the results in the RNase P Run screen.
Analyze the Experiment

Review the data to confirm the results of the experiment.

1. In the Analysis screen of the RNase P Run wizard, confirm the status of the run:
   - **Passed** – The instrument passed the RNase P run. Go to step 5 on page 74.
   - **Failed** – The instrument failed the RNase P run. Go to step 2 to screen the experiment for outliers.

   If the run fails, the automated analysis may have included outliers that caused the initial analysis to fail. Experimental error may cause some wells to be amplified insufficiently or not at all. These wells typically produce $C_T$ values that differ significantly from the average for the associated replicate wells. If included in the calculations, these outlying data (outliers) can result in erroneous measurements.

2. In the Amplification Plot, select **Ct vs. Well** from the Plot Type dropdown menu.

3. Confirm the uniformity of each replicate population on the RNase P plate (controls, standards, and unknowns) by comparing the groupings of $C_T$ values:
   a. In the plate layout, select the wells containing the 10,000-copy unknown population:
      - StepOne™ System – Wells from columns 1, 2, 6, 7, and 8 in rows D, E, and F
      - StepOnePlus™ System – Wells rows F, G, and H
   b. In the plot, confirm that the $C_T$'s of the replicate population are equivalent.

   **Note:** The numbers on the X-axis of the plot correspond to the wells of the reaction plate. Beginning with well A1, the wells are numbered from left-to-right, and top-to-bottom.
c. If an outlier is present in the population, select the corresponding well in the plate layout, then click **Omit** to remove the well from the analysis.

![Image of plate layout with outliers highlighted]

**IMPORTANT!** If too many outliers are present, order another RNase P plate and repeat the experiment.

d. Repeat steps 3a through 3c for each replicate population (unknowns, standards, and negative controls) on the reaction plate.

4. Click **Reanalyze** to analyze the run without the outliers.

If the status of the RNase P Run is “Failed” after performing steps 2 through 4, repeat the RNase P experiment using a different RNase P plate. If the problem persists, contact Applied Biosystems as explained in “How to Obtain Support” on page xii.
5. Review the standard curve:
   a. Select the **Standard Curve** tab.
   b. Click the upper-right corner of the Plate Layout to select all wells.
   c. Confirm that the R2 value is greater than or equal to 0.990.

If the R2 value is less than 0.990, repeat the RNase P experiment using a different RNase P plate. If the problem persists, contact Applied Biosystems as explained in “How to Obtain Support” on page xii.

6. Click **Save Status**, then click **Yes** when prompted.

7. Touch the instrument touchscreen to awaken it, then touch **Pass** in the RNase P wizard.

---

**Notes**
After the Installation

After verifying the performance of the system, you can install additional software to the computer and/or connect the instrument to an Ethernet network.

Install Additional Software

Applied Biosystems recommends installing the following types of software to improve the function and security of the system computer:

- Antivirus software
- Archival or file compression software
- Security software (firewall and encryption utilities)
- Performance optimizing software

Note: For more information, see “Select Protective Hardware and Software” on page 7.

To confirm that third-party software does not interfere with the StepOne™ software:

1. Install the software to the computer that contains the StepOne™ software.

2. Perform several test experiments using “dummy” plates (plates that do not contain reagents).

   Note: The goal of the test experiments is to run plates under conditions that match normal instrument operation. Therefore, the characteristics of the test experiments (plate layout and run method) must closely resemble your actual experiments.

3. Confirm that the system performs each test experiment without producing errors. If the system performs the tests successfully, perform experiments normally. If the system encounters errors during the test runs, the software may not be compatible with the StepOne™ software.

Network the System

If the standalone instrument is connected to a network, then computers on the network that are running the StepOne™ software can:

- Monitor the status of the run in progress
- Send and download experiments to and from the instrument instead of using the USB drive

To connect the instrument to a network, go to Chapter 5, “Connect the System to a Network,” on page 77.
Chapter 5

5

Connect the System to a Network

This chapter covers:

■ Overview ................................................................. 78
■ Connect the Instrument to a Network ......................... 82
■ Set Up a Computer for Remote Monitoring ................ 84
■ Monitor the Instrument .............................................. 86

Note: For more information about any of the topics discussed in this guide, access the Help from within the Applied Biosystems StepOne™ Real-Time PCR System Software by pressing F1, or clicking in the toolbar, or selecting Help → StepOne Software Help.

IMPORTANT! This chapter does not provide adequate detail to integrate the Applied Biosystems StepOne™ or StepOnePlus™ Real-Time PCR Instrument into all possible network architectures. Because your network may contain advanced features (such as a firewall or network domains), Applied Biosystems recommends that you consult a network administrator before connecting the Applied Biosystems StepOne™ or StepOnePlus™ Real-Time PCR System to your laboratory network.
Overview

After installing the Applied Biosystems StepOne™ or StepOnePlus™ Real-Time PCR System, you can connect the instrument to a local area network to enhance its functionality.

This chapter describes how to:

- Set up the instrument for use on a network.
- Set up a computer for remote monitoring.
- Test the network connection by engaging the remote monitoring feature.

About Remote Monitoring

Once the instrument is connected to a network, any computer on the network can use the remote monitoring feature of the StepOne™ software to monitor the instrument. During a run, the remote monitoring feature can provide run status, temperature, and amplification data as the instrument collects them. See “Monitor the Instrument” on page 86 for more information on remote monitoring.

**IMPORTANT!** The remote monitoring feature does not allow you to control of the instrument. Control of the instrument is limited to the colocated computer when the system is in a colocated layout, or the instrument touchscreen when the system is in a standalone layout.

Network Setup Workflow

1. Connect the computer to the network.
2. Install the StepOne™ software.
3. Define the LAN Port IP settings.
4. Enable remote monitoring.

Test the network connection

1. Enable remote monitoring.
Example Network Layouts

The LAN and Computer Ports of the instrument allow you to add the system to a network in several ways. The following examples describe two basic network layouts of the system.

**Networked Standalone Layout**

In this example, a standalone instrument is connected to a network by the instrument LAN Port ( ), which has been configured for dynamic host configuration protocol (DHCP) or static IP operation. In this layout, any computer on the network can monitor and exchange experiment data with the instrument; however, computers on the network cannot control the instrument. Runs must be started from the instrument touchscreen.

**Networked Colocated Layout**

In this example, a colocated instrument is connected to a networked colocated computer by the Computer Port ( ), and to a network by the LAN Port ( ) that has been configured for DHCP or static IP operation. In this layout, computers on the network can monitor and exchange experiment data with the instrument; however, the instrument is controlled locally by the colocated computer.

**IMPORTANT!** Consult your IT department to network a colocated computer. To enable the full functionality of the StepOne™ software, the colocated computer requires a network connection.
Instrument Ports

The instrument supports two 10Base-T Ethernet connections: a Computer Port for communication with the colocated computer, and a Local Area Network (LAN) Port for network communication.

<table>
<thead>
<tr>
<th>Port</th>
<th>Purpose</th>
<th>Supports</th>
</tr>
</thead>
<tbody>
<tr>
<td>Computer Port</td>
<td>The connection for the colocated computer, which controls the instrument.</td>
<td>Static IP network service only with subnet mask and default gateway settings</td>
</tr>
<tr>
<td>Note: Applied Biosystems does not support colocated layouts in which the Computer Port does not directly connect the instrument to the colocated computer.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>LAN Port</th>
<th>The connection for a local area network. When the instrument is connected to a network, computers on the network that run the StepOne™ software can:</th>
<th>Supports</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• Remote monitor the instrument as it performs runs.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Send experiments to, and download experiments from the instrument.</td>
<td></td>
</tr>
<tr>
<td>IMPORTANT!</td>
<td>Computers connected to the instrument through the LAN port cannot control the instrument.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Static IP network service with subnet mask and default gateway settings or Dynamic host configuration protocol (DHCP) network service</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Managed data network service (mDNS/DNS) for local domains‡</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• IPv4 link-local (IPV4LL) in the RFC§</td>
<td></td>
</tr>
</tbody>
</table>

‡ Because managed data network service (mDNS) is limited to direct network connections, a instrument set for mDNS may not be visible to other nodes that are separated by a router, hub, or another network device.

§ Also known as Automatic Private IP Addressing (APIPA) or Internet Protocol Automatic Configuration (IPAC). When the instrument is set for DHCP, Automatic Private IP Addressing (APIPA) is automatically enabled, and the instrument provides an IP address when no address is supplied by the DHCP server.
• **Consult a Network Administrator**
  - Applied Biosystems recommends that you consult a network administrator before connecting the system to your laboratory network.
  - To enable the full functionality of the StepOne™ software, the colocated computer requires a network connection.

• **Confirm the Instrument Connections**
  Confirm that the instrument is connected to the network by the blue LAN Port ( ). If the system is installed in a colocated layout, confirm that the instrument is connected to the computer by the yellow Computer Port ( ).

• **Limit Remote Monitoring to One Computer**
  Avoid using more than one computer to simultaneously remote monitor the instrument. Although the system supports remote monitoring from multiple computers, each connection taxes the instrument microprocessor. Too many connections can overburden the instrument and result in instrument errors.

  **Note:** The effects of an overburdened instrument are evident in the Temperature Plot during a run. Symptoms can include extended hold times or brief, unexpected plateaus in the instrument Temperature Plot.

• **Observe Restrictions to mDNS and Auto Discovery**
  The instrument supports multicast domain name service (mDNS) but only when the instrument and computer share a direct network connection and are within the same subnet. Consequently, computers on the network that are separated from the instrument by a router, hub, or other network device may not be able to access the instrument by its host name.

  The instrument also does not support auto discovery for mDNS. However, the instrument does support name resolution but the instrument name must be unique within the subnet.

  **Note:** Confirm the uniqueness of the instrument name. The instrument does not test the uniqueness of the instrument name when it is set.

• **Add Instruments Using Lower Case Letters**
  When you add the instrument for remote monitoring (see “Enable Remote Monitoring” on page 86), enter the instrument name using lower case letters only.
Connect the Instrument to a Network

After deciding how to connect the instrument to a network, set up the instrument according to your network policies.

**Materials Required**
- Ethernet cable with RJ45 connectors

**Collect Required Information**
- Network policy for obtaining IP addresses: DHCP or static IP.

**IMPORTANT!** When the instrument is set for DHCP, Automatic Private IP Addressing (APIPA) is automatically enabled and the instrument will provide an IP address when no address is supplied by a DHCP server.

- If the network requires a static IP address, obtain the IP address, subnet mask, and gateway address for the instrument.

**How to Obtain the MAC Address of the Instrument**

If your systems administrator requests the Media Access Control (MAC) address for the instrument, obtain the MAC address as follows:

1. Touch the instrument touchscreen to awaken it, then touch .
2. In the Main Menu, touch **Settings Menu**, then touch **About the Instrument**.
   The MAC address for the instrument appears in the rights side of the About Instrument screen.

3. When finished, touch **Done**.
4. In the Settings Menu, touch **Home** to return to the Main Menu.
Chapter 5  Connect the System to a Network
Connect the Instrument to a Network

Define the LAN Port IP Settings

1. Touch the instrument touchscreen to awaken it, then touch 

2. In the Main Menu, touch Settings Menu, touch Admin Menu, then touch Set IP Address.

3. Enter the IP settings for the network connection.

<table>
<thead>
<tr>
<th>Network Service</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>DHCP</td>
<td>Touch Assign IP address dynamically (using DHCP), touch Done, then touch OK when prompted.</td>
</tr>
<tr>
<td>Static IP</td>
<td>1. Touch Static.&lt;br&gt;2. Enter the IP address, subnet mask, and default gateway settings. For each setting, touch the field, enter the address, then touch Done.&lt;br&gt;3. Touch Done to save the settings, then touch OK when prompted.</td>
</tr>
</tbody>
</table>

The following figure shows an example of static IP network settings for the LAN port of the instrument.

4. Touch to return to the Main Menu.

5. Connect the Ethernet cable between the:<br>• Blue LAN Port (Blue) of the instrument, and the<br>• Ethernet port for your network

IMPORTANT! Do not connect the Ethernet cable to the yellow Computer Port (Yellow); this port is reserved for the colocated computer connection.

Notes
Set Up a Computer for Remote Monitoring

After connecting the instrument to the network, connect the computer to the network and install the StepOne™ software for remote monitoring.

**Materials Required**

- Ethernet cable with RJ45 connectors

**Computer Requirement**

If you are connecting a computer that you provided to a network, confirm that the computer contains a network interface card (NIC) or a free network port.

**Collect Required Information**

- Network policy for obtaining IP addresses: DHCP or static IP
- If the network requires a static IP address, obtain the IP address, subnet mask, and gateway address for the computer

**Connect the Computer to the Network**

**IMPORTANT!** Applied Biosystems recommends that you arrange for a network administrator to connect your computer to the network. The following procedure does not provide adequate detail for all network architectures.

1. Use the Ethernet cable to connect the computer to the nearest network port.
2. Power on the computer, then log in using an account that belongs to the Administrators user group.
3. In the computer desktop, right-click **My Network Places**, then select **Properties**.
4. Right-click **Local Area Connection**, then select **Properties**.
5. Select **Internet Protocol (TCP/IP)**, then click **Properties**.

---

**Notes**

---

Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems Installation, Networking, and Maintenance Guide
6. Set the Internet Protocol (TCP/IP) Properties:

<table>
<thead>
<tr>
<th>Network Configuration</th>
<th>Action</th>
</tr>
</thead>
</table>
| DHCP                   | 1. Select **Obtain an IP address automatically.**  
2. If the computer obtains DNS addresses:  
  - Automatically – Select **Obtain DNS server address automatically.**  
  - Statically – Select **Use the following DNS address**, enter the address of the preferred and alternate DNS servers if available. |
| Static IP              | 1. Select **Use the following IP address.**  
2. In the IP Address field, enter the static IP address.  
3. If necessary, enter a subnet mask.  
4. If necessary, enter a static gateway address in the Default Gateway field. |

7. If your network requires advanced TCP/IP settings (such as WINS settings):
   a. Click **Advanced** in the Internet Protocol (TCP/IP) Properties dialog box.
   b. Define the IP Settings, DNS, and WINS tabs as instructed by your systems administrator, then click **OK**.

8. Close all dialog boxes by clicking **OK**.

9. Restart the computer.

**Note:** The computer is now visible to other computers on the network.

---

**Install the StepOne™ Software**

1. If you have not already done so, install the StepOne™ software to the networked computer (see “Install the Software” pages 35 or 60).

   **Note:** The StepOne™ software is required to monitor the instrument over the network.

2. (Optional) Install protective software to the computer (see “Select Protective Hardware and Software” on page 7).
Monitor the Instrument

After connecting the instrument and a computer to the network, test the network connection by enabling remote monitoring.

About Remote Monitoring

When the instrument is connected to the network, any computer on the network that is running the StepOne™ software can:

- Monitor the status of the instrument during and between runs
- Send an experiment to the instrument (see page 88)
- Download an experiment from the instrument (see page 88)
- Enable or change email notification settings for the instrument (see page 89)

Guidelines for Remote Monitoring

To ensure optimal performance of the remote monitoring feature, observe the following:

- Although the StepOne™ software can add multiple instruments for remote monitoring, it can monitor only one instrument at a time.
- Applied Biosystems does not recommend that an instrument be monitored by more than one computer simultaneously.
- Unless you are sure that your instrument and computer exist on the same subnet, Applied Biosystems recommends that you use the IP address of the instrument to add it for remote monitoring.

Enable Remote Monitoring

1. In the StepOne™ software, select **Instrument ➤ Remote Monitor**.
2. In the Manage Instrument screen, click **Add Instrument**.
3. Add the instrument in the Add Instrument dialog box:
   a. In the Profile Name field, enter the name of your instrument (from step 1b on page 21).
   b. In the Instrument Name, Host Name, or IP Address field, enter the host name or IP Address of the instrument that you want to monitor.
   c. Click **Save & Exit**.

   The StepOne™ software displays an entry for the instrument in the left-most column of the Manage Instruments screen.

4. Enable remote monitoring for the instrument:
   a. In the Manage Instrument pane of the StepOne™ software, select the instrument that you want to monitor.
   b. In the entry for the instrument, click ✉.

   **Note:** You can also monitor the instrument by selecting your instrument from the dropdown menu, then clicking **Monitor**.

---

**Notes**
The StepOne™ software displays the status, attributes, and plot data for the selected instrument in real time. If a communications warning appears, troubleshoot the problem as explained in “Network Connection Problems” on page 135.

You will lose the software connection to the colocated instrument if you:

- Change the instrument that is connected directly to your computer
- Use the colocated instrument touchscreen to change the instrument name or IP address

To reestablish the colocated connection, restart the StepOne™ software.
Send an Experiment to a Monitored Instrument

1. In the entry for your instrument, click .
2. Click Browse, then navigate to and select the experiment that you want send to the instrument, then click Open.
3. Select your instrument from the Select Instrument dropdown menu.
4. Click Send Experiment, then click OK when prompted.

Download an Experiment from a Monitored Instrument

1. In the entry for your instrument, click .
2. Select your instrument from the Instrument dropdown menu.
3. Select your experiment from the Experiment dropdown menu.
4. Click Browse, then navigate to and select the folder to which you want to send the experiment, then click Select.
5. Click Download Experiment, then click OK when prompted.
Enable or Change Notification Settings

The notification settings allow you to configure the StepOne™ software to alert you by email when the instrument begins and completes a run, or if an error occurs during a run. You can also set up the software to attach a completed run file to the Run Completed email notification. The notifications settings feature is optional and does not affect system performance.

**IMPORTANT!** The StepOne™ software will transmit email only while the instrument is monitored. If the network connection is interrupted, the StepOne™ software will stop transmitting updates.

**To modify the notification settings:**

1. Contact your systems administrator or information technology department for the:
   - Network address of a Simple Mail Transfer Protocol (SMTP) server.
   - A user name and password for the server, if required for access.
   - The Secure Sockets Layer (SSL) setting of the server (on or off).

2. While monitoring an instrument, select **Enable Run Notifications** in the top-right corner of the screen.

3. Click **Change Notifications**, change the Notification Settings as desired, then click the close box.

4. Select **Enable Notifications**.

5. Select the events that generate notifications:
   - **Instrument Error** – Causes the system to email recipients all errors encountered by the instrument during each run.
   - **Run Started** – Causes the system to email the recipients every time the instrument starts a run.
   - **Run Completed** – Causes the system to email the recipients every time the instrument completes a run.

6. Click the **Enter e-mail addresses for notifications** field, then enter the email address(es) that you want to receive email notifications.

7. Click the Outgoing Mail Server (SMTP) field, then enter the address of the SMTP server.

8. Select whether or not to attach completed run files to the Run Completed email notifications.

**Note:** This option applies only to email notifications that are generated when the instrument completes a run (that is, Run Completed is selected in step 5).
9. Set the authentication settings as needed.
   If the SMTP server requires authentication:
   
   a. Click Yes.
   
   b. Click the User Name field, then enter the user name to access the server.
   
   c. Click the Password field, then enter the password for the user account.

10. Click **Test Configuration**. If the notification settings are set up correctly, sample emails are sent to the addresses entered in step 6.
Maintain the System

This chapter covers:

- Regular Maintenance .................................................. 92
  - Perform a Spatial Calibration ........................................ 94
  - Perform a Background Calibration ............................... 98
  - Perform a Dye Calibration ......................................... 104
  - Archive and Back Up Data ......................................... 118
- Infrequent Maintenance .................................................. 120
  - Decontaminate the Sample Block(s) ............................ 121
  - Move the Instrument ............................................... 124
  - Replace the External Fuses ....................................... 126
  - Ship the Instrument for Service .................................. 128
  - Update the StepOne™ Software or the Operating System .... 130

Note: For more information about any of the topics discussed in this guide, access the Help from within the Applied Biosystems StepOne™ Real-Time PCR System Software by pressing F1, or clicking in the toolbar, or selecting Help ➤ StepOne Software Help.
Chapter 6 Maintain the System

Regular Maintenance

Perform routine maintenance of your Applied Biosystems StepOne™ or StepOnePlus™ Real-Time PCR Instrument and computer to ensure proper operation. The following table displays the recommended maintenance schedule.

<table>
<thead>
<tr>
<th>Perform every...</th>
<th>Task</th>
<th>See Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Week</td>
<td>Check the computer disk space. If necessary, archive or back up your experiment files.</td>
<td>118</td>
</tr>
<tr>
<td></td>
<td>Power off the computer controlling the instrument, then after 30 sec power on the computer.</td>
<td>—</td>
</tr>
<tr>
<td></td>
<td>Clean the surface of the instrument with a lint-free cloth.</td>
<td>—</td>
</tr>
<tr>
<td></td>
<td>Defragment the computer hard drive.</td>
<td>—</td>
</tr>
<tr>
<td>Month</td>
<td>Perform a background calibration.‡</td>
<td>98</td>
</tr>
<tr>
<td>1.5 Years</td>
<td>Perform a spatial calibration.</td>
<td>94</td>
</tr>
<tr>
<td></td>
<td>Perform a dye calibration.</td>
<td>104</td>
</tr>
</tbody>
</table>

‡ You can run a background calibration to check for contamination. Also, you must run a background calibration and a dye calibration if any part of the instrument optics are replaced or moved.

The spatial, background, and dye calibrations must be performed while the system is in a colocated layout. To set up the system for maintenance, connect the yellow StepOne system cable between the:

- Yellow Ethernet port ( ) of the instrument, and
- Ethernet port ( ) of the computer running the StepOne™ software

**IMPORTANT!** Do not connect the StepOne system cable to the blue LAN Port ( ), which is reserved for a network connection.

When a required maintenance task such as a calibration is overdue, the StepOne™ software and instrument display messages that prompt you to perform the necessary procedure.

Notes
How to View Maintenance Information
You can use the StepOne™ software to view a summary of maintenance data for your instrument. To view the maintenance information, select Instrument ➤ Instrument Maintenance Manager in the StepOne™ software. For each calibration (spatial, background, and dye), the software lists the following information:

- **Status** – Condition of the current calibration where:
  - **Current** indicates that the calibration is up to date.
  - **Expired** indicates that the calibration must be performed at the earliest possible convenience.
  - **Not Run** indicates that the calibration has not been run (RNase P only).
- **Last Run** – Date when current calibration was run.
- **Expiry Date** – Date when current calibration will expire.

Instrument Tools Menu Tests
The Tools Menu of the instrument provides several features that test the temperature of several instrument components against the product specification.

<table>
<thead>
<tr>
<th>Test</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Run Cycle Performance Test</td>
<td>Verifies that the sample block(s) achieves the temperature accuracy specification for the instrument.</td>
</tr>
<tr>
<td>Optics Verification</td>
<td>Verifies that the instrument optics is operating to the specifications of the instrument.</td>
</tr>
<tr>
<td>Statistics</td>
<td>Displays the usage data for the instrument, including:</td>
</tr>
<tr>
<td></td>
<td>• Thermal cycles performed by the sample block(s).</td>
</tr>
<tr>
<td></td>
<td>• Degrees Celsius heated or cooled by the sample block(s).</td>
</tr>
<tr>
<td></td>
<td>• Hours of operation for the instrument LED.</td>
</tr>
<tr>
<td></td>
<td>• RNase P verification run data.</td>
</tr>
</tbody>
</table>

Applied Biosystems Temperature Verification Service
Applied Biosystems recommends that you perform an annual temperature verification of the instrument depending on your usage and laboratory requirements. The temperature verification service can be performed by Applied Biosystems when the instrument is shipped for an annual service, or by an Applied Biosystems service engineer at an additional cost. See “How to Obtain Support” on page xii to contact Applied Biosystems for pricing and further information.
Perform a Spatial Calibration

Perform a spatial calibration every 18 months, or as often as necessary, depending on instrument use.

### Materials Required
- Spectral calibration plate 1 from the spectral calibration kit for your instrument:
  - StepOne™ Real-Time PCR System Spectral Calibration Kit (PN 4371433)
  - StepOnePlus™ Real-Time PCR System Spectral Calibration Kit (PN 4371435)
- Safety glasses
- Powder-free gloves
- Centrifuge with reaction plate adapter
- StepOne system cable, yellow (from the system packing kit)

### Purpose of the Calibration
A spatial calibration maps the positions of the wells on the sample block(s) so that the StepOne™ software can associate increases in fluorescence during a run with specific wells of the reaction plate.

### Prepare for the Calibration

**CAUTION** PHYSICAL INJURY HAZARD. During instrument operation, the temperature of the sample block(s) can exceed 100°C. If the instrument has been used recently, keep your hands away until the sample block(s) reaches room temperature.

**IMPORTANT!** Wear powder-free gloves when you handle calibration plates.

1. If you have not already done so, use the StepOne system cable to connect the:
   - *Yellow Ethernet port ( ) of the instrument to the*
   - *Ethernet port ( ) of the computer running the StepOne™ software*

   **IMPORTANT!** Do not connect the StepOne system cable to the *blue LAN Port ( )*.

2. Get calibration plate 1 from the spectral calibration kit in the freezer.

3. Allow calibration plate 1 to warm to room temperature (approximately 5 min).

   **IMPORTANT!** Do not remove calibration plate 1 from its packaging until you are ready to run it. The fluorescent dyes in the wells of both spectral calibration plates are photosensitive. Prolonged exposure to light can diminish the fluorescence signal strength of the dyes.
4. Remove calibration plate 1 from its packaging.

5. Vortex calibration plate 1 for 5 sec.

6. Centrifuge calibration plate 1 for 2 min at less than 1500 rpm.

**IMPORTANT!** The calibration plate must be well mixed and centrifuged.

7. Confirm that the liquid is at the bottom of each well of calibration plate 1. If not, centrifuge the calibration plate again at a greater rpm and for a longer time.

**IMPORTANT!** Do not allow the bottom of the calibration plate to become dirty. Fluids and other contaminants that adhere to the bottom of the plates can contaminate the sample block(s) and cause an abnormally high background signal.

8. Load calibration plate 1 into the instrument:
   a. Open the instrument drawer.
   b. Place the calibration plate in the sample block(s) so that the A1 position is at the back-left corner.
   c. Close the instrument drawer carefully.

<table>
<thead>
<tr>
<th>Correct</th>
<th>Incorrect</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Correct Liquid Location" /></td>
<td><img src="image" alt="Incorrect Liquid Location" /></td>
</tr>
<tr>
<td>Liquid is at the bottom of the well.</td>
<td>• Not centrifuged with enough force, or • Not centrifuged for enough time</td>
</tr>
</tbody>
</table>
Perform the Calibration

1. In the main screen of the StepOne™ software, select Instrument → Instrument Maintenance Manager.

2. In the navigation pane of the Instrument Maintenance Manager, click Spatial.

3. In the Instrument Maintenance Manager, click Start Calibration.

4. In the Setup screen of the Spatial Calibration dialog box, select The calibration plate is loaded into the instrument, then click Next.

5. In the Run screen, click START RUN ▸, then wait for the instrument to complete the spatial calibration.

Remove the Calibration Plate

WARNING PHYSICAL INJURY HAZARD. During instrument operation, the temperature of the sample block(s) can exceed 100°C. If the instrument has been used recently, keep your hands away until the sample block(s) reaches room temperature.

IMPORTANT! Wear powder-free gloves when you handle calibration plate.

1. Open the instrument drawer.

2. Remove calibration plate 1 from the sample block(s), place it inside its packaging sleeve, and return it to the spectral calibration kit in the freezer.

3. Close the instrument drawer carefully.
Chapter 6  Maintain the System

Regular Maintenance

Analyze the Calibration Data

1. In the Analysis screen of the Spatial Calibration dialog box, confirm the status of the calibration:
   - **Passed** – The instrument passed the calibration. Go to step 2.
   - **Failed** – The instrument failed the calibration. Contact Applied Biosystems as described in “How to Obtain Support” on page xii.

2. Click Finish.

3. When prompted to save the calibration, click Yes.
Perform a Background Calibration

Perform a background calibration monthly, or as often as necessary, depending on instrument use.

**Materials Required**

- Background plate from the spectral calibration kit for your instrument:
  - StepOne™ Real-Time PCR System Spectral Calibration Kit (PN 4371433)
  - StepOnePlus™ Real-Time PCR System Spectral Calibration Kit (PN 4371435)

*Note:* Alternatively, create a background plate as described in “How to Create a Background Plate” on page 103.

- Powder-free gloves
- Safety glasses
- Centrifuge with reaction plate adapter
- StepOne system cable, yellow (from the system packing kit)

**Calibration Guidelines**

- Make sure the centrifuge you use is clean. Before centrifuging, wipe down the bucket using a tissue.
- Handle the calibration plates with care to prevent contamination. To avoid contaminating the reaction plate, do not place plates on a lab bench. Always return the calibration plate to its original bag.

**Purpose of the Calibration**

A background calibration measures the level of background fluorescence in the instrument. During a background calibration run, the system:

- Performs continuous reads of a background plate containing PCR buffer for 10 min at 60°C.
- Averages the spectra recorded during the run and extracts the resulting spectral component to a calibration file.

The StepOne™ software uses the calibration file during subsequent runs to remove the background fluorescence from the run data.

**Background Fluorescence**

Fluorescence data collected by the system includes a fluorescent spectral component inherent to the system, commonly referred to as background fluorescence. This background fluorescence is a composite signal found in all signal data that consists of fluorescence from several sources, including:

- Background electronic signal
- Contaminants in the sample block(s)
- The plastic consumable (plates and caps)
CAUTION  PHYSICAL INJURY HAZARD. During instrument operation, the temperature of the sample block(s) can exceed 100°C. If the instrument has been used recently, keep your hands away until the sample block(s) reaches room temperature.

**IMPORTANT!** Wear powder-free gloves when you handle the background plate.

1. If you have not already done so, use the StepOne system cable to connect the:
   - Yellow Ethernet port (-yellow) of the instrument to the
   - Ethernet port (-blue) of the computer running the StepOne™ software

   **IMPORTANT!** Do not connect the StepOne system cable to the blue LAN Port (-blue).

2. Get the background plate from the spectral calibration kit in the freezer.

3. Allow the background plate to warm to room temperature (at least 5 min).

4. Remove the background plate from its packaging.

   **IMPORTANT!** Do not discard the packaging sleeve. The background plate can be used up to three times if it is stored in its original packaging sleeve.

5. Vortex the background plate for 5 sec.

6. Centrifuge the background plate for 2 min at less than 1500 rpm.

   **IMPORTANT!** The background plate must be well mixed and centrifuged.
7. Confirm that the liquid is at the bottom of each well of the background plate. If not, centrifuge the background plate again at a greater rpm and for a longer time.

**IMPORTANT!** Do not allow the bottom of the background plate to become dirty. Fluids and other contaminants that adhere to the bottom of the background plate can contaminate the sample block(s) and cause an abnormally high background signal.

8. Load the background plate into the instrument:
   a. Open the instrument drawer.
   b. Place the background plate in the sample block(s) so that the A1 position is at the back-left corner.
   c. Close the instrument drawer carefully.

### Perform the Calibration

1. In the main screen of the StepOne™ software, select **Instrument** ➔ **Instrument Maintenance Manager**.

2. In the navigation pane of the Instrument Maintenance Manager, click **Background**.

3. Click **Start Calibration**.

4. In the Setup screen of the Background Calibration dialog box, select **The background plate is loaded into the instrument**, then click **Next**.

5. In the Run screen, click **START RUN** ➔, then wait for the instrument to complete the background calibration.

**Note:** If the StepOne™ software displays messages during the run, troubleshoot the errors as described in “Background Calibration Failure” on page 138.
Remove the Background Plate

⚠️ CAUTION PHYSICAL INJURY HAZARD. During instrument operation, the temperature of the sample block(s) can exceed 100°C. If the instrument has been used recently, keep your hands away until the sample block(s) reaches room temperature.

 IMPORTANTE! Wear powder-free gloves when you handle the background plate.

1. Open the instrument drawer.

2. Remove the background plate from the sample block(s), place it inside its packaging sleeve, and return it to the spectral calibration kit in the freezer.

   Note: Do not discard the background plate. If you store the background plate in its packaging sleeve at –20 to –25°C, you can reuse it three times after you open it.

3. Close the instrument drawer carefully.
Analyze the Calibration Data

1. In the Analysis screen of the Background Calibration dialog box, confirm the status of the calibration:
   - **Passed** – The instrument passed the calibration. Go to step 2.
   - **Failed** – The instrument failed the calibration. Troubleshoot the error as described in “Background Calibration Failure” on page 138.

2. Select all wells of the plate layout.

3. Inspect the raw data for irregular spectral peaks.
   
   If one or more wells produce raw spectra that diverge significantly from that of the neighboring wells, the background plate or the sample block(s) could contain a fluorescent contaminant. If you suspect contamination, troubleshoot the irregular signal as explained in “Background Calibration Failure” on page 138.

4. If all spectra are acceptable, click **Finish**.

5. When prompted to save the background calibration, click **Yes**.
How to Create a Background Plate

Whenever possible, use a background plate included with the spectral calibration kit. The background plate contains a buffer that accurately models the reagents used for PCR, and produces high-quality calibration data. However, if a background plate from a spectral calibration kit is not available, you can create one as explained below.

Materials Required

- Deionized water
- MicroAmp® Optical Adhesive Film or MicroAmp® 8-Cap Strip (Flat Caps only)
- MicroAmp® Optical Reaction Plate
- Pipettor, 200-µL and pipette tips
- Powder-free gloves
- Safety glasses

Create the Background Plate

**IMPORTANT!** Wear powder-free gloves while creating the background plate.

1. Remove a reaction plate from its box and place it on a clean, dry surface.
2. Pipette 30 µL of deionized water to each well of the reaction plate.
3. Seal the reaction plate using an optical adhesive film or optical flat caps.
4. Use the reaction plate to perform the background calibration.
Perform a Dye Calibration

Perform a dye calibration at least every 18 months, or as often as necessary depending on instrument use. Because the age and use of the instrument can affect spectral readings, you may need to perform the calibration more frequently.

**IMPORTANT!** Perform a background calibration before performing a dye calibration (see “Perform a Background Calibration” on page 98).

**Materials Required**

- Spectral Calibration Plates from the spectral calibration kit for your instrument:
  - StepOne™ Real-Time PCR System Spectral Calibration Kit (PN 4371433)
  - StepOnePlus™ Real-Time PCR System Spectral Calibration Kit (PN 4371435)
- Safety glasses
- Powder-free gloves
- Centrifuge with reaction plate adapter
- StepOne system cable, yellow (from the system packing kit)

**Purpose of the Calibration**

During a dye calibration run, the system:

- Collects spectral data from a series of dye standards.
- Stores the spectral information for the dye standards in the spectra run file, a calibration file in the StepOne™ software directory.

The StepOne™ software uses spectral data during subsequent runs to characterize dyes and distinguish the individual contribution of each dye in the collective fluorescence collected by the instrument during a run. After each run, the StepOne™ software stores run data in the form of a raw spectral signal for each reading. It determines the contribution of each fluorescent dye used in the sample by comparing the raw spectra to the spectral file. After analysis, the StepOne™ software stores the spectral data with the collected fluorescence data for each experiment.

**Custom Dye Plates**

The StepOne™ and StepOnePlus™ instrument supports the use of custom dyes (dyes not supplied by Applied Biosystems) that are excited with a light source at 470 nm and fluoresce within the spectral range it supports (500 to 650 nm). See “How to Calibrate a Custom Dye” on page 115 for more information.
**Supported Dyes**

**StepOnePlus™ System Dyes**

The StepOnePlus™ instrument uses the following dye set for calibration: FAM™ dye, JOE™ dye, NED® dye, ROX™ dye, TAMRA® dye, VIC® dye, and SYBR® Green dye. The following figure shows the emission spectrum for each dye, and the filter at which each dye is read.

![Emission Spectra Diagram](image)

**StepOne™ System Dyes**

The StepOne™ instrument uses the following dye set for calibration: FAM™ dye, JOE™ dye, ROX™ dye, VIC® dye, and SYBR® Green dye. The following figure shows the emission spectrum for each dye, and the filter at which each dye is read.

![Emission Spectra Diagram](image)
Custom Dyes

The system can be used to run assays designed with custom dyes (dyes not supplied by Applied Biosystems). However, before using custom dyes with the instrument, you must create and run a custom calibration plate. The purpose of the custom plate is similar to that of a spectral calibration plate. The StepOne™ software uses the custom calibration plate to create a spectral standard to distinguish the custom dye in the fluorescence data collected during the run.

**IMPORTANT!** To use a custom dye on your system, it must be excited with light at 470 nm and fluoresce within the 500 to 650 nm spectral range measured by the StepOne™ and StepOnePlus™ instrument.

**IMPORTANT!** Applied Biosystems does not recommend the use of TAMRA™ dye as reporter or quencher with the StepOne™ system. TAMRA™ dye may be used as a reporter or quencher with the StepOnePlus™ system.
About the Analysis

The product of a dye calibration is a collection of spectral profiles that represent the fluorescence signature of each dye standard. Each profile consists of a set of spectra that correspond to the fluorescence collected from the wells of the spectral calibration plate. The StepOne™ software plots the resulting data for each spectral profile in a graph of fluorescence versus filter.

When the StepOne™ software extracts the calibration data from a dye run, it evaluates the fluorescence signal generated by each well in terms of the collective spectra for the entire calibration plate. Dye spectra are generally acceptable if they peak within the same filter as their group but diverge slightly at other wavelengths (see below).

The StepOne™ software can compensate for some differences in a spectral profile by replacing (auto-repairing) the spectra of unacceptable wells with the spectra of other wells on the reaction plate. However, the software allows only a few replacements and may reject the calibration if the spectra between neighboring wells vary significantly.

**Note:** Because the wells in a calibration plate contain dyes at identical concentrations, the resulting signals for the wells containing each dye should be similar. Among wells containing the same dye, variations in spectral position and peak position are caused by minor differences in the optical and excitation energy between the individual wells.

---

**Acceptable Spectra**
Spectra peak at the same wavelength and do not diverge significantly

**Unacceptable Spectra**
Spectra peak at the different wavelengths
Prepare for the Calibration

IMPORTANT! Wear powder-free gloves when you handle the calibration plates.

1. If you have not already done so, use the StepOne system cable to connect the:
   - Yellow Ethernet port ( ) of the instrument to the
   - Ethernet port ( ) of the computer running the StepOne™ software

   IMPORTANT! Do not connect the StepOne system cable to the blue LAN Port ( ).

2. Get calibration plate 1 from the spectral calibration kit in the freezer.
3. Allow calibration plate 1 to warm to room temperature (~5 min).

   IMPORTANT! Do not remove calibration plate 1 from its packaging until you are ready to run it. The fluorescent dye in the wells of each calibration plate is photosensitive. Prolonged exposure to light can diminish the fluorescence signal strength of the dyes.

4. Remove calibration plate 1 from its packaging.

5. Vortex calibration plate 1 for 5 sec.
6. Centrifuge calibration plate 1 for 2 min at less than 1500 rpm.

   IMPORTANT! The calibration plate must be well mixed and centrifuged.
7. Confirm that the liquid is at the bottom of each well of the calibration plate. If not, centrifuge the plate again at a greater rpm and for a longer time.

**IMPORTANT!** Do not allow the bottom of the calibration plates to become dirty. Fluids and other contaminants that adhere to the bottom of the plates can contaminate the sample block(s) and cause an abnormally high background signal.

<table>
<thead>
<tr>
<th>Correct</th>
<th>Incorrect</th>
</tr>
</thead>
<tbody>
<tr>
<td>Liquid is at the bottom of the well.</td>
<td>• Not centrifuged with enough force, or</td>
</tr>
<tr>
<td></td>
<td>• Not centrifuged for enough time</td>
</tr>
</tbody>
</table>

8. Load calibration plate 1 into the instrument:
   a. Open the instrument drawer.
   b. Place calibration plate 1 in the sample block(s) so that the A1 position is at the back-left corner.
   c. Close the instrument drawer carefully.
PHYSICAL INJURY HAZARD. During instrument operation, the temperature of the sample block(s) can exceed 100°C. If the instrument has been used recently, keep your hands away until the sample block(s) reaches room temperature.

1. In the main menu of the StepOne™ software, select Instrument ➔ Instrument Maintenance Manager.
2. In the Instrument Maintenance Manager, click Dye in the navigation pane.
4. Click Start Calibration.
5. In the Setup screen, select Plate 1 is loaded into the instrument.
6. Click Next.
7. In the Run screen, click Start Run.
8. While the instrument is running calibration plate 1, prepare calibration plate 2 by performing steps 4 through 7 on page 109.

9. When the wizard prompts you to do so, load and run calibration plate 2:
   a. Open the instrument drawer.
   b. Remove the calibration plate 1 from the sample block(s) and discard it.
   c. Place calibration plate 2 in the sample block(s) so that the A1 position is at the back-left corner.
   d. Close the instrument drawer carefully.
   
   \[\text{CAUTION}\]

   e. In the Dye Calibration Setup wizard, select \textit{Plate 2 is loaded in the instrument}, click \textit{Continue Calibration}.

   ![](image)

10. When the instrument completes the calibration, unload calibration plate 2:
    a. Open the instrument drawer.
    b. Remove the calibration plate 2 from the sample block(s) and discard it.
    c. Close the instrument drawer carefully.

\section*{Analyze the Calibration Data}

1. After the calibration is complete, confirm the status of the calibration:
   - \textbf{Passed} – The instrument passed the calibration. Go to step 2a.
   - \textbf{Failed} – The instrument failed the calibration. Troubleshoot the error as described in “Dye Calibration Failure” on page 140.
2. For each dye present on the plate, confirm the grouping of the dye spectra:
   a. In the plate layout, press Ctrl, then select the wells that contain the same dye.
   b. Inspect the raw data. For each spectrum, confirm that the peak is:
      • Within the detectable range for the instrument.
      • Free of irregular spectral peaks.
      • Present in the correct channel for the dye (see “StepOne™ System Dye Spectra” on page 113 or “StepOnePlus™ System Dye Spectra” on page 114).

If a spectrum does not comply with the criteria above, troubleshoot the problem as described in “Dye Calibration Failure” on page 140.

Note: Among wells containing the same dye, variations in spectral position and peak position are caused by minor differences in the optical and excitation energy between the individual wells.

3. If all spectra are acceptable, click Plate 2 from the View Details menu.
4. Inspect the raw data for the as described in step 2b.
5. If all spectra are acceptable, click Finish.
6. When prompted to save the dye calibration, click Yes.
Chapter 6
Maintain the System

Regular Maintenance

StepOne™ System Dye Spectra

Filter 1
(~520 nm)
FAM

Filter 2
(~550 nm)
JOE

Filter 3
(~610 nm)
ROX
StepOnePlus™ System Dye Spectra

<table>
<thead>
<tr>
<th>Filter 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>(~520 nm)</td>
</tr>
<tr>
<td>FAM</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Filter 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>(~550 nm)</td>
</tr>
<tr>
<td>JOE</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Filter 3</th>
</tr>
</thead>
<tbody>
<tr>
<td>(~580 nm)</td>
</tr>
<tr>
<td>NED</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Filter 4</th>
</tr>
</thead>
<tbody>
<tr>
<td>(~610 nm)</td>
</tr>
<tr>
<td>ROX</td>
</tr>
</tbody>
</table>

| SYBR Green |

| VIC |

| TAMRA |
How to Calibrate a Custom Dye

Materials Required

- Centrifuge with reaction plate adaptor
- Custom dye(s)
- Deionized water
- MicroAmp® Optical Adhesive Film or MicroAmp® 8-Cap Strip (Flat Caps only)
- MicroAmp® Optical Reaction Plate of the size appropriate for your instrument
- Pipettors and pipette tips (200-µL and 1000-µL)
- Powder-free gloves
- Safety glasses
- Tubes (2-ml and 10-ml)

Prepare the Custom Spectral Calibration Plate

1. Create a calibration plate for the custom dye:
   a. Prepare 1.5 mL of the custom dye at the desired concentration.
   b. Pipette 30 µL of the diluted custom dye to all wells of a reaction plate.
   c. Seal the wells of the reaction plate using an adhesive film or optical flat caps.
   d. Vortex the calibration plate for 5 sec.
   e. Centrifuge calibration plate for 2 min at less than 1500 rpm.

**IMPORTANT!** The calibration plate must be well mixed and centrifuged.
f. Confirm that the liquid in each well of the calibration plate is at the bottom of the well. If not, centrifuge the calibration plate again at a greater rpm and for a longer time.

**IMPORTANT!** Do not allow the bottom of the calibration plate to become dirty. Fluids and other contaminants that adhere to the bottom of the plate can contaminate the sample block(s) and cause an abnormally high background signal.

<table>
<thead>
<tr>
<th>Correct</th>
<th>Incorrect</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1" alt="Correct Liquid" /></td>
<td><img src="image2" alt="Incorrect Liquid" /></td>
</tr>
<tr>
<td>Liquid is at the bottom of the well.</td>
<td>• Not centrifuged with enough force, or&lt;br&gt;• Not centrifuged for enough time</td>
</tr>
</tbody>
</table>

2. Load the custom calibration plate into the instrument:
   a. Open the instrument drawer.
   b. Place the custom calibration plate in the sample block(s) so that the A1 position is at the back-left corner.
   c. Close the instrument drawer carefully.

Run the Custom Spectral Calibration Plate

1. In the main screen of the StepOne™ software, select **Instrument ➤ Instrument Maintenance Manager**.

2. In the Instrument Maintenance Manager:
   a. In the navigation pane, click **Dye**.
   b. In the Dye screen, select **Custom Dye Calibration**.
   c. Click **Start Calibration**.
3. In the Setup screen of the Dye Calibration dialog box, select a custom dye from the list or create the custom dye as follows:
   
a. Click New Dye.
   
b. In the Dye Manager dialog box, click New.
   
c. Complete the New Dye dialog box, then click OK.
   
d. Click Close.
   
4. In the Setup screen of the Dye Calibration dialog box, enter a temperature setting for the calibration.
   
   **Note:** Set the temperature to match the temperature at which you intend to collect data. For example, the temperature for all Applied Biosystems system dyes is 60°C because data collection for TaqMan® reagents occurs during the 60°C extension step of the PCR.
   
5. Select The custom dye plate is loaded in the instrument, then click Next.
   
6. In the Run screen, click Start Run, then wait for the instrument to complete the dye calibration.
   
   **Note:** If the StepOne™ software displays messages during the run, troubleshoot the errors as described in “Dye Calibration Failure” on page 140.
   
7. When the instrument displays the Main Menu, unload the custom calibration plate.
   
8. Analyze the custom spectral calibration plate as explained in “Analyze the Calibration Data” on page 111.
Archive and Back Up Data

Develop a strategy that addresses the following data management issues for the instrument.

**Check Disk Space Regularly**
If you perform real-time experiments on your system, or collect real-time data for genotyping experiments, check the available space on your hard drive weekly. When the hard drive is within 20% of maximum capacity, transfer the older data to a backup storage device.

**Archive Older Experiments**
Conserve space on the computer hard drive by using a data compression utility to archive unused or older experiments. Several commercially available compression utilities are available, such as the PKZIP and ARC archive formats common to the Microsoft® Windows® operating system.

**Back Up Experiments Regularly**
Back up the experiments generated by your system to:
- Protect against potential data loss of data caused by an unforeseen failure of the computer or its hard drive(s).
- Conserve space on the hard drive and to optimize performance, if you remove old data after backing up.

See “Select Protective Hardware and Software” on page 7 for more information on backup storage devices.
Infrequent Maintenance

Maintenance  Perform the following procedures as needed to resolve problems as they arise:

- Decontaminate the Sample Block(s) .................................................. 121
- Move the Instrument ........................................................................ 124
- Replace the External Fuses ............................................................. 126
- Ship the Instrument for Service ....................................................... 128
- Update the StepOne™ Software or the Operating System .............. 130
- Update the StepOne™ Software ....................................................... 130
Decontaminate the Sample Block(s)

If you perform a background calibration and observe high fluorescent background that you suspect to be contamination, decontaminate the sample block(s).

**Materials Required**
- Bleach solution (10%)
- Cotton or nylon swabs and lint-free cloths
- Deionized water
- EtOH solution (95%)
- Pipettor and pipette tips (100-µL)
- Powder-free gloves
- StepOne system cable, yellow (from the system packing kit)

**Guidelines for Bleach Solution Use**

**CAUTION** Applied Biosystems recommends the use of 10% bleach solution for resolving fluorescent contamination on the instrument sample block(s); however, excessive use of the solution can corrode the block material.

To prevent block degradation:
- Use bleach solution to decontaminate the sample block(s) as a last resort. Rinse the sample block(s) with bleach only after treatments of deionized water and 95% ethanol fail to remove the contamination.
- Use deionized water to rinse the sample block(s) thoroughly after treating the block with bleach solution. Thoroughly removing residual bleach from the metal surfaces with water minimizes the long term effects of bleach.

**Clean the Contaminated Wells**

**CAUTION** PHYSICAL INJURY HAZARD. During instrument operation, the temperature of the sample block(s) can exceed 100°C. If the instrument has been used recently, keep your hands away until the sample block(s) reaches room temperature.

**Prepare the Instrument**

1. If you have not already done so, use the StepOne system cable to connect the:
   - Yellow Ethernet port ( ) of the instrument to the
   - Ethernet port ( ) of the computer running the StepOne™ software

**IMPORTANT!** Do not connect the StepOne system cable to the blue LAN Port ( ).

---

**Notes**
2. Using the data from the background calibration, identify the location of the contaminated wells on the sample block(s).

3. Turn off and unplug the system. Allow it to cool for 15 min.

4. Open the instrument drawer.

5. Clean each contaminated well of the sample block(s):
   a. Pipette a small volume of water into the contaminated well, slowly pipette the water up and down several times, then expel the water into a waste beaker.
   b. Use a cotton swab to scrub inside of the contaminated well.
   c. Use a lint-free cloth to absorb the excess deionized water in the well.
   d. Repeat steps 5a through 5d.

6. Close the instrument drawer, then plug in and power on the instrument.

7. Perform a background calibration to confirm that you have eliminated the contamination.
8. If the contamination persists, clean the wells with a 95% EtOH solution:

- **WARNING** CHEMICAL HAZARD. Ethanol is a flammable liquid and vapor. Exposure causes eye, skin, and respiratory tract irritation and may cause central nervous system depression and liver damage. Read the SDS, and follow the handling instructions. Wear appropriate protective eyewear, clothing, and gloves.
  
  a. Perform steps 2 through 5, substituting a 95% EtOH solution in place of the deionized water.
  
  b. Repeat step 5 using deionized water to rinse the wells of the sample block(s).
  
  c. Perform steps 6 and 7 to confirm that you have eliminated the contamination.

**IMPORTANT!** Use deionized water to rinse wells after they have been treated with bleach or EtOH solution.

9. If the contamination persists, clean the wells with a 10% bleach solution:

- **WARNING** CHEMICAL HAZARD. Sodium hypochlorite (bleach) is a liquid disinfectant that can be corrosive to the skin and can cause skin depigmentation. Read the SDS, and follow the handling instructions. Wear appropriate protective eyewear, clothing, and powder-free gloves.
  
  a. Perform steps 2 through 5, substituting a 10% bleach solution in place of the deionized water.
  
  b. Repeat step 5 using deionized water to rinse the wells of the sample block(s).
  
  c. Perform steps 6 and 7 to confirm that you have eliminated the contamination.

**IMPORTANT!** Use deionized water to rinse wells after they have been treated with bleach or EtOH solution.

10. If the contamination is still present, contact Applied Biosystems technical support.
Move the Instrument

Perform this procedure to safely move the instrument short distances (for example, between laboratories in the same building).

**Note:** If you want to transport the instrument via ground or air shipping, package the instrument for shipping as explained in “Ship the Instrument for Service” on page 128.

**Materials Required**

Original packing plate or a MicroAmp® Optical Reaction Plate

**Prepare the Instrument**

1. Load the packing plate or empty reaction plate into the instrument:
   a. Open the instrument drawer.
   b. Place the packing plate or empty reaction plate onto the sample block(s).
   c. Close the instrument drawer.

2. Raise the sample block(s) to secure it for transport:
   a. Touch the instrument touchscreen to awaken it, then touch.
   b. In the Main Menu, touch *Tools Menu*, touch *Ship Prep*, then touch *Ship Prep*.
   c. Wait for the instrument to raise the sample block(s), then power off the instrument when prompted.

3. Disconnect the power cord from the back of the instrument.
PHYSICAL INJURY HAZARD. Do not attempt to lift the instrument or any other heavy objects unless you have received related training. Incorrect lifting can cause painful and sometimes permanent back injury. Use proper lifting techniques when lifting or moving the instrument. At least two people are required to lift the instrument.

IMPORTANT! Moving your instrument can create subtle changes in the alignment of the instrument optics. Applied Biosystems recommends that you run a TaqMan® RNase P Fast Instrument Verification Plate after you move the instrument to confirm the performance of the system.

1. Move your instrument according to the guidelines in step 6 on page 16.

Do not carry the instrument by the instrument drawer. Carrying the instrument by the drawer can damage the instrument optics.

2. Install the components of the system according the chosen layout.

<table>
<thead>
<tr>
<th>Layout</th>
<th>Description</th>
<th>Perform the installation described in…</th>
</tr>
</thead>
<tbody>
<tr>
<td>Colocated</td>
<td>In this layout, the instrument is connected to the colocated computer by the yellow StepOne system cable.</td>
<td>Chapter 3, “Install the Colocated Layout,” on page 25</td>
</tr>
<tr>
<td>Standalone</td>
<td>In this layout, the instrument is not directly connected to the computer running the StepOne™ software.</td>
<td>Chapter 4, “Install the Standalone Layout,” on page 51</td>
</tr>
</tbody>
</table>

If the RNase P experiment performed at the end of the installation:

- **Passes**, then you have successfully moved the instrument.
- **Fails**, recalibrate the instrument:
  a. Perform a spatial calibration (see “Perform a Spatial Calibration” on page 94).
  b. Perform a background calibration (see “Perform a Background Calibration” on page 98).
  c. Perform a dye calibration (see “Perform a Dye Calibration” on page 104).
  d. Perform another RNase P experiment (see “Perform the RNase P Experiment” on page 41 or page 64).
**Replace the External Fuses**

Replace the fuses of the instrument as needed.

**Materials Required**
- Fuses, 10 A fast-acting 250 VAC Slo-Blo®
- Small flatblade screwdriver

**About the Fuses**

The instrument uses two 10 A fast-acting 250 VAC fuses to protect the system electronics from power surges. When replacing one fuse, Applied Biosystems recommends that you replace the companion fuse, regardless of its condition.

**Note:** Acceptable AC line voltage tolerances are 100, 120, 220, 230 ±10%; 240 VAC +6%/–10%, 50/60 Hz ± 1%.

---

**WARNING** **FIRE HAZARD.** For continued protection against the risk of fire, replace fuses only with Listed and Certified fuses of the same type and rating as those currently in the instrument.

**DANGER** **SHOCK HAZARD.** To protect yourself against shock hazards, use a properly wired three-terminal outlet. Do not use an adapter to a two-terminal outlet since this does not provide positive ground protection.

---

**Replace the Fuses**

**DANGER** **ELECTRICAL SHOCK HAZARD.** Severe electrical shock, which could cause physical injury or death, can result from working on an instrument when the high voltage power supply is operating. To avoid electrical shock, disconnect the power supply to the instrument, unplug the power cord, and wait at least 1 min before working on the instrument.

1. Power off the instrument.
2. Disconnect the power cord from the back of the instrument.
3. Remove the power entry module and fuses from the power entry module:
   
a. Insert a small flat-tip screwdriver into one of two slots in the right side of the power entry module containing the fuses, and pry open the door.
   
b. Insert the screwdriver into either side slot on the fuse compartment and eject the power entry module.
   
c. Replace the burnt fuse(s) in the power entry module with a new 10 A fast-acting 250 V AC fuse.

4. Replace the power entry module:
   
a. Lightly squeeze both mounted fuses between your thumb and forefinger and insert the power entry module into the fuse compartment until it is fully seated.
   
b. Press the power entry module door until it locks in place.

5. Connect the power cord to the back of the instrument.

6. Power on the instrument, then wait for it to perform a diagnostic of all major system components. If the diagnostic is successful, the instrument displays the main screen. If the instrument detects a problem, it displays an error code for the related failed test. Repeat the procedure above without replacing the fuses to reseat the fuse holder. If the problem persists, contact Applied Biosystems as explained in “How to Obtain Support” on page xii.
Ship the Instrument for Service

If the instrument requires the attention of an Applied Biosystems service representative, decontaminate the instrument and package it for transportation to Applied Biosystems.

**Materials Required**
- MicroAmp® Optical Reaction Plate

**Prepare for Shipment to Applied Biosystems**

1. Contact the Applied Biosystems Customer Care Center (see “How to Obtain Support” on page xii) and request a Certificate of Decontamination.

2. Decontaminate the instrument according to the guidelines in the Certificate of Decontamination.

3. Sign the completed Certificate of Decontamination and fax or e-mail it to the Applied Biosystems Customer Care Center.

**IMPORTANT!** Do not dispose the completed Certificate of Decontamination. You must include a copy in the package containing the instrument.

4. Raise the sample block(s) to secure it for transport:
   - a. Load the empty reaction plate into the instrument.
     ![Load the empty reaction plate into the instrument]
   - b. Touch the instrument touchscreen to awaken it, then touch .
     ![Touch the instrument touchscreen to awaken it, then touch .]
   - c. In the Main Menu, touch **Tools Menu**, touch **Ship Prep**, then touch **Ship Prep**.
     ![In the Main Menu, touch **Tools Menu**, touch **Ship Prep**, then touch **Ship Prep**.]
   - d. Wait for the instrument to raise the sample block(s), then power off the instrument when prompted.

5. Disconnect the power cord from the back of the instrument.

![Disconnect the power cord from the back of the instrument]
6. Using the packaging material provided by Applied Biosystems, create a package to ship the instrument that includes the:
   • StepOne™ or StepOnePlus™ instrument
   • Certificate of Decontamination (from step 3b on page 128)

   **IMPORTANT!** Shipping an instrument to Applied Biosystems without a completed Certificate of Decontamination will delay service of the instrument.

   • Payment for the service in one of the following forms:
     • Purchase order, or
     • Company letterhead with the words “verbal purchase order,” or
     • Visa or MasterCard credit card information
   • Your address and contact information, including:
     • Billing address
     • Return shipping address
     • Name and phone number of a contact

   **IMPORTANT!** Do not include accessories or cords in the package.

7. Affix the postage provided to the package.

8. Inform the courier to arrange pickup, then ship the package to the location specified by the Applied Biosystems Customer Care Center.

**Install the Serviced Instrument**

When you receive the serviced instrument from Applied Biosystems, install it as you would a new instrument by completing Chapters 1 through 5 of this guide.
Update the StepOne™ Software or the Operating System

Visit the StepOne™ and StepOnePlus™ System Website

For the latest services and support information for the StepOne™ and StepOnePlus™ systems, go to:

info.appliedbiosystems.com/stepone

The website contains the latest software and documentation updates for the instrument and analysis software.

At the system support page, you can:

• Submit a question directly to Technical Support
• Order Applied Biosystems user documents, SDSs, certificates of analysis, and other related documents
• Download documents in Adobe portable document format (PDF)
• Obtain information about customer training
• Download software updates and patches for the instrument

Update the StepOne™ Software

Prepare for the Update

If you want to update the StepOne™ Software, prepare your computer by exporting the application libraries and backing up your experiment files.

1. Back up the application libraries:
   a. In the main menu of the StepOne™ software, select Tools > <desired library>.
   b. When the library dialog box opens, select the element(s) that you want to export, then click Export.
   c. In the Export dialog box, click Save to archive the selected records.
   d. Repeat steps 1 through 3 for the remaining libraries to archive them.

2. Back up all experiment files by creating a copy of the directory that you are using to store files.

   The default directory for StepOne or StepOnePlus™ experiments is:
   D:\Applied Biosystems\<software name>\experiments

   where <software name> is the current version of the StepOne software.

3. Back up the instrument data:
   a. Connect a USB drive to the USB port.

Notes
b. Touch the instrument touchscreen to awaken it, then touch

c. In the Main Menu, touch Settings Menu, then touch Admin Menu, touch Admin Menu, then touch Back Up Experiments and Settings.

d. Touch Back Up, then wait for the instrument to transfer the data.

e. When the transfer is complete, touch Done, then remove the USB drive.

Check for Updates

1. Go to:
   http://info.appliedbiosystems.com/stepone
   to open the StepOne and StepOnePlus system product page.

2. Under Software Download, view the available downloads.

3. If there are updates and/or patches for v2.1 or later, select the appropriate option, then follow the prompts to begin the download.
   You may be asked for your instrument serial number. The serial number is on the back panel of your instrument, or can be obtained from the instrument touchscreen.

Determine the Compatibility of an Operating System Upgrade or Update

Do not upgrade or update the Microsoft Windows® operating system of the computer that runs the StepOne™ software without first consulting the software release notes or the Applied Biosystems website. Future versions of the Windows® operating system and updates to the current operating system may conflict with the StepOne™ software and render the software inoperable.

1. From the desktop, browse to and open:
   <drive>:\Applied Biosystems\<software name>
   where:
   – <drive> is the computer hard drive on which the StepOne software is installed.
     The default installation drive for the software is the D drive.
   – <software name> is the current version of the StepOne software.

2. Double-click release-notes.html, then read the StepOne™ Software Release Notes for the compatibility of interest.

3. If the release notes do not mention the compatibility:
   a. Go to:
      info.appliedbiosystems.com/stepone
   b. Search the system website for the compatibility of interest.

4. If the website does not contain the information of interest, contact Applied Biosystems for the information (see “How to Obtain Support” on page xii).
How to Troubleshoot the Installation

This appendix covers:

- **StepOne™ Software Problems** .................................................. 134
- **Network Connection Problems** .................................................. 135
- **Background Calibration Failure** ................................................. 138
- **Dye Calibration Failure** ............................................................. 140

**Note**: For more information about any of the topics discussed in this guide, access the Help from within the Applied Biosystems StepOne™ Real-Time PCR System Software by pressing F1, or clicking 📚 in the toolbar, or selecting Help › StepOne Software Help.
StepOne™ Software Problems

If you encounter errors during the installation of the StepOne™ software, uninstall the software before reinstalling it.

1. Log onto the operating system as Administrator, or as a member of the Administrators user group.

   **IMPORTANT!** If you are installing the StepOne™ software, you must log onto the Windows® operating system using a user account that belongs to the Administrators user group.

2. Remove the StepOne™ software:
   a. In the desktop, select **Start ➤ Control Panel ➤ Add/Remove Programs**.
   b. In the Add/Remove Programs dialog box, select **StepOne™ software**, then click **Change/Remove**.
   c. In the Welcome page of the InstallShield Wizard dialog box, select **Remove**.
   d. In the Confirm Uninstall dialog box, click **OK**.
   e. When the uninstallation is complete, then click **Finish**.
   f. Close the Add/Remove Programs dialog box.

3. Restart the computer and log in as Administrator, or as a member of the Administrators user group.

4. Reinstall the StepOne™ software.
   If the StepOne™ software installation continues to fail, reimage the computer and repeat the installation.
Network Connection Problems

Use this topic to resolve problems when setting up the instrument for remote monitoring.

Troubleshooting Workflow

Start: StepOne™ software cannot add instrument for remote monitoring

- Is the instrument connected to the network by the blue LAN Port?
  - No: Connect the Ethernet cable for the network connection to the blue LAN Port at rear of the instrument.
  - Yes: Determine the IP address and network settings of the instrument LAN port as explained in step 1 on page 136.

  - Is the LAN Port of the instrument set up for static IP or DHCP?
    - Static IP: Confirm with your network administrator that the static IP address, subnet mask, and default gateway settings are correct. Correct the network settings as directed by your network administrator.
    - DHCP: Determine the subnet address as explained in “How to Determine the Subnet Address” on page 137.

  - Are the instrument and computer located on the same subnet?
    - No: Add and monitor the instrument using the IP address of the LAN Port.
    - Yes: Confirm the network connection by pinging the instrument as explained in “How to Ping the Instrument” on page 136.

    - Can you “ping” the instrument from a computer on the network?
      - No: Consult your network administrator to determine the source of the failed network connection.
      - Yes: Can you add or monitor the instrument using the StepOne™ software?
        - No: When you add the instrument for remote monitoring, enter the instrument name using lower case letters only.
        - Yes: If you cannot use the instrument name to add the instrument for remote monitoring, try using the IP address of the instrument.

Contact Applied Biosystems as explained in “How to Obtain Support” on page xii.

Notes
How to Ping the Instrument

You can confirm the connection between a network computer and instrument by pinging the instrument name or IP address from the computer. The ping command issued from the DOS command shell causes the computer to send a series of 32-byte data packets to the instrument. If the network connection between the computer and the instrument is unobstructed, the instrument sends data packets in reply.

1. Determine the IP address of the instrument:
   a. Touch the instrument touchscreen to awaken it, then touch .
   b. In the Main Menu, touch Settings Menu ➤ Admin Menu ➤ Set IP Address.
   c. Record the IP address in the IP Address field.

2. Ping the instrument:
   a. Power on the instrument and wait for the instrument to boot.
   b. In the computer desktop, select Start ➤ Programs ➤ Accessories ➤ Command Prompt.
   c. In the Command Prompt window, enter ping <IP address>, then press Enter.

<table>
<thead>
<tr>
<th>If the DOS prompt...</th>
<th>Then...</th>
</tr>
</thead>
<tbody>
<tr>
<td>replies to the pings</td>
<td>the computer can communicate with the IP address.</td>
</tr>
<tr>
<td>displays “request timed out”</td>
<td>Wait a few minutes for the network to update the IP address of the instrument, then ping the instrument again. If you still cannot ping the instrument after two attempts, consult your network administrator to determine the source of the failed network connection.</td>
</tr>
</tbody>
</table>

Notes
Appendix A  How to Troubleshoot the Installation
Network Connection Problems

Resolving an IP Address Conflict
If you suspect that the IP address used by either port of the instrument may conflict with another device on your network, you can use the following procedure to test for the conflict.

1. Unplug the instrument from the network.
2. Ping the IP address of the instrument LAN port as explained above.
   If you can ping the IP address, then another device on the network is already using the address and you must reassign the IP address of the instrument to resolve the conflict.

How to Determine the Subnet Address

1. Touch the instrument touchscreen to awaken it, then touch .
2. In the Main Menu, touch Settings Menu  Admin Menu  Set IP Address.
3. Record the IP address in the IP Address field. The first three numbers of the IP address are the subnet address.
   For example, the italicized numbers in the following IP address are the subnet address:
   
   $192.168.100.140$

If the subnet address for the instrument is different than that of the computer used for remote monitoring, then you cannot use the instrument name to add the instrument for remote monitoring. The mDNS limitation explained in “Networking Guidelines and Best Practices” on page 81 restricts the use of the instrument name as an identifier to network devices on the same subnet.

Note: To determine the subnet address of the computer that you want to use to monitor the instrument, select Start  Help and Support in the computer desktop, then use the Microsoft Windows Help System search for the procedure appropriate for the operating system.
Background Calibration Failure

Use this topic to troubleshoot failed background calibrations.

Troubleshooting Workflow

Does the instrument complete the background run?

- **Yes**: Repeat the calibration. If the problem persists, contact Applied Biosystems as explained in “How to Obtain Support” on page xii.
- **No**: One or more wells of the background plate have produced spectra that exceed the maximum limit for the instrument.
  1. Repeat the calibration using the same background plate.
  2. If the calibration fails again, repeat the calibration using a different background plate.
  3. If the calibration fails again, determine the source of the contamination as explained in “Identify the Source and Location of Contamination” below.

1. **Identify the Source and Location of Contamination**

Signals that exceed the limit of normal background fluorescence may indicate the presence of fluorescent contamination on the calibration plate or the sample block(s). Common contaminants include: ink residue from permanent pens, powder from disposable gloves, and dust.

To determine the source and location of the contamination:

1. While viewing the raw spectra, locate the contaminated well position(s) by selecting successively smaller regions of the plate layout.

2. Rotate the background plate 180°, then perform the background calibration again.

3. Repeat step 1 to locate the contamination. If the position(s) of the contamination in steps 1 and 3 are:
   - **Identical** – The sample block(s) are contaminated. Decontaminate the sample block(s) as explained on page 121.
   - **Reversed** – The background plate is contaminated. Discard the background plate and perform the background run using a new background plate.

If the calibration fails after you have replaced the background plate and decontaminated the sample block(s), perform the following test:

1. Load a plate covered by a piece of black paper into the instrument.

2. Perform the background run as explained in “Perform a Background Calibration” on page 98.

3. After the run is complete, select all wells of the plate layout.
4. View the Spectral plot for the peak(s). If the peak is:
   • **Visible** – The optics of your instrument may be contaminated. Contact Applied Biosystems as explained in “How to Obtain Support” on page xii.
   • **Absent** – The sample block(s) are contaminated. Decontaminate the sample block(s) as explained in “Decontaminate the Sample Block(s)” on page 121.
Dye Calibration Failure

Use this topic to troubleshoot failed dye calibrations.

**Troubleshooting Workflow**

Start

Does the instrument complete the dye calibration?

No

Reattempt the calibration. If the problem persists, contact Applied Biosystems as explained in “How to Obtain Support” on page 111.

Yes

Does the calibration pass?

No

One or more wells produced spectra:

- Beyond the detectable range for the system, or
- In more than one filters

Review the spectra for irregularities as explained in “Analyze the Calibration Data” on page 111.

Yes

Do the dye spectra peak in the correct filters?

No

If the peaks of one or more spectra appear in the wrong filter, confirm that:

- The spectral calibration plate was run in the correct orientation (the plate was not rotated 180° when run).
- The correct dyes were loaded onto the spectral calibration plate, if you are running a custom plate.

Yes

Notes

---

Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems Installation, Networking, and Maintenance Guide
## Appendix A

### How to Troubleshoot the Installation

#### Dye Calibration Failure

The following table displays irregular spectra common to dye calibrations.

<table>
<thead>
<tr>
<th>Spectra</th>
<th>Possible Cause</th>
<th>Action</th>
</tr>
</thead>
</table>
| One or more raw spectra are at or below the detectable threshold for the calibration. | • The spectral calibration plate has been centrifuged insufficiently.  
• The spectral calibration plate contains old or insufficient reagents.  
• If you are running a custom spectral calibration plate, the dye may not be present at a sufficient concentration. | 1. Unload the instrument and view the wells of the spectral calibration plate. If the liquid in the wells are not:  
- At the bottom of the wells, centrifuge the plate for a longer time, then repeat the calibration.  
- Equivalent in volume, the plate is not sealed and the reagents have evaporated. Discard it and run another.  
2. If the spectral calibration plate appears to be normal, discard the plate and run another.  
3. If the problem persists, contact Applied Biosystems as explained in "How to Obtain Support" on page xii.  
**Note:** If you are running a custom spectral calibration plate, create another plate but increase the concentration of the dye that produced insufficient signal. |
| One or more raw spectra exceed the maximum limit for the instrument. | • Fluorescent contamination is present on the sample block(s) or spectral calibration plate.  
• If you are running a custom spectral calibration plate, the dye may be too concentrated. | Confirm that the presence of contamination by performing a background calibration as explained in "Perform a Background Calibration" on page 98.  
If the background calibration does not show sample block contamination, the spectral calibration plate may be contaminated.  
**Note:** If you are running a custom spectral calibration plate, create another plate but decrease the concentration of the dye that exceeds the detectable limit. |
| The spectra contain peaks in more than one filter. | Fluorescent contamination is present on the sample block(s) or spectral calibration plate. | |

---

**Notes**

---

*Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems Installation, Networking, and Maintenance Guide*
## Glossary

<table>
<thead>
<tr>
<th>Term</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Advanced Setup</strong></td>
<td>In the StepOne™ software, a feature that allows you to set up your experiment according to your experiment design. Advanced Setup provides you with maximum flexibility in the design and setup of your experiment.</td>
</tr>
<tr>
<td><strong>AIF</strong></td>
<td>See assay information file (AIF).</td>
</tr>
<tr>
<td><strong>allele</strong></td>
<td>For a given target, any of the different sequences that occurs in the population.</td>
</tr>
<tr>
<td><strong>allelic discrimination plot</strong></td>
<td>Display of data collected during the post-PCR read. The allelic discrimination plot is a graph of the normalized reporter signal from the allele 1 probe plotted against the normalized reporter signal from the allele 2 probe.</td>
</tr>
<tr>
<td><strong>amplicon</strong></td>
<td>A segment of DNA amplified during PCR.</td>
</tr>
<tr>
<td><strong>amplification</strong></td>
<td>Part of the instrument run in which PCR produces amplification of the target. For quantitation experiments, fluorescence data collected during amplification are displayed in an amplification plot, and the data are used to calculate results. For genotyping or presence/absence experiments, fluorescence data collected during amplification are displayed in an amplification plot, and the data can be used for troubleshooting.</td>
</tr>
<tr>
<td><strong>amplification efficiency (EFF%)</strong></td>
<td>Calculation of efficiency of the PCR amplification. The amplification efficiency is calculated using the slope of the regression line in the standard curve. A slope close to −3.32 indicates optimal, 100% PCR amplification efficiency. Factors that affect amplification efficiency:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Range of standard quantities</strong> – To increase the accuracy and precision of the efficiency measurement, use a broad range of standard quantities, 5 to 6 logs (10^5 to 10^6 fold).</td>
</tr>
<tr>
<td></td>
<td>• <strong>Number of standard replicates</strong> – To increase the precision of the standard quantities and decrease the effects of pipetting inaccuracies, include replicates.</td>
</tr>
<tr>
<td></td>
<td>• <strong>PCR inhibitors</strong> – PCR inhibitors in the reaction can reduce amplification and alter measurements of the efficiency.</td>
</tr>
<tr>
<td><strong>amplification plot</strong></td>
<td>Display of data collected during the cycling stage of PCR amplification. Can be viewed as:</td>
</tr>
<tr>
<td></td>
<td>• Baseline-corrected normalized reporter (ΔRn) vs. cycle</td>
</tr>
<tr>
<td></td>
<td>• Normalized reporter (Rn) vs. cycle</td>
</tr>
<tr>
<td></td>
<td>• Threshold cycle (C_T) vs. well</td>
</tr>
</tbody>
</table>
amplification stage  Part of the instrument run in which PCR produces amplification of the target. The amplification stage is called a cycling stage in the thermal profile and consists of denaturing, primer annealing, and polymerization steps that are repeated.

For quantitation experiments, fluorescence data collected during the amplification stage are displayed in an amplification plot, and the data are used to calculate results. For genotyping or presence/absence experiments, fluorescence data collected during the amplification stage are displayed in an amplification plot, and the data can be used for troubleshooting. See also cycling stage.

assay  In the StepOne™ and StepOnePlus™ systems, a PCR reaction mix that contains primers to amplify a target and a reagent to detect the amplified target.

Assay ID  Identifier assigned by Applied Biosystems to TaqMan® Gene Expression Assays and TaqMan® SNP Genotyping Assays.

assay information file (AIF)  Data file on a CD shipped with each assay order. The file name includes the number from the barcode on the plate. The information in the AIF is provided in a tab-delimited format.

assay mix  PCR reaction component in Applied Biosystems TaqMan® Gene Expression Assays and TaqMan® SNP Genotyping Assays. The assay mix contains primers designed to amplify a target and a TaqMan® probe designed to detect amplification of the target.

AutoDelta  In the run method, a setting to increase or decrease the temperature and/or time for a step with each subsequent cycle in a cycling stage. When AutoDelta is enabled for a cycling stage, the settings are indicated by an icon in the thermal profile:

- AutoDelta on: ▲
- AutoDelta off: ▲

automatic baseline  An analysis setting in which the software calculates the baseline start and end values for the amplification plot. You can apply the automatic baseline setting to specific wells in the reaction plate. See also baseline.

automatic $C_T$  An analysis setting in which the software calculates the baseline start and end values and the threshold in the amplification plot. The software uses the baseline and threshold to calculate the threshold cycle ($C_T$). See also threshold cycle ($C_T$).

baseline  In the amplification plot, a line fit to the fluorescence levels during the initial stages of PCR, when there is little change in fluorescence signal.
baseline-corrected normalized reporter ($\Delta R_n$)

The magnitude of normalized fluorescence signal generated by the reporter:

1. In experiments that contain data from real-time PCR, the magnitude of normalized fluorescence signal generated by the reporter at each cycle during the PCR amplification. In the $\Delta R_n$ vs. Cycle amplification plot, $\Delta R_n$ is calculated at each cycle as:

   $$\Delta R_n \text{ (cycle)} = R_n \text{ (cycle)} - R_n \text{ (baseline)}$$

   where $R_n = \text{normalized reporter}$

2. In genotyping experiments and presence/absence experiments, the difference in normalized fluorescence signal generated by the reporter between the pre-PCR read and the post-PCR read. In the allelic discrimination plot (genotyping experiments) and the presence/absence plot (presence/absence experiments), $\Delta R_n$ is calculated as:

   $$\Delta R_n = R_n \text{ (post-PCR read)} - R_n \text{ (pre-PCR read)}$$

   where $R_n = \text{normalized reporter}$

See also normalized reporter ($R_n$).

biological replicate

Reactions that contain identical components and volumes, but evaluate separate samples of the same biological source (for example, samples from three different mice of the same strain, or separate extractions of the same cell line or tissue sample).

When using biological replicate groups in a comparative $C_T$ study, the values displayed in the Biological Replicates tab are calculated by combining the results of the separate biological samples and treating this collection as a single population (that is, as one sample). For $\Delta C_T$ computations (normalizing by the endogenous control) in a singleplex experiment, the separate biological samples are treated as unpaired data when computing variability estimates of the single biological replicate. You can observe individual contributions of the separate biological samples to the single biological replicate results in the Technical Replicates tab.

**Note:** To view the Biological Replicates and Technical Replicates tabs, from the Study Menu pane, select Analysis ➤ Gene Expression.

blocked IPC

In presence/absence experiments, a reaction that contains IPC blocking agent, which blocks amplification of the internal positive control (IPC). In the StepOne™ software, the task for the IPC target in wells that contain IPC blocking agent. See also negative control-blocked IPC wells.

calibrator

See reference sample.

chemistry

See reagents.

colocated layout

A system layout in which the StepOne™ or StepOnePlus™ instrument is directly connected to a colocated computer by the yellow cable. In this layout, you can control the instrument with the StepOne™ software on the colocated computer or with the instrument touchscreen.
comparative \(C_T\) (\(\Delta\Delta C_T\)) method

Method for determining relative target quantity in samples. With the comparative \(C_T\) (\(\Delta\Delta C_T\)) method, the StepOne™ software measures amplification of the target and of the endogenous control in samples and in a reference sample. Measurements are normalized using the endogenous control. The software determines the relative quantity of target in each sample by comparing normalized target quantity in each sample to normalized target quantity in the reference sample.

\(C_T\)

See threshold cycle (\(C_T\)).

custom dye

Dye that is not supplied by Applied Biosystems. Custom dyes may be adapted for use in experiments on the StepOne™ and StepOnePlus™ systems. When using custom dyes, the custom dye should be added to the Dye Library and a custom dye calibration performed.

**IMPORTANT!** Applied Biosystems does not recommend the use of TAMRA™ dye as reporter or quencher with the StepOne™ system. TAMRA dye may be used as a reporter or quencher with the StepOnePlus™ system.

cycle threshold

See threshold cycle (\(C_T\)).

cycling stage

In the thermal profile, a stage that is repeated. A cycling stage is also called an amplification stage. For cycling stages, you can enable AutoDelta settings. See also amplification stage.

data collection

A process during the instrument run in which an instrument component detects fluorescence data from each well of the reaction plate. The instrument transforms the signal to electronic data, and the data are saved in the experiment file. In the StepOne™ software, a data collection point is indicated by an icon in the thermal profile:

- Data collection on: 
- Data collection off: 

delta Rn (\(\Delta Rn\))

See baseline-corrected normalized reporter (\(\Delta Rn\)).

derivative reporter (\(-Rn'\))

The negative first-derivative of the normalized fluorescence generated by the reporter during PCR amplification. In the derivative reporter (\(-Rn'\)) vs. temperature melt curve, the derivative reporter signal is displayed in the y-axis.

Design Wizard

A feature in the StepOne™ software that helps you set up your experiment by guiding you through best practices as you enter your experiment design.

diluent

A reagent used to dilute a sample or standard before adding it to the PCR reaction. The diluent can be water or buffer.

Diluted Sample Concentration (10× for Reaction Mix)

In the StepOne™ software, a field displayed on the Sample Dilution Calculations tab of the Reaction Setup screen. For this field, enter the sample concentration you want to use to add to the reaction mix for all samples in the experiment. “10× for Reaction Mix” indicates that the software assumes the sample or standard component of the reaction mix is at a 10× concentration. For example, if the diluted sample concentration is 50.0 ng/μL (10×), the final sample concentration in the reaction is 5 ng/μL (1×).

dilution factor

See serial factor.
### dissociation curve
See melt curve.

### EFF%
See amplification efficiency (EFF%).

### endogenous control
A target or gene that should be expressed at similar levels in all samples you are testing. Endogenous controls are used in relative standard curve and comparative C$_T$ (ΔΔC$_T$) experiments to normalize fluorescence signals for the target you are quantifying. Housekeeping genes can be used as endogenous controls. See also housekeeping gene.

When using multiple endogenous controls, the software treats all endogenous controls as a single population, and calculates the experiment-appropriate mean to establish a single value against which the target of interest is normalized. In comparative C$_T$ experiments, the mean calculated is the arithmetic mean of the C$_T$ values. In relative standard curve experiments, the C$_T$ values are converted to relative quantities prior to normalization; the mean calculated is subsequently the geometric mean of the relative quantities.

**Note:** Arithmetic and geometric means are related and equivalent due to logarithmic transformation of the data.

Variability estimates for multiple endogenous controls are computed separately. The final variability estimate is a pooled combination of the individual variability estimates (similar to computing pooled standard deviations).

### endpoint read
See post-PCR read.

### experiment
Refers to the entire process of performing a run using the StepOne™ or StepOnePlus™ systems, including setup, run, and analysis. The types of experiments you can perform using the StepOne™ and StepOnePlus™ systems:

- Quantitation - standard curve
- Quantitation - relative standard curve
- Quantitation - comparative C$_T$ (ΔΔC$_T$)
- Melt curve
- Genotyping
- Presence/absence

### experiment name
Entered during experiment setup, the name that is used to identify the experiment. Experiment names cannot exceed 100 characters and cannot include any of the following characters: forward slash (/), backslash (\), greater than sign (>), less than sign (<), asterisk (*), question mark (?), quotation mark ("), vertical line (|), colon (:), semicolon (;), and sign (&), percent sign (%), dollar sign ($), at sign (@), circumflex (^), left parenthesis ( ( ), right parenthesis ( ) ), or exclamation point (!).

**IMPORTANT!** If you run the instrument in standalone mode from the instrument touchscreen, you cannot enter more than 32 characters in the Experiment Name field and you cannot include spaces in the name.
**experiment type**  
The type of experiment you are performing using the StepOne™ or StepOnePlus™ system:  
- Standard curve  
- Comparative $C_T$ ($\Delta\Delta C_T$)  
- Relative standard curve  
- Melt curve (not available in the Design Wizard)  
- Genotyping  
- Presence/absence  

The experiment type you select affects the setup, run, and analysis.

**forward primer**  
Oligonucleotide that flanks the 5′ end of the amplicon. The reverse primer and the forward primer are used together in PCR reactions to amplify the target.

**holding stage**  
In the thermal profile, a stage that includes one or more steps. You can add a holding stage to the thermal profile to activate enzymes, to inactivate enzymes, or to incubate a reaction.

**housekeeping gene**  
A gene that is involved in basic cellular functions and is constitutively expressed. Housekeeping genes can be used as endogenous controls. See also endogenous control.

**internal positive control (IPC)**  
In presence/absence experiments, a short synthetic DNA template that is added to PCR reactions. You can use the IPC to distinguish between true negative results (that is, the target is absent in the samples) and negative results caused by PCR inhibitors, incorrect assay setup, or reagent or instrument failure.

**inventoried assays**  
TaqMan® Gene Expression Assays and TaqMan® SNP Genotyping Assays that have been previously manufactured, passed quality control specifications, and stored in inventory.

**IPC**  
In presence/absence experiments, abbreviation for internal positive control (IPC). In the StepOne™ software, the task for the IPC target in wells that contain the IPC and do not contain IPC blocking agent. See also internal positive control (IPC).

**IPC blocking agent**  
Reagent added to PCR reactions to block amplification of the internal positive control (IPC).

**IPC+**  
See negative control-IPC wells.

**made-to-order assays**  
TaqMan® Gene Expression Assays or TaqMan® SNP Genotyping Assays that are manufactured at the time of order. Only assays that pass manufacturing quality control specifications are shipped.

**manual baseline**  
An analysis setting in which you enter the baseline start and end values for the amplification plot. You can apply the manual baseline setting to specific wells in the reaction plate.

**manual $C_T$**  
An analysis setting in which you enter the threshold value and select whether to use automatic baseline or manual baseline values. The software uses the baseline and the threshold values to calculate the threshold cycle ($C_T$).
melt curve  A plot of data collected during the melt curve stage. Peaks in the melt curve can indicate the melting temperature (Tm) of the target or can identify nonspecific PCR amplification. In the StepOne™ software, you can view the melt curve as normalized reporter (Rn) vs. temperature or as derivative reporter (−Rn′) vs. temperature. Also called dissociation curve.

melt curve stage In the thermal profile, a stage with a temperature increment to generate a melt curve.

melting temperature (Tm) In melt curve experiments, the temperature at which 50% of the DNA is double-stranded and 50% of the DNA is dissociated into single-stranded DNA. The Tm is displayed in the melt curve.

multicomponent plot A plot of the complete spectral contribution of each dye for the selected well(s) over the duration of the PCR run.

negative control (NC) In the StepOne™ software, the task for targets or SNP assays in wells that contain water or buffer instead of sample. No amplification of the target should occur in negative control wells. Previously called no template control (NTC).

negative control-blocked IPC wells In presence/absence experiments, wells that contain IPC blocking agent instead of sample in the PCR reaction. No amplification should occur in negative control-blocked IPC wells because the reaction contains no sample and amplification of the IPC is blocked. Previously called no amplification control (NAC).

negative control-IPC wells In presence/absence experiments, wells that contain IPC template and buffer or water instead of sample. Only the IPC template should amplify in negative control-IPC wells because the reaction contains no sample. Previously called IPC+.

no amplification control (NAC) See negative control-blocked IPC wells.

no template control (NTC) See negative control (NC).

nonfluorescent quencher-minor groove binder (NFQ-MGB) Molecules that are attached to the 3’ end of TaqMan® probes. When the probe is intact, the nonfluorescent quencher (NFQ) prevents the reporter dye from emitting fluorescence signal. Because the NFQ does not fluoresce, it produces lower background signals, resulting in improved precision in quantitation. The minor groove binder (MGB) increases the melting temperature (Tm) without increasing probe length. It also allows the design of shorter probes.

normalized quantity Quantity of target divided by the quantity of endogenous control.

normalized reporter (Rn) Fluorescence signal from the reporter dye normalized to the fluorescence signal of the passive reference.

omit well An action that you perform before reanalysis to omit one or more wells from analysis. Because no algorithms are applied to omitted wells, omitted wells contain no results.

outlier For a set of data, a datapoint that is significantly smaller or larger than the others.
<table>
<thead>
<tr>
<th>Term</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>passive reference</td>
<td>A dye that produces fluorescence signal. Because the passive reference signal should be consistent across all wells, it is used to normalize the reporter dye signal to account for non-PCR related fluorescence fluctuations caused by minor well-to-well differences in concentrations or volume. Normalization to the passive reference signal allows for high data precision.</td>
</tr>
<tr>
<td>plate layout</td>
<td>An illustration of the grid of wells and assigned content in the reaction plate. In StepOne™ systems, the grid contains 6 rows and 8 columns. In StepOnePlus™ systems, the grid contains 8 rows and 12 columns. In the StepOne™ software, you can use the plate layout as a selection tool to assign well contents, to view well assignments, and to view results. The plate layout can be printed, included in a report, exported, and saved as a slide for a presentation.</td>
</tr>
<tr>
<td>point</td>
<td>One standard in a standard curve. The standard quantity for each point in the standard curve is calculated based on the starting quantity and serial factor.</td>
</tr>
<tr>
<td>positive control</td>
<td>In genotyping experiments, a DNA sample with a known genotype, homozygous or heterozygous. In the StepOne™ software, the task for the SNP assay in wells that contain a sample with a known genotype.</td>
</tr>
<tr>
<td>post-PCR read</td>
<td>Used in genotyping and presence/absence experiments, the part of the instrument run that occurs after amplification. In genotyping experiments, fluorescence data collected during the post-PCR read are displayed in the allelic discrimination plot and used to make allele calls. In presence/absence experiments, fluorescence data collected during the post-PCR read are displayed in the presence/absence plot and used to make detection calls. Also called endpoint read.</td>
</tr>
<tr>
<td>pre-PCR read</td>
<td>Used in genotyping and presence/absence experiments, the part of the instrument run that occurs before amplification. The pre-PCR read is optional but recommended. Fluorescence data collected during the pre-PCR read can be used to normalize fluorescence data collected during the post-PCR read.</td>
</tr>
<tr>
<td>primer mix</td>
<td>PCR reaction component that contains the forward primer and reverse primer designed to amplify the target.</td>
</tr>
<tr>
<td>primer/probe mix</td>
<td>PCR reaction component that contains the primers designed to amplify the target and a TaqMan® probe designed to detect amplification of the target.</td>
</tr>
<tr>
<td>pure dye</td>
<td>See custom dye and system dye.</td>
</tr>
<tr>
<td>quantitation method</td>
<td>In quantitation experiments, the method used to determine the quantity of target in the samples. In StepOne™ and StepOnePlus™ systems, there are three types of quantitation methods: standard curve, relative standard curve, and comparative ( \Delta \Delta C_T ).</td>
</tr>
<tr>
<td>quantity</td>
<td>In quantitation experiments, the amount of target in the samples. Absolute quantity can refer to copy number, mass, molarity, or viral load. Relative quantity refers to the fold-difference between normalized quantity of target in the sample and normalized quantity of target in the reference sample.</td>
</tr>
</tbody>
</table>
**quencher**

A molecule attached to the 3′ end of TaqMan® probes to prevent the reporter from emitting fluorescence signal while the probe is intact. With TaqMan® reagents, a nonfluorescent quencher-minor groove binder (NFQ-MGB) can be used as the quencher. With SYBR® Green reagents, no quencher is used.

**IMPORTANT!** Applied Biosystems does not recommend the use of TAMRA™ dye as reporter or quencher with the StepOne™ system. TAMRA dye may be used as a reporter or quencher with the StepOnePlus™ system.

---

**QuickStart**

A feature in StepOne™ and StepOnePlus™ systems that allows you to run an experiment without entering plate setup information. QuickStart requires a colocated layout with the instrument powered on and an intact instrument-computer connection.

---

**R² value**

Regression coefficient calculated from the regression line in the standard curve. The R² value indicates the closeness of fit between the standard curve regression line and the individual CT data points from the standard reactions. A value of 1.00 indicates a perfect fit between the regression line and the data points.

---

**ramp**

The rate at which the temperature changes during the instrument run. Except for the melt curve step, the ramp is defined as a percentage. For the melt curve step, the ramp is defined as a temperature increment. In the graphical view of the thermal profile, the ramp is indicated by a diagonal line.

---

**ramp speed**

Speed at which the temperature ramp occurs during the instrument run. Available ramp speeds include fast and standard.

- For optimal results using the fast ramp speed, Applied Biosystems recommends using fast reagents in your PCR reactions.
- For optimal results using the standard ramp speed, Applied Biosystems recommends using standard reagents in your PCR reactions.

**IMPORTANT!** Fast reagents are not supported for presence/absence experiments.

---

**raw data plot**

A plot of raw fluorescence signal (not normalized) for each optical filter.

---

**reaction mix**

A solution that contains all components to run the PCR reaction, except for the template (sample, standard, or control).

---

**reagents**

The PCR reaction components you are using to amplify the target and to detect amplification. Types of reagents used on the StepOne™ and StepOnePlus™ systems:

- TaqMan® reagents
- SYBR® Green reagents
- Other reagents

---

**real-time PCR**

Process of collecting fluorescence data during PCR. Data from the real-time PCR are used to calculate results for quantitation experiments or to troubleshoot results for genotyping or presence/absence experiments.
**reference sample**  
In relative standard curve and comparative C_T (ΔΔC_T) experiments, the sample used as the basis for relative quantitation results. Also called the calibrator.

**refSNP ID**  
Identifies the reference SNP (refSNP) cluster ID. Generated by the Single Nucleotide Polymorphism Database of Nucleotide Sequence Variation (dbSNP) at the National Center for Biotechnology Information (NCBI). The refSNP ID can be used to search the Applied Biosystems Store for an Applied Biosystems SNP Genotyping Assay. Also called an rs number.

**regression coefficients**  
Values calculated from the regression line in standard curves, including the R^2 value, slope, and y-intercept. You can use the regression coefficients to evaluate the quality of results from the standards. See also standard curve.

**regression line**  
In standard curve and relative standard curve experiments, the best-fit line from the standard curve. Regression line formula:  

\[ C_T = m \log (\text{Qtty}) + b \]  

where m is the slope, b is the y-intercept, and Qtty is the standard quantity.  
See also **regression coefficients**.

**reject well**  
An action that the software performs during analysis to remove one or more wells from further analysis if a specific flag is applied to the well. Rejected wells contain results calculated up to the point of rejection.

**relative standard curve method**  
Method for determining relative target quantity in samples. With the relative standard curve method, the StepOne™ software measures amplification of the target and of the endogenous control in samples, in a reference sample, and in a standard dilution series. Measurements are normalized using the endogenous control. Data from the standard dilution series are used to generate the standard curve. Using the standard curve, the software interpolates target quantity in the samples and in the reference sample. The software determines the relative quantity of target in each sample by comparing target quantity in each sample to target quantity in the reference sample.

**Remote Monitor**  
A feature in the StepOne™ software that allows you to monitor a StepOne™ or StepOnePlus™ instrument over the network. With the Remote Monitor, you can monitor the instrument status, send an experiment to the instrument, monitor amplification plots and temperature plots in real time, and download the results to your computer. You cannot operate the StepOne™ or StepOnePlus™ instrument using the Remote Monitor.

**replicate group**  
A set of identical reactions in an experiment.

**replicates**  
Total number of identical reactions containing identical components and identical volumes.

**reporter**  
Fluorescent dye used to detect amplification. If you are using TaqMan® reagents, the reporter dye is attached to the 5′ end. If you are using SYBR® Green reagents, the reporter dye is SYBR® Green dye.

**reverse primer**  
An oligonucleotide that flanks the 3′ end of the amplicon. The reverse primer and the forward primer are used together in PCR reactions to amplify the target.
<table>
<thead>
<tr>
<th><strong>reverse transcriptase</strong></th>
<th>An enzyme that converts RNA to cDNA. Reverse transcriptase is added to the PCR reaction to perform 1-step RT-PCR.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Rn</strong></td>
<td>See normalized reporter (Rn).</td>
</tr>
<tr>
<td><strong>ROX™ dye</strong></td>
<td>A dye supplied by Applied Biosystems and precalibrated on the StepOne™ and StepOnePlus™ systems. ROX dye is used as the passive reference.</td>
</tr>
<tr>
<td><strong>rs number</strong></td>
<td>See refSNP ID.</td>
</tr>
<tr>
<td><strong>run method</strong></td>
<td>Definition of the reaction volume and the thermal profile for the StepOne™ or StepOnePlus™ instrument run.</td>
</tr>
<tr>
<td><strong>sample</strong></td>
<td>The template that you are testing.</td>
</tr>
<tr>
<td><strong>Sample DNA (10X)</strong></td>
<td>In the StepOne™ software, a reaction component displayed on the Reaction Mix Calculations tab of the Reaction Setup screen. The software assumes the sample DNA is added to the reaction mix at a 10X concentration. For example, if the reaction volume is 20 μL, the calculated volume of sample for 1 reaction is 2 μL.</td>
</tr>
<tr>
<td><strong>Sample Library</strong></td>
<td>In the StepOne™ software, a collection of samples. The Sample Library contains the sample name and the sample color.</td>
</tr>
<tr>
<td><strong>Sample or Standard (10X)</strong></td>
<td>In the StepOne™ software, a reaction component displayed on the Reaction Mix Calculations tab of the Reaction Setup screen. The software assumes the sample or standard is added to the reaction mix at a 10X concentration. For example, if the reaction volume is 20 μL, the calculated volume of sample or standard for 1 reaction is 2 μL.</td>
</tr>
<tr>
<td><strong>sample/SNP assay reaction</strong></td>
<td>In genotyping experiments, the combination of which sample to test and which SNP assay to perform in one PCR reaction. Each PCR reaction can contain only one sample and one SNP assay.</td>
</tr>
<tr>
<td><strong>sample/target reaction</strong></td>
<td>In quantitation experiments, the combination of which sample to test and which target to detect and quantify in one PCR reaction. In the Design Wizard, you can detect and quantify only one target in one PCR reaction. Use Advanced Setup to detect and quantify more than one target in one PCR reaction.</td>
</tr>
<tr>
<td><strong>serial factor</strong></td>
<td>In the StepOne™ software, a numerical value that defines the sequence of quantities in the standard curve. The serial factor and the starting quantity are used to calculate the standard quantity for each point in the standard curve. For example, if the standard curve is defined with a serial factor of 1:10 or 10X, the difference between any 2 adjacent points in the curve is 10-fold.</td>
</tr>
<tr>
<td><strong>series</strong></td>
<td>See standard dilution series.</td>
</tr>
<tr>
<td><strong>slope</strong></td>
<td>Regression coefficient calculated from the regression line in the standard curve. The slope indicates the PCR amplification efficiency for the assay. A slope of −3.32 indicates 100% amplification efficiency. See also amplification efficiency (EFF%) and regression line.</td>
</tr>
<tr>
<td><strong>SNP</strong></td>
<td>Abbreviation for single nucleotide polymorphism. The SNP can consist of a base difference or an insertion or deletion of one base.</td>
</tr>
</tbody>
</table>
SNP assay

Used in genotyping experiments, a PCR reaction that contains primers to amplify the SNP and two probes to detect different alleles.

SNP Assay Library

In the StepOne™ software, a collection of SNP assays to add to genotyping experiments. The SNP assays in the library contain the SNP assay name, SNP assay color, and for each allele, the allele name or base(s), reporter, quencher, and allele colors. The SNP assays in the library may also contain the assay ID and comments about the SNP assay.

Spatial calibration

Type of StepOne™ and StepOnePlus™ system calibration in which the system maps the positions of the wells in the sample block(s). Spatial calibration data are used so that the software can associate increases in fluorescence during a run with specific wells in the reaction plate.

Stage

In the thermal profile, a group of one or more steps. There are three types of stages: holding stage (including pre-PCR read and post-PCR read), cycling stage (also called amplification stage), and melt curve stage.

Standalone layout

A system layout in which the StepOne™ or StepOnePlus™ instrument is not connected to a computer by the yellow cable. In this layout, you control the instrument only with the instrument touchscreen, and you use a USB drive or network connection to transfer data between the instrument and computer.

Standard

Sample that contains known standard quantities. Standard reactions are used in quantitation experiments to generate standard curves. See also standard curve and standard dilution series.

Standard curve

In standard curve and relative standard curve experiments:

- The best-fit line in a plot of the C_T values from the standard reactions plotted against standard quantities. See also regression line.
- A set of standards containing a range of known quantities. Results from the standard curve reactions are used to generate the standard curve. The standard curve is defined by the number of points in the dilution series, the number of standard replicates, the starting quantity, and the serial factor. See also standard dilution series.

Standard curve method

Method for determining absolute target quantity in samples. With the standard curve method, the StepOne™ software measures amplification of the target in samples and in a standard dilution series. Data from the standard dilution series are used to generate the standard curve. Using the standard curve, the software interpolates the absolute quantity of target in the samples. See also standard and standard curve.

Standard dilution series

In standard curve and relative standard curve experiments, a set of standards containing a range of known quantities. The standard dilution series is prepared by serially diluting standards. For example, the standard stock is used to prepare the first dilution point, the first dilution point is used to prepare the second dilution point, and so on. In the StepOne™ software, the volumes needed to prepare a standard dilution series are calculated by the number of dilution points, the number of standard replicates, the starting quantity, the serial factor, and the standard concentration in the stock. See also standard curve.
<table>
<thead>
<tr>
<th><strong>standard quantity</strong></th>
<th>A known quantity in the PCR reaction.</th>
</tr>
</thead>
<tbody>
<tr>
<td>• In standard curve experiments, the quantity of target in the standard. In the StepOne™ software, the units for standard quantity can be for mass, copy number, viral load, or other units for measuring the quantity of target.</td>
<td></td>
</tr>
<tr>
<td>• In relative standard curve experiments, a known quantity in the standard. Standard quantity can refer to the quantity of cDNA or the quantity of standard stock in the PCR reaction. The units are not relevant for relative standard curve experiments because they cancel out in the calculations.</td>
<td></td>
</tr>
<tr>
<td><strong>starting quantity</strong></td>
<td>When defining a standard curve in the StepOne™ software, corresponds to the highest or lowest quantity.</td>
</tr>
<tr>
<td><strong>step</strong></td>
<td>A component of the thermal profile. For each step in the thermal profile, you can set the ramp rate (ramp increment for melt curve steps), hold temperature, hold time (duration), and you can turn data collection on or off for the ramp or the hold parts of the step. For cycling stages, a step is also defined by the AutoDelta status. With StepOnePlus™ systems, which contain the VeriFlex™ blocks, each step contains 6 temperatures (1 for each VeriFlex block).</td>
</tr>
<tr>
<td><strong>study name</strong></td>
<td>Entered during study setup, the name that is used to identify the study. Study names cannot exceed 100 characters and cannot include any of the following characters: forward slash (/), backslash (), greater than sign (&gt;), less than sign (&lt;), asterisk (*), question mark (?), quotation mark (&quot;), vertical line (</td>
</tr>
<tr>
<td><strong>SYBR® Green reagents</strong></td>
<td>PCR reaction components that consist of two primers designed to amplify the target and SYBR® Green dye to detect double-stranded DNA.</td>
</tr>
</tbody>
</table>
system dye  Dye supplied by Applied Biosystems and precalibrated on the StepOne™ or StepOnePlus™ system. Before you use system dyes in your experiments, make sure the system dye calibration is current in the Instrument Maintenance Manager.

System dyes on the StepOne™ system:
- FAM™ dye
- JOE™ dye
- ROX™ dye
- SYBR® Green dye
- VIC® dye

System dyes on the StepOnePlus™ system:
- FAM™ dye
- JOE™ dye
- NED™ dye
- ROX™ dye
- SYBR® Green dye
- TAMRA™ dye
- VIC® dye

IMPORTANT! Applied Biosystems does not recommend the use of TAMRA™ dye as reporter or quencher with the StepOne™ system. TAMRA dye may be used as a reporter or quencher with the StepOnePlus™ system.

TaqMan® reagents  PCR reaction components that consist of primers designed to amplify the target and a TaqMan® probe designed to detect amplification of the target.

target  The nucleic acid sequence that you want to amplify and detect.

target color  In the StepOne™ software, a color assigned to a target to identify the target in the plate layout and analysis plots.

Target Library  In the StepOne™ software, a collection of targets to add to experiments. The targets in the library contain the target name, reporter, quencher, and target color. The target in the library may also contain comments about the target.

task  In the StepOne™ software, the type of reaction performed in the well for the target or SNP assay. Available tasks:
- Unknown
- Negative Control
- Standard (standard curve and relative standard curve experiments)
- Positive control (genotyping experiments)
- IPC (presence/absence experiments)
- Blocked IPC (presence/absence experiments)
technical replicate: Reactions that contain identical components and volumes, and that evaluate the same sample.

temperature plot: In the StepOne™ software, a display of temperatures for the sample, instrument cover, and instrument block during the StepOne™ or StepOnePlus™ instrument run.

template: In the Design Wizard of the StepOne™ software (and in QuickStart for quantitation experiments), the type of nucleic acid to add to the PCR reaction. The recommended template varies according to experiment type:

- Quantitation experiments (standard curve, relative standard curve, and comparative C₇) – cDNA (complementary cDNA), RNA, or gDNA (genomic DNA)
  For quantitation experiments, the template type selection affects the run method, reaction setup, and materials list.
- Genotyping experiments – Wet DNA (gDNA or cDNA) or dry DNA (gDNA or cDNA)
  For genotyping experiments, the template type selection affects the reaction setup.
- Presence/absence experiments - DNA
  For presence/absence experiments, Applied Biosystems recommends adding DNA templates to the PCR reactions.

thermal profile: Part of the run method that specifies the temperature, time, ramp, and data collection points for all steps and stages of the StepOne™ or StepOnePlus™ instrument run.

threshold: 1. In amplification plots, the level of fluorescence above the baseline and within the exponential growth region. The threshold can be determined automatically (see automatic C₇) or can be set manually (see manual C₇).

2. In presence/absence experiments, the level of fluorescence above which the StepOne™ software assigns a presence call.

threshold cycle (C₇): The PCR cycle number at which the fluorescence meets the threshold in the amplification plot.

Tm: See melting temperature (Tm).

touchscreen: Instrument display that you touch to control the StepOne™ or StepOnePlus™ instrument.

unknown: In the StepOne™ software, the task for the target or SNP assay in wells that contain the sample you are testing:

- In quantitation experiments, the task for the target in wells that contain a sample with unknown target quantities.
- In genotyping experiments, the task for the SNP assay in wells that contain a sample with an unknown genotype.
- In presence/absence experiments, the task for the target in wells that contain a sample in which the presence of the target is not known.

unknown-IPC wells: In presence/absence experiments, wells that contain a sample and internal positive control (IPC).
**VeriFlex™ Technology**

The StepOnePlus™ instrument contains six independently thermally regulated VeriFlex™ blocks, creating up to six different zones for the 96 sample wells. After you enable the VeriFlex blocks in the StepOne™ software, you can set a different temperature for one or more of the VeriFlex blocks.

**y-intercept**

In the standard curve, the value of y where the regression line crosses the y-axis. The y-intercept indicates the expected threshold cycle (C_T) for a sample with quantity equal to 1.

**zone**

One of up to six sample temperatures among the 96 wells formed by independently thermally regulated VeriFlex™ blocks during the StepOnePlus™ instrument run. You can set a different temperature for one or more of the VeriFlex blocks, or you can set the same temperature for each of the VeriFlex blocks.

*Note:* For melt curve steps, you need to set the same temperature for each of the VeriFlex blocks.

**zone boundary**

The edge of a zone for samples formed by the six independently thermally regulated VeriFlex™ blocks. In the StepOne™ software, the zone boundaries are displayed in the plate layout as thick red lines.
Index

A
advanced setup 143
AIF. See assay information file.
allele 143
allelic discrimination plot 143
amplicon 143
amplification 143
plot 143
stage 144
amplification efficiency (EFF%) 143
analyze
background calibration 102
dye calibration 111–115
RNase P experiment 46–48, 72–74
spatial calibration 97
antivirus software 8, 50, 75
APIPA. See Automatic Private IP Addressing.
Applied Biosystems
contacting xii
Technical Support xii
temperature verification service 93
Applied Biosystems StepOne and StepOnePlus Real-Time PCR System. See instrument or system.
archiving files 119
assay 144
ID 144
mix 144
assay information file (AIF) 144
AutoDelta 144
automatic baseline 144
automatic C_T 144
Automatic Private IP Addressing compatibility 82
B
back up experiments 119
background calibration 98–103
analyze the data 102
guidelines 98
perform 100
prepare 99–100
purpose 98
background component, about 98
background plate
about 98
create 103
number of reuses 99
backup storage devices 7
baseline 144
baseline-corrected normalized reporter (ΔRn) 145
biohazardous waste, handling xix
bleach solution, usage 121
blocked IPC 145
bold text, use of x
C
calibration
background 98–103
dye (custom) 116–118
dye (system) 104–114
schedule 92
spatial 94–97
calibrator 145
CAUTION, description xiii
chemical
safety xvii
waste safety xix
chemistry 145
chemistry installation kit 18
clearance requirement, instrument 15
colocated layout 9, 145
collect system components 37–39
collect to a network 78
element network layout 79
install computer 28–35
installation 26–50
installation workflow 26
perform RNase P experiment 41–49
when to install 26
comparative C_T (ΔΔC_T) method 146
counter
connect to instrument 37
default user name and password 31, 56
monitor instrument 86
name, define 34, 59
placement 29, 55
prepare operating system 32–34, 57–59
remote monitoring set up 84
requirements 6
site preparation 29, 55
Computer Port
about 80
connect the computer and instrument 30
connect, instrument to computer 37
contamination, removal 121–123

Applied Biosystems StepOne™ and StepOnePlus™ Real-Time PCR Systems
Installation, Networking, and Maintenance Guide
conventions
bold text x
for describing menu commands x
IMPORTANTS! x
in this guide x
italic text x
Notes x
safety xiii
user attention words x
create
background plate 103
custom dye plate 116–118
C_T. See threshold cycle.
custom dye
about 146
calibration 116–118
plate, how to create 116–118
cycle threshold 146
cycling stage 146

d
DANGER, description xiii
data
about collection 3, 146
backup/storage devices 7
date and time settings
define for the instrument 21
define for the software 33, 58
delta Rn (ΔRn) 146
derivative reporter (- Rn′) 146
Design Wizard 146
diluent 146
diluted sample concentration 146
dilution factor 146
dimensions
computer 29, 55
instrument 15
disable 'Local Area Connection' messages 39
disk space, checking 119
dissociation curve 147
documentation
obtain xii
related xi
shipped with the system 19
dye calibration 104–114
analyzing data 111
analyzing the data 111–115
perform 110–111
prepare 108–109
purpose 104
spectra, evaluating 107
dye plate
about 104
create 116
custom dye 104
dyes
custom 106, 146
system 4, 105, 156

e
EFF%. See amplification efficiency.
electrical protective devices 7
electrical safety xx
electromagnetic compatibility standards.
See EMC standards
EMC standards xxii
encryption software 8, 50, 75
endpoint read 147
ergonomics, safety xxi
experiment 147
download from instrument 88
RNase P. See RNase P experiment.
send to instrument 88
type 148
experiment workflow
colocated layout 9
standalone layout 10

f
FAM™ system dye 4, 105
spectral profile 114, 115
file compression software 8, 50, 75
firewall software 8, 50, 75
forward primer 148

G
guidelines
background calibration 98
bleach solution, usage 121
chemical safety xvii
chemical waste disposal xix
chemical waste safety xix
lifting and moving 16, 29, 55
networking 81
remote monitoring 86

h
hardware, optional 7
hazard icons. See safety symbols, on instruments.
hazard symbols. See safety symbols, on instruments
hazards. See safety
Help system, accessing xi
holding stage 148
housekeeping gene 148
humidity requirement
computer 29, 55
instrument 15
INDEX

IMPORTANT, description xiii
incompatibilities, testing third-party software 8
installation
  category, overvoltage rating xx
  colocated layout 26–50
  instrument 14–23
  network 78–90
  operating system updates 130
  preparation 5
  required materials 6
  service pack updates 131
  site preparation 15, 29, 55
  software 32–35, 57–60
  software, administrator rights requirement 35, 60
  software, third-party 8, 50, 75
  standalone layout 52–75
  third-party software 8
  using this guide 5
  Windows service pack updates 131
workflow 11, 14
installation kit
  chemistry kit 18
  packing kit 17–18
  software and documentation kit 19
installation specification 42, 47, 65, 73
instrument
  Automatic Private IP Addressing 82
  background calibration 98–103
  Computer Port 80
  connect to a network 82
  connect to computer 37
  define settings 21
  download experiment from instrument 88
  dye calibration 104–114
  dye calibration (custom) 116–118
  dye spectra 114, 115
  installation 14–23
  IPV4LL 80
  LAN Port 80
  load 44, 67
  MAC address 82
  maintenance data 93
  maintenance schedule 92
  mDNS/DNS compatibility 80
  placement 16
  send experiment to instrument 88
  set up 20
  site preparation 15
  spatial calibration 94–97
  temperature verification service 93
  unload 49, 69
  instrument name, define 21
  instrument operation, safety xvi
  internal positive control (IPC) 148
  inventoried assays 148
  IP settings, LAN Port 83

IPC 148
  IPC blocking agent 148
  IPC+ 148
  IPv4 link-local (IPV4LL) 80
italic text, when to use x

J
  JOE™ system dye 4, 105
  spectral profile 114, 115

K
  kits provided
  installation chemistry kit 18
  packing kit 17–18
  software and documentation kit 19

L
  LAN Port
  about 80
  define IP settings 83
  layout. See colocated layout or standalone layout.
  lifting guidelines 16, 29, 55
  line conditioner, requirements 7
  load, instrument 44, 67
  local area connection messages, disable 39

M
  MAC address, instrument 82
  made-to-order assays 148
  maintenance
  archiving files 119
  back up, experiments 119
  decontamination 121–123
  disk space, checking 119
  infrequent procedures 120
  notifications 92
  optics verification 93
  required connection 92
  run cycle performance test 93
  schedule 92
  statistics, instrument 93
  temperature verification service 93
  using this guide 5
  view information 93
  managed data network service. See mDNS.
  manual baseline 148
  manual Cₜ 148
  materials required, to
  analyze the RNase P experiment 69
  create a background plate 103
  decontaminate the sample block(s) 121
  install the system 6
  move the instrument 124
network the instrument 82
perform a background calibration 98
perform a custom dye calibration 116
perform a dye calibration 104
perform a spatial calibration 94
perform an RNase P experiment 41, 64
replace the instrument fuses 126
set up remote monitoring 84
set up the computer 28, 54
ship the instrument 128

materials, shipped with the system 17
mDNS/DNS compatibility 80
Media Access Code address. See MAC address.
melt curve stage 149
melt curve 149
melting temperature (Tm) 149
menu commands, conventions for describing x
monitor the instrument. See remote monitoring.
moving and lifting, safety xvi
moving guidelines 16, 29, 55
multicomponent plot 149

N
NED® system dye 4, 105
spectral profile 115
negative control (NC) 149
negative control-blocked IPC wells 149
negative control-IPC wells 149
network 78–90
example layouts 79
guidelines 81
set up workflow 78
setup 78
using this guide 5
no amplification control (NAC) 149
no template control (NTC) 149
nonfluorescent quencher-minor groove binder (NFQ-
MGB) 149
normalized quantity 149
normalized reporter (Rn) 149
notification settings, enable 89

O
omit well 46, 72, 149
online Help. See Help system
operating system
prepare 32–34, 57–59
update 130
optics verification 93
optimization software 8
outlier 149
outliers 46, 72
overvoltage category (rating) xx

P
packing kit, contents 17–18
packing material, removal 21
passive reference 150
password, default for computer 31, 56
perform
background calibration 100
dye calibration 110–111
RNase P experiment 44, 67
spatial calibration 96
placement
computer 29, 55
instrument 16
plate layout 150
plates
background plate 98
background plate, custom 103
MicroAmp plates 17, 18
number of reuses 99
RNase P plate 18, 41, 64
spectral calibration plate 94, 104
point 150
positive control 150
post-PCR read 150
power line regulator 7, 28, 54
power options settings, for the software 32, 57
power requirement
computer 29, 55
instrument 15
preparation, system installation 5
prepare
background calibration 99–100
dye calibration 108–109
RNase P experiment 43, 66
spatial calibration 94–95
pre-PCR read 150
primer mix 150
primer/probe mix 150
protective devices, electrical 7
pure dye calibration. See dye calibration.
pure dyes 150

Q
quantitation method 150
quantity 150
quencher 151
QuickStart 151

R
R2 value 48, 74, 151
radioactive waste, handling xix
ramp 151
Index

raw data plot 151
reaction mix 151
reagents 151
real-time PCR 151
reference sample 152
refSNP ID 152
regression
coefficients 152
line 152
regulator, power line 7, 28, 54
reject well 152
relative standard curve method 152
remote monitoring 78, 152
enable notification settings 89
guidelines 86
monitor instrument 86
set up (computer) 84
removing outliers from RNase P runs 46, 72
repetitive motion, safety xxi
replicate group 152
replicates 152
reporter 152
requirements
computer 6, 29, 55
instrument 15
See also materials required.
reverse primer 152
reverse transcriptase 153
Rn. See normalized reporter.
RNase P experiment 41, 64
analyze 46–48, 72–74
materials required 41, 64
perform 44, 67
prepare 43, 66
purpose 41, 64
R² value 48, 74, 151
transfer data 70
when to perform 41, 64
ROX™ system dye 4, 105, 153
spectral profile 114, 115
rs number 153
run cycle performance test 93
run method 153

S

safety
before operating the instrument xvi
biological hazards xxi
chemical xvii
chemical waste xix
conventions xiii
electrical xx
ergonomic xxi
guidelines xvii, xix
instrument operation xvi
labels, on instruments xv
moving and lifting instrument xvi
moving/lifting xvi
repetitive motion xxi
standards xxii
symbols, on instruments xiv
workstation xxi
sample 153
sample block(s), decontaminate 121–123
Sample DNA (105) 153
Sample Library 153
Sample or Standard 153
sample/SNP assay reaction 153
sample/target reaction 153
screen resolution, for the software 33, 58
screen saver, for the software 32, 57
SDSs
description xvii
obtaining xii, xviii
security software 8, 50, 75
serial factor 153
series 153
service pack, updates 130
set up
computer 29, 54
instrument 20
site requirements
computer 29, 55
instrument 15
slope 153
SNP 153
SNP assay 154
SNP Assay Library 154
software
administrator rights requirement 35, 60
antivirus 8, 50, 75
cryptography 8, 50, 75
file compression 8, 50, 75
firewall 8, 50, 75
installation 32–35, 57–60
installation (third-party) 8
installation, administrator rights requirement 35, 60
optional 7
prepare for use 62
prepare operating system 32–34, 57–59
shipped with the system 19
system optimization 8
software, third-party 8
spatial calibration 94–97, 154
analyzing the data 97
perform 96
prepare 94–95
purpose 94
specification, installation 42, 47, 65, 73
spectrum, system dyes 114, 115
<table>
<thead>
<tr>
<th>Term</th>
<th>Page(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>stage</td>
<td>154</td>
</tr>
<tr>
<td>standalone layout</td>
<td>154</td>
</tr>
<tr>
<td>connect to a network</td>
<td>78</td>
</tr>
<tr>
<td>description</td>
<td>10</td>
</tr>
<tr>
<td>example network layout</td>
<td>79</td>
</tr>
<tr>
<td>installation</td>
<td>52–75</td>
</tr>
<tr>
<td>installation workflow</td>
<td>52</td>
</tr>
<tr>
<td>when to install</td>
<td>52</td>
</tr>
<tr>
<td>standard</td>
<td>154</td>
</tr>
<tr>
<td>curve</td>
<td>154</td>
</tr>
<tr>
<td>curve method</td>
<td>154</td>
</tr>
<tr>
<td>standard dilution series</td>
<td>154</td>
</tr>
<tr>
<td>standard quantity</td>
<td>155</td>
</tr>
<tr>
<td>standard</td>
<td>154</td>
</tr>
<tr>
<td>standards</td>
<td></td>
</tr>
<tr>
<td>EMC</td>
<td>xxii</td>
</tr>
<tr>
<td>safety</td>
<td>xxii</td>
</tr>
<tr>
<td>starting quantity</td>
<td>155</td>
</tr>
<tr>
<td>statistics, instrument</td>
<td>93</td>
</tr>
<tr>
<td>step</td>
<td>155</td>
</tr>
<tr>
<td>storage devices, backup</td>
<td>7</td>
</tr>
<tr>
<td>surge protector, requirements</td>
<td>7, 20, 28, 54</td>
</tr>
<tr>
<td>SYBR® Green 1 dsDNA Binding Dye</td>
<td>4, 105</td>
</tr>
<tr>
<td>reagents</td>
<td>155</td>
</tr>
<tr>
<td>spectral profile</td>
<td>114, 115</td>
</tr>
<tr>
<td>symbols, safety</td>
<td>xiv</td>
</tr>
<tr>
<td>system</td>
<td></td>
</tr>
<tr>
<td>chemistry kit</td>
<td>18</td>
</tr>
<tr>
<td>components</td>
<td>17</td>
</tr>
<tr>
<td>data collection</td>
<td>3</td>
</tr>
<tr>
<td>documentation</td>
<td>19</td>
</tr>
<tr>
<td>packing kit</td>
<td>17–18</td>
</tr>
<tr>
<td>software</td>
<td>19</td>
</tr>
<tr>
<td>system dyes</td>
<td>105, 114, 115, 156</td>
</tr>
<tr>
<td>test</td>
<td></td>
</tr>
<tr>
<td>optics verification</td>
<td>93</td>
</tr>
<tr>
<td>run cycle performance</td>
<td>93</td>
</tr>
<tr>
<td>third-party software for incompatibilities</td>
<td>8</td>
</tr>
<tr>
<td>text conventions</td>
<td>x</td>
</tr>
<tr>
<td>thermal profile</td>
<td>157</td>
</tr>
<tr>
<td>third-party software</td>
<td>8</td>
</tr>
<tr>
<td>threshold</td>
<td>157</td>
</tr>
<tr>
<td>threshold cycle C&lt;sub&gt;T&lt;/sub&gt;</td>
<td>157</td>
</tr>
<tr>
<td>Tm. See melting temperature.</td>
<td></td>
</tr>
<tr>
<td>Tools menu, maintenance tests</td>
<td>93</td>
</tr>
<tr>
<td>touchscreen</td>
<td>157</td>
</tr>
<tr>
<td>training, information on</td>
<td>xii</td>
</tr>
<tr>
<td>transfer data</td>
<td>70</td>
</tr>
<tr>
<td>download experiment from instrument</td>
<td>88</td>
</tr>
<tr>
<td>send experiment to instrument</td>
<td>88</td>
</tr>
<tr>
<td>U</td>
<td></td>
</tr>
<tr>
<td>uninterruptable power supply, requirements</td>
<td>7, 20, 28, 54</td>
</tr>
<tr>
<td>unknown</td>
<td>157</td>
</tr>
<tr>
<td>unknown-IPC wells</td>
<td>157</td>
</tr>
<tr>
<td>unload, instrument</td>
<td>49, 69</td>
</tr>
<tr>
<td>update</td>
<td></td>
</tr>
<tr>
<td>operating system</td>
<td>130</td>
</tr>
<tr>
<td>service packs</td>
<td>130</td>
</tr>
<tr>
<td>UPS, requirements</td>
<td>7, 20, 28, 54</td>
</tr>
<tr>
<td>USB drive, transfer data</td>
<td>10, 70</td>
</tr>
<tr>
<td>user attention words, described</td>
<td>x</td>
</tr>
<tr>
<td>user name, default for computer</td>
<td>31, 56</td>
</tr>
<tr>
<td>using this guide</td>
<td></td>
</tr>
<tr>
<td>installation</td>
<td>5</td>
</tr>
<tr>
<td>maintenance</td>
<td>5</td>
</tr>
<tr>
<td>networking</td>
<td>5</td>
</tr>
<tr>
<td>V</td>
<td></td>
</tr>
<tr>
<td>VIC® system dye</td>
<td>4, 105</td>
</tr>
<tr>
<td>spectral profile</td>
<td>114, 115</td>
</tr>
<tr>
<td>W</td>
<td></td>
</tr>
<tr>
<td>WARNING, description</td>
<td>xiii</td>
</tr>
<tr>
<td>waste disposal, guidelines</td>
<td>xix</td>
</tr>
<tr>
<td>waste profiles, description</td>
<td>xix</td>
</tr>
<tr>
<td>weight</td>
<td></td>
</tr>
<tr>
<td>computer</td>
<td>29, 55</td>
</tr>
<tr>
<td>instrument</td>
<td>15</td>
</tr>
<tr>
<td>Windows operating system</td>
<td></td>
</tr>
<tr>
<td>operating system upgrades, installation</td>
<td>131</td>
</tr>
<tr>
<td>service pack updates, installing</td>
<td>131</td>
</tr>
<tr>
<td>workflow</td>
<td></td>
</tr>
<tr>
<td>install the instrument</td>
<td>14</td>
</tr>
<tr>
<td>install the system</td>
<td>11</td>
</tr>
<tr>
<td>workstation safety</td>
<td>xxi</td>
</tr>
</tbody>
</table>
Index

Y
y-intercept 158

Z
zone 158
zone boundary 158